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WHY THIS eBOOK?
Now that the eBook Revolution is in full 

swing, it is interesting for us to finally have 

a more public medium for our eBooks. 

We have specialized in interactive eBooks 

for digital photography since the year 

2000 and this is our 19th publication in 

approximately this form.

Yet, this volume is somewhat experi-

mental. With the release of Apple’s iPad, a 

new era of eBooks is upon us. iPad users can 

play PDF files within Apple’s iBooks app.

Previous PDF eBooks allowed embed-

ded movies and photos that could 

change with a mouse move plus audio 

files one could click and play on comput-

ers only. The PDF reader on your iPad 

offers a different sort of interaction, but it 

is fast, intuitive and easy to control.

Our Lights, Digital Camera, ACTIONS! 

eBook appeared in 2008. Photoshop then 

was only up to version CS3. Today, Pho-

toshop is up to CS5. Its Actions capability 

has reached new levels of maturity and 

functionality. As a Beta Tester, I worked 

with the Adobe team, championing some 

of the functions that made it into the 

final CS5 version. All of the Photoshop 

Actions in this eBook have been written, 

re-written or tested with Photoshop CS5.

Actions are recorded sequences of 

Photoshop steps. If I showed you an 

interesting process with more than about 

five sequential steps, a month from now 

you would no longer be sure you remem-

bered them exactly, but an Action would 

remember them for you, precisely.  

Some iNovaFX Photoshop Actions are 

literally hundreds of 

steps long—far beyond 

what is reasonable to 

memorize, so Actions are 

a way of orchestrating 

complex new “features.”

With CS5, the rate of 

Action replay has been 

accelerated. For both 

Mac and Windows platforms, Pho-

toshop CS5 can operate in a speedy 

64-bit mode. See your Photoshop docs 

for instructions in setting this up.

SOFTWARE INCLUDED
Our Action software comes with this 

volume, and that’s the collection of 

Photoshop CS5 Actions that you must 

install into your copy of Photoshop so 

you can achieve the things you see in 

this document. Most will work with CS4 

and earlier versions of Photoshop as well.

Photoshop Actions in this eBook are all 

original. All begin with a lower-case “i.” 

Some execute quickly; others take 

several minutes, depending on the func-

tions and number of steps they employ. 

A few will stop midstream, waiting for 

you to provide personal input. 

Often you won’t know precisely what 

an Action will generate until you’ve 

tried it several times, or with several 

different images. After a while, the 

Actions begin to feel 

like large, complex 

Photoshop tools, each 

delivering a larger, more 

complex result than you 

get from Photoshop’s 

usual tools, filters and 

functions alone.

Most Actions deliver a 

labeled Snapshot into the History Panel. 

If you don’t have the History Panel visible, 

you can light it up through the Windows 
> History command that appears in the 

Header Bar.

In this eBook, the Actions are 

designed to work with just about any 

image from 6MP (about 3000 x 2000 

pixels) to 24MP (6000 x 4000), and 

many will work seamlessly with shots 

as small as 4MP and larger than 50MP.

Sometimes the image will be scaled to a 

standard larger size before the heavy work 

begins. That might result in a file much 

bigger than the original, so you may wish 

to scale images back to near-original size 

before saving the result. A few Actions may 

reduce the original image to a smaller size 

before processing, but only if the original is 

extraordinarily large.  We have tried to hit 

a balance between final pixel dimensions 

and prudent processing times.

There is no real limit to the number of 

steps that can be applied to an image, so 

some of our Actions dump the memo-

rized steps that fill up the History Panel on 

the fly during processing. 

You can limit the number of steps 

that Photoshop tries to keep track of by 

opening Preferences > Performance > History 
& Cache > History States > # and filling in any 

number. To keep memory lively, put in a 

lower number of History States. Try 10. To 

be able to retrace your steps more deeply, 

you might try 100.

You won’t find the Actions inside the 

eBook. They are software files in a folder 

called CS5Actions. There you will see over 

101 folders, each of which holds between 1 

and 30 different Actions. 

Loading Actions is easy. You may load 

them by dropping an Action’s icon onto 

the Photoshop program icon or alias. Or 

use the Actions Panel’s own attached 

Load Actions menu function.

Bon Aperture,

Peter iNova, November, 2010

FOREWORD/FORWARD If your practice of photography does not involve amplifying your 
images—quick: close this volume and step away from the computer 
with your hands in the air—nobody will get hurt.
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GETTING THE MOST FROM THIS EBOOK
You’re in the Twilight Zone of 
written publications. The signpost 
up ahead says eBook, but the 
definition of that is not resolved. 
Here’s our map.

This eBook is a ginormous PDF 
file, and reads directly within Adobe 
Reader on your computer or through 
the iBooks reader on your iPad.  It’s 
big because the images are extraor-
dinarily high resolution. (A smaller, 
lower-resolution ActionsCS5-Fast file 
moves quicker on the iPad.)

PDF means Portable Document 
Format, and Adobe invented it in the 
1990s as a cross-platform standard 
allowing text and images to play on a 
computer screen with color, interac-
tion, instant jumping around and 
instant linking to the Internet. 

Most PDF files that you download 
from the Internet are relatively small, 
with low-quality images and limited 
resolution. Say goodbye to all that. 
This volume lets you expand images 
up to full screen to study the picture 
closer than any printed book.

iPad viewing allows extreme 
enlargement. Just double tap 
on an image to have it zoom up 
to as big as it can get without 
cropping. This CS5-based revision 
concentrates on making iPad 
viewing straightforward and easy to 
negotiate. 

Since the subject here involves 
Adobe Photoshop CS5 (often written 
as PS CS5), the eBook is just a mouse 
click away from the subject matter 
when viewed on your computer. 
And for reading on your iPad, it goes 
anywhere;  from the loo to Timbuktu. 

We encourage you to read about 
an Action, then wonder if it is useful 
to your type of photography for a 
while, then experiment with it several 
times before using it for something 
important. 

You will need Adobe Reader 9 or 
greater to experience this eBook on 
your computer.  Your iPad will need 
a PDF reader, too. Apple’s own iBook 
app loads any PDF files through 
iTunes. In iTunes, an attached iPad 
shows its contents under a dedicated 
Books header where you can view all 
PDF volumes by icon or by name.

Variations on Adobe Reader for PC’s 
are free for Windows, Mac and Linux 
operating systems, but Photoshop 
is only available for Windows and 
Macintosh computers, so you are 
likely in one of those two platforms. 

The eBook files and Actions are 
compatible with all forms of Macin-
tosh OS X and Windows that can 
accommodate Photoshop CS5. Many 
Actions will work with older versions 
such as CS4 and CS3.

THUMBNAIL BROWSING
The thumbnails running down the 

left side of the Adobe Reader page 
on a computer work well as a quick 
finder. Adobe Reader 9 tabs this 
feature under the title Pages while 
some prior versions call it Thumbnails.  
Viewing on iPads doesn’t show 
these thumbnails, rather they’ve 
become a scroll line along the 
bottom of the page.

Thumbnails give you a chance to 
scan the eBook pages fairly quickly 
and spot any page that looks familiar. 
Click on any page for an instant 
jump to it at the current viewing 
magnification. You can enlarge, shrink 
or eliminate thumbnails to conserve 
screen space.

A Bookmarks tab at the left of the 
Reader page image is a sort of mini 
table of contents. Click on any of its 
listed items and jumping to that page 
will be instantaneous.

Note that Reader behaves much like 
an Internet browser and arrows in 
the header will navigate forward and 
backward through a string of your 
most recent interactive jumps.

PRINTING OUT
You can print out ranges of pages 

from your computer in black and 
white, with a laser printer, or in color, 
with an ink-jet printer, any time you 
wish for reference.

Hint: to print a range of pages, 
highlight the first page, shift-click 
the last and use Reader’s Print Range 
feature.

INTERNET UPDATES
It is inevitable. Data in a timely 

document like this may give way to 
new information, become obsolete, 
or acquire new meanings as technol-
ogy progresses. 

After reading through this eBook 
you may wish to visit our special site 
holding updated information, links, 
special offers, new techniques, bonus 
Actions and the latest information, 
along with any errata and corrections.

http://www.digitalsecrets.net/ActionsCS5/

http://www.digitalsecrets.net/ActionsCS5/
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THREE HINTS FOR THE NEW PHOTOGRAPHY
Aw, you missed it!
Liquids, dryers, the smell of exotic chemicals, the 
finger discoloration, nay, the shirt stains that no 
dry cleaner could erase. Ah, the golden days of 
photography where discovering that you got the 
exposure all wrong was merely an hour into the 
future or a day too late...

Today’s DSLR cameras can move you from being 

a newcomer to being a photographic artist. The 

great photographers from the past would have 

exchanged body parts for today’s gear if you 

could send it back in a time machine. 

Ansel Adams lived long enough to experience 

the first rays at the dawn of electronic photogra-

phy, and he knew that cameras like these would 

be in our future. He smiled in envy of you. So, 

welcome to the expanding world of images as 

seen by a computer with a lens attached.

At its heart, a digital camera is all about count-

ing. They count the number of photons from 

the real world and give back numerical images 

from the computer world. Between those two 

extremes, you get to intervene and decide what’s 

Good, Bad or Ugly. 

HINT #1: Throw away the Ugly, improve the Bad 

and learn from the Good.

All the historical principles of photography are 

still there—except the ones about wet darkroom 

stains. We still need to pay attention to shutter 

speeds, sensitivity to light, color balance, aperture 

settings, framing the image, composing the 

picture and understanding how those all work. 

But like magic, as soon as you shoot a picture, you 

get to review it at a decent size. If it displeases 

you, erase it. Put down the image and step away 

from the shot.

����

HINT #2: Reviewing via the monitor is your first 

line of defense from the Bad and Ugly. 

By arming yourself with a wide range of digital 

possibilities, you can think of that review image 

as a starting place for things you can accomplish 

later. Where film photographers 

from the past were required to take 

their images through the darkroom, 

you have your laptop or desktop 

computer in which you can store, 

manipulate, correct and improve your images in a 

near infinite number of ways.

Think of this as a dimroom —just enough light 

control to let you see the computer screen. It’s the 

place that differentiates the snap-shooter from the 

photojournalist, the portrait photographer and the 

photographic artist.  People who take photography 

seriously revisit their images the way Adams 

did—always thinking of ways to make the original 

moment into compelling memory.

HINT #3: Much of photography is about the 

subject, but most of it is about the photographer.  

Your role—Eye of the Beholder—is involved at 

every level, so here are hundreds of extra ways of 

beholding.
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Learning Examples
iCrAb-series               26

Chromatic Aberration reduction 
reviewed as part of a general 
explanation of how Actions work.

 (32 associated detail Actions*)
iBC-DIY                   43
 Barrel and pincushion distortion 

Action making as an example for 
learning how Actions work.

 (You make 1 Action)
iCrosstar-DIY              49
 Hands-on crosstar complex Action 

making. (You make 1 Action)
iTelePanoBlend          176
 Demonstration of Photomerge with 

included pano segments. (1 Action)
iPerspectiveTutor         182
 Guided tutorial on perspective 

correction geometry. (2 Actions)

Border Crossings   .  .  .  .  .  .  .  .  .  .  . 59
 Actions that create frames, film 

borders and graphic containers for 
images.

iFilmBorders               61
 Simulated roll film and 6x6 borders 

with edge text and roll fog options.
 (9 Actions)
 Simulated 4x5 H and V sheet film 

borders with margin text.
 (2 Actions + 2 Crop utilities)

iFilmBorders35             68
 Simulation of accurate 35mm single 

frame chip. Two different versions 
plus margin title generators for 
CS2/CS3.

 (19 Actions plus 8 prep utilities)
iStampBorders            69
 Graphic perforated stamp borders in 

three sizes.
 (5 Actions)
iFourPrint                 70
 Page layout that combines any four 

images into a single sheet horizontal 
and vertical 3x4 & 2x3 variations.

 (4 Actions)
iMulti16                  72
 Page layout that combines any 

16 images into a single sheet. 
Horizontal, vertical, twisted and 
dimensional variations.

 (6 Actions + utilities/info) 

Photoshop Filters +++  .  .  .  .  .  .  .  . 75
iPSArtistic-Series           77
 iColorPencilWhite (1)  . . . . . . . . 77
 iColorPencilGray (1) . . . . . . . . . 78
 iDryBrush (1) . . . . . . . . . . . . . . . 79
 iDryBrushG (1)  . . . . . . . . . . . . . 80
 iFilmGrain1 / 2 (2) . . . . . . . . . . . 81
 iFresco (1)  . . . . . . . . . . . . . . . . . 82
 iNeonGlow1 / 2 (2)  . . . . . . . . . . 83
 iPaintDaubs (1). . . . . . . . . . . . . . 84
 

 iPaletteKnife (1) . . . . . . . . . . . . . 85
 iPlasticWrap (1) . . . . . . . . . . . . . 86
 iPoster (1) . . . . . . . . . . . . . . . . . . 87
 iRoughPastelsBoard (1) . . . . . . . 88
 iRoughPastelsCanvas (1) . . . . . . 88
 iSmudgeStick (1) . . . . . . . . . . . . 89
 iSponge (1) . . . . . . . . . . . . . . . . . 90
 iUnderpainting (1) . . . . . . . . . . . 91
 iWatercolor1 (1) . . . . . . . . . . . . . 92
 iWatercolor2 / 3 (2) . . . . . . . . . . 93
  (21 Actions)
iPSBrushstrokes-Series       95
 iAccentedEdges (3)  . . . . . . . . . . 95
 iAngledStrokesLg (1) . . . . . . . . . 96
 iAngledStrokesPortrait (1) . . . . . 97
 iAngledStrokesSm (1) . . . . . . . . 98
 iCrosshatch (1) . . . . . . . . . . . . . . 99
 iDarkStrokes (1) . . . . . . . . . . . . 100
 iInkOutlines (1)  . . . . . . . . . . . . 101
 iSpatter (1) . . . . . . . . . . . . . . . . 102
 iSprayedStrokes (1) . . . . . . . . . 103
 iSumi-E (1) . . . . . . . . . . . . . . . . 104
 (12 Actions)
iPSDistort-Series           105
 iDiffuseGlow1 / 2 / 3 (3) . . . . . 105
 iGlassRipple (1) . . . . . . . . . . . . 106
 iOceanRipple (1)  . . . . . . . . . . . 107
 iPinch (4) . . . . . . . . . . . . . . . . . 108
 iSpherize (4) . . . . . . . . . . . . . . . 109
 iRipple (1)  . . . . . . . . . . . . . . . . 110
 iShear (2) . . . . . . . . . . . . . . . . . 111
 iTwirl (2)  . . . . . . . . . . . . . . . . . 112
 

 iWave (2) . . . . . . . . . . . . . . . . . 113
 iZigAround (1) . . . . . . . . . . . . . 114
 iZigCenter (1) . . . . . . . . . . . . . . 115
 iZigPond (1) . . . . . . . . . . . . . . . 116
 (23 Actions)
iPSPixelate-Series         117
 iColorHalftoneL / T (2) . . . . . . 117
 iBWHalftoneT (1)  . . . . . . . . . . 117
 iCrystalize (1) . . . . . . . . . . . . . . 118
 iPointillizeSeurat (2)  . . . . . . . . 119
 (6 Actions)
iPS+Noise-Series          120
 iMedian (1) . . . . . . . . . . . . . . . . 120
 iDust/Scratches (1) . . . . . . . . . . 120
 (2 Actions)
iPSSketch-Series          121
 iBasRelief (1) . . . . . . . . . . . . . . 121
 iBasReliefColor (2)  . . . . . . . . . 121
 iChalkNcharcoal (1) . . . . . . . . . 122
 iChalkNcharcoalColor (1) . . . . 123
 iCharcoal (1). . . . . . . . . . . . . . . 123
 iCharcoalColor (1) . . . . . . . . . . 123
 iChrome / iChromeChroma (2) 124
 iContéCrayon1 / 2 (2). . . . . . . . 125
 iContéCrayon3 / 4 (2). . . . . . . . 126
 iContéCrayonColor (1). . . . . . . 127
 iGraphicPen (2)  . . . . . . . . . . . . 128
 iGraphicPenColor (2) . . . . . . . . 129
 iPhotoCopy (1) . . . . . . . . . . . . . 130
 iPhotoColorCopy (1) . . . . . . . . 131 

iReticulation1 / 2 / 3 (3+Carnet) 132
 iReticulationColor (1)  . . . . . . . 133
 

 Meet the Actions
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iPSSketch-series. .  .  .  .  .  . (continued)

	 iStamp	(1)	 .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 134
. iStampColor	(1)	 .  .  .  .  .  .  .  .  .  .  .  . 135
	 iTornEdges	(1)	 .  .  .  .  .  .  .  .  .  .  .  .  . 136
	 iWaterPaper	(2) 	 .  .  .  .  .  .  .  .  .  .  .  . 137
	 (30	Actions)
iStylize-Series. .  .  .  .  .  .  .  .  .  .  .  .138
	 iEmboss	(1) 	 .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 138
	 iEmbossColor	(1)	 .  .  .  .  .  .  .  .  .  .  . 138
	 iExtrudeChalk	(1)	 .  .  .  .  .  .  .  .  .  .  . 139
	 iExtrudePlanks	(1)	 .  .  .  .  .  .  .  .  .  . 140
	 iExtrudeSpikes	(2)	 .  .  .  .  .  .  .  .  .  . 141
	 iFindEdges	(5)	 .  .  .  .  .  .  .  .  .  .  .  .  . 142
	 iGlowingEdgesA	/	B	(2) .	 .	 .	 .	 .	 .	143
	 iGlowingWindL	/	R	(2)	 .  .  .  .  .  . 144
	 iFindEdgesCarnet	(1)
	 iGlowingCarnet	(1)
	 (17	Actions)
iPSTexture-Series .. .. .. .. .. .. .. .. .145
	 iCraquelureA	(1) 	 .  .  .  .  .  .  .  .  .  .  . 145
	 iCraquelureB	/	C	(2)	 .  .  .  .  .  .  .  .  . 146
	 iMosaicPatchwork	(2) 	 .  .  .  .  .  .  . 147
	 iStainedGlass	(1) 	 .  .  .  .  .  .  .  .  .  .  . 148
	 iStainedGlass+	(1)	 .  .  .  .  .  .  .  .  .  . 159
	 iTexturizer	(3) 	 .  .  .  .  .  .  .  .  .  .  .  .  . 150
	 (10	Actions)

iFilterFantastics. .  .  .  .  .  .  .  .  .151
	 iGradA	(11) 	 .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 153
	 iGradB-Contrast	(1)	 .  .  .  .  .  .  .  .  . 155
	 iGrad2Taste	(1) 	 .  .  .  .  .  .  .  .  .  .  .  . 156
	 iFog	(5)	 .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 157
	 iDiffuse	(4)	 .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 158

	 iHalo	(9)	 .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 159
	 iCrosstar	(9)	 .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 160
	 iScratchStar	(3) .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	161
	 iPolarizeSkyFX	(15) .	 .	 .	 .	 .	 .	 .	 .	 .	162
	 iIRbw	(3) 	 .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 163
	 iShatter	(3)	 .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 164
	 iShatter++	(1)	 .  .  .  .  .  .  .  .  .  .  .  .  .  . 165
	 iBaby	(4) .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	166
	 iToy	(5) .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	167
	 iFocusMeCS5	(3)	 .  .  .  .  .  .  .  .  .  .  . 168
	 iFocusInteractive3	(1) 	 .  .  .  .  .  .  . 169
	 iVignette	(4)	 .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 170
	 (82	Actions)

Corrective.Measures. .  .  .  .  .  .  .  . 171
	 iBCGeneral	(barrel	dist)	(20)	 .  . 174
	 iBCCorner	(4) .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	175
	 iBCMulti	H	/	V	batch	(40)	 .  .  .  . 176
	 iPanoCylinderEdges	(14)	 .  .  .  .  . 177	

iPerspectiveTutor	(2)	 .  .  .  .  .  .  .  . 181
	 iCCMetrics	(23)	 .  .  .  .  .  .  .  .  .  .  .  . 184
	 iCCMisc	(10)	 .  .  .  .  .  .  .  .  .  .  .  .  .  . 184
	 iSodium	(7) 	 .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 185
	 iCFCooler-Warmer	(2)	 .  .  .  .  .  .  . 185
	 iAerialShotCorrect	(2)	 .  .  .  .  .  .  . 186
	 iDeJPEG	(1)	 .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 187
	 iDeNoise	(6)	 .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 188
	 iShadowLifts	(13) .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	189
	 iSODSLR	(12)	 .  .  .  .  .  .  .  .  .  .  .  .  . 190
	 iSOExtreme	(6) 	 .  .  .  .  .  .  .  .  .  .  .  . 191
	 iFlawFix	(7)	 .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 192
	 iDustAway	(3)	 .  .  .  .  .  .  .  .  .  .  .  .  . 193
	 (176	Actions)
	

Artistic.Conversions. .  .  .  .  .  .  .  . 195
	 iLiners	(6)	 .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 196
	 iComplexArtFX	
	 	 iAngledStrokes	(4)	 .  .  .  .  .  .  .  . 197
	 	 iCanvasPainting	(5) 	 .  .  .  .  .  .  . 198
	 	 iLandscape	(3) 	 .  .  .  .  .  .  .  .  .  .  . 199
	 	 iWaterColor	(3) 	 .  .  .  .  .  .  .  .  .  . 200
	 	 iPencilSketch	(1) 	 .  .  .  .  .  .  .  .  . 201
	 	 iPencilLine	(1)	 .  .  .  .  .  .  .  .  .  .  . 202
	 	 iEqualize	(1)	 .  .  .  .  .  .  .  .  .  .  .  .  . 202
	 	 iColorBlast	(1)	 .  .  .  .  .  .  .  .  .  .  . 203
	 	 iColorDream	(1)	 .  .  .  .  .  .  .  .  .  . 203
	 	 iContrast	(9)	 .  .  .  .  .  .  .  .  .  .  .  .  . 204
	 iDimroomArt
	 	 iLumiBloom	(3) 	 .  .  .  .  .  .  .  .  .  . 205
	 	 iBloomArt	(3)	 .  .  .  .  .  .  .  .  .  .  .  . 206
	 	 iFleshTona	(1)	 .  .  .  .  .  .  .  .  .  .  .  . 207
	 iToons	(6)	 .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 208
	 iGraphic	(6) 	 .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 209
	 iCine-Like	FX
	 	 iHalcyon	(4) 	 .  .  .  .  .  .  .  .  .  .  .  .  . 210
	 	 iSinCity	(5)	 .  .  .  .  .  .  .  .  .  .  .  .  .  . 211
	 	 iJazzAge	(3) 	 .  .  .  .  .  .  .  .  .  .  .  .  . 212
	 	 iDomino	(4) 	 .  .  .  .  .  .  .  .  .  .  .  .  . 213
	 iRustica	(3)	 .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 214
	 iBWColorFilters	(13)	 .  .  .  .  .  .  .  . 215
	 iBWFilmFX	(7)	 .  .  .  .  .  .  .  .  .  .  .  . 217	

iBWPrintTints	(14) 	 .  .  .  .  .  .  .  .  . 218
	 (106	Actions)

Enhancements/Utilities. .  .  .  .  .  . 219
	 iDynamicRangers	(9)	 .  .  .  .  .  .  .  . 220
	 iFrameAverage	(4)	 .  .  .  .  .  .  .  .  .  . 221
	 iFrameAvgAutoAlign	(5)	 .  .  .  .  . 224
	 iFrmAvgFullAA+CropCS5	(5)	 224
	 iRegister	(12)	 .  .  .  .  .  .  .  .  .  .  .  .  .  . 224
	 iPanacea	(3)	 .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 225
	 iLayers	(8) 	 .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 226
	 iCrop	(7)	 .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 228
	 iOldTymie	(3) .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	229
	 iRetinex	(7) .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	230
	 iBCFisheye	(7)	 .  .  .  .  .  .  .  .  .  .  .  .  . 231
	 iDotsFX	(7) 	 .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 232
	 iCombo	(4)	 .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 233
	 iHandyChanges	(5) .	 .	 .	 .	 .	 .	 .	 .	 .	 .	234
	 iChannelMixer	(2)	 .  .  .  .  .  .  .  .  .  . 235
	 iFingerPrint	(4)	 .  .  .  .  .  .  .  .  .  .  .  .  . 237
	 iBubble	(10)	 .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 238
	 iFace	(3)	 .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 242
	 iButterfly	(4) .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	 .	243
	 iBannerImage	(2)	 .  .  .  .  .  .  .  .  .  .  . 245
		 (106	Actions)

 Meet the Actions (continued)
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Photoshop Extended  .  .  .  .  .  .  .  . 247
	 iPanoFromMovie	(6)	 .  .  .  .  .  .  .  . 248
	 iSlit	(1)	 .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 253
	 iSlitStreak	(4)	 .  .  .  .  .  .  .  .  .  .  .  .  .  . 255
	 iSlitScan	(2)	 .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 256
	 iVidGrad	(1)	 .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 260
	 iVidBlur2	(1)	 .  .  .  .  .  .  .  .  .  .  .  .  .  . 261
	 iFlickerFixer	(1)	 .  .  .  .  .  .  .  .  .  .  .  . 262
	 iTimeLapseMaker	(1) .	 .	 .	 .	 .	 .	 .	 .	262
	 iMovieStar	&	Lite	(2) .	 .	 .	 .	 .	 .	 .	 .	263
	 iVintageCS5	(4)	 .  .  .  .  .  .  .  .  .  .  .  . 264
	 iMovieToonsCS5	(3)	 .  .  .  .  .  .  .  . 265
	 iMovieCharcoal	(2) 	 .  .  .  .  .  .  .  .  . 266
	 iMoveConté	(3) 	 .  .  .  .  .  .  .  .  .  .  .  . 267
	 iMovieBrighten	(3) .	 .	 .	 .	 .	 .	 .	 .	 .	 .	268
		 iMovieDarken	(3)	 .  .  .  .  .  .  .  .  .  .  . 268	

iMovieGrade	(10)	 .  .  .  .  .  .  .  .  .  .  . 269
	 iMovieDeNoise	(3) .	 .	 .	 .	 .	 .	 .	 .	 .	 .	274
	 iMovieTimeDNoise	(2)	 .  .  .  .  .  . 275
	 iMovieSharpen	(3)	 .  .  .  .  .  .  .  .  .  . 275
	 iMovieDotRemover	(1) . . . . . . 276
	 (56	Actions)
Total	at	press	time	 .  .  .  .  .  .  .  .  .  .  .  .  .  . 101	Folders
	 	 	 .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 704	Actions

Notes:	
	 Minor	Actions	are	not	counted .

	 *	iCrAb	Actions	for	chromatic	
aberration	are	counted	as	8	ideas,	
not	the	32	individual	Actions	 .  .  . 26

	 Bonus	Actions	and	undocumented	
fun	are	included .	

http://www.digitalsecrets.net/ActionsCS5/

What’s on the DVD
 
The	eBook	file	(you’re	reading	it .)
	 The	ActionsCS5	folder
	 Adobe	Reader	for	Windows
	 	 XP
	 	 Vista
	 Adobe	Reader	for	Mac	OS	X
	 	 Snow	Leopard,	Lion
	 Extras	Folder
	 	 Panoramic	tutorial	images
	 	 Demonstration/test	images
	 	 iBannerImage	folder
	 	 	 iBannerImage1 .psd
	
Top Action Build Shortcuts 
 Win / Mac
Dismiss	an	Action	alert	window:	
	 Return	or	Enter
Default	Foreground/Background	colors
	 D	key
Change	Foreground/Background	colors:
	 X	key
Close	an	open	image	without	saving:
	 Ctrl+W	/	Command	+	W...	+	D	
Save	the	current	file:
	 Ctrl+S	/	Command	+	S
Save	for	Web	&	Devices:
	 Shift	+	Alt	+	Ctrl	+	S	/
	 Shift	+	Option	+	Command	+	S

Adobe Reader keystroke 
navigation shortcuts 

Click	away	from	page	objects	in	the	
right	margin	to	fully	activate	the	
page’s	response	to	key	stroke	
instructions .

Zoom	in	/	out	of	page:
	 Ctrl	(Win)	or	Cmd	(Mac)	+/-
	 Plus	or	minus	keys .
Reader	remembers	the	order	in	which	

you	have	browsed	pages .

Back	or	forward	to	the	previously	
viewed	page:

	 Ctrl	/	Cmd	+	Left	or	Right	Arrow	
key .	

Up	/	down	in	page	order:
	 Up	or	Down	Arrow	keys .
-or-	Left	or	Right	Arrow	keys .
	 Page	Up	or	Page	Down	keys

NB:	Adobe	Reader	works	somewhat	like	
a	web	browser	page,	in	that	it	can	
step	backwards	through	pages	in	the	
order	you	viewed	them .	

	 Small	arrow	buttons	in	the	header	
bar	work	this	way .

	 Arrow	keyboard	keys	alone	step	
to	and	fro	through	pages	in	page	
order,	not	viewing	order .	

	 Reader’s	larger	left/right	arrow	
icons	work	this	way .

iPad Viewing and navigation 
tips (iBook app)

Pinch	in	/	out	of	page:
	 iPad	viewing	lets	you	zoom	in	

and	out	of	images	or	text	with	
expanding	two	finger	gestures	
(zoom	in)	or	pinch	gestures	
(zooming	out) .	You	may	also	
double	tap	on	any	image	to	zoom	it	
larger	or	smaller .

Tap	navigation	on	open	pages:
	 Single-tap	in	the	middle	of	an	open	

page	to	bring	up	the	navigation	
header	and	footer .	The	footer	
lets	you	move	a	page	selector	
horizontally .

View.	In	the	header,	next	to	the	Library	
return	button,	a	List	View	button	
lets	you	view	pages	as	small,	but	
very	detailed	reductions .	Swipe	
up	or	down	to	navigate	to	nearby	
pages .	Tap	a	reduced	page	to	bring	
it	up	to	full	size .	

i The	only	negative	feature	of	iPad	
viewing	that	we’ve	experienced	
is	its	occasional	slow	rendering	of	
large	blow-ups .	Nearly	all	images	
will	zoom	to	maximum	screen	size	
when	tapped .

 Meet the Actions / Navigation

http://www.digitalsecrets.net/ActionsCS5/
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INFOBITES
In the land of information, the bite is king. It cuts to the chase and calls a 

spade a shovel. 

Throughout this eBook you will see paragraphs that are marked with the 

InfoBite symbol, i. Always purple / always pithy, infobite paragraphs 

tell you of things that you really should know, if even just for a few 

moments. 

Often InfoBites are the why behind the wherefore, or explain the 

what behind the huh.

In most cases, they are the secrets that are better off being 

whispered into your ear by The Great Voice of Reason, the clues 

that keep you from being clueless and the icing on the cupcake 

of tasty data.

i You don’t have to memorize the InfoBites, but they might just 

contain a tidbit that will trigger a memory during some future photo 

shoot or editing session. 

i In Apple's Safari, a few text panels show up with a black background and  

the type is not easy to read. Other browsers open this file in Adobe Reader,  

where the type and background are correctly displayed. iPads have no problem 

with these panels. You can always save this eBook and read it in Adobe Reader.
 
An example is on page 15. 
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You don’t just open Photoshop and think you’ve done your job—the 
magic is in how you work it. There are a HUGE number of hand tools 
at your fingertips, and each will achieve wonders. All you have to do 
is use each tool in exactly the right way at exactly the right time in an 
involved process. Often by rote. Sound easy? Maybe not. Pretty soon 
you’ll start wishing for power tools.

Assuming you know the basics, 
 

how to open, re-name and save image files, how to 

apply a Photoshop filter, make a selection and add text over an image—you 

are ready for Actions.

An Action is a string of steps in Photoshop. A recipe. A macro. A program. 

A fixed cluster of do this, do that commands all neatly formatted so you can 

run it anytime on an open image. Patiently, the string of instructions will wrestle the 

myriad functions of Photoshop into achieving some repeatable process, manipulation 

or effect. The seagull above wasn’t shot with a cross star filter, but the prospect of 

adding it later was in my mind as I clicked the shot. The Actions in this eBook are 

already written. You merely load them into your Photoshop CS5, then click on them to 

run their instructions automatically.

The image above started as the image at left. No cross star filter there, but in the 

final shot an Action has supplied the twinkle rays that add the missing fantasy.

Actions / Reactions
Before you begin...

Chapter 0
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No Photoshop book is going to spend the time and effort to guide you through 

a process with 20, or let alone 100, distinct steps. Nor should it. Once you get 

past about six or eight discrete sequential manipulations, a foo-factor sets in: 

The Primate Limit. Assuming you also are an advanced monkey-brain as I am, 

our casual limit for remembering a new set of sequential steps in any operation 

is around three. Hence, “simple as 1, 2, 3!”

It’s not for nothing they didn’t say “simple as 1, 2, 3, 4, 5, 6, 7, 8, 9!” 

Humans don’t often have the ability to quickly absorb even five steps dropped 

on them out of the blue. But that’s what Photoshop steps in a process can feel 

like. Steps are often not intuitive, and much of the time, some may seem trivial, 

but when the final result can is seen, oops, every step was important.

So how do we get correct results? Do all the steps in precisely the right 

sequence. But, unless you had the list of exact instructions at your elbow, you 

could forget about accurately remembering all those steps. You primate, you.

As complexity rises, our ability to deal with it while making a subtle or drastic 

mistake grows nearly exponentially. A 20-step process stops being obvious, 

interesting or even fun. But for a computer, it’s a piece of cake, a snap, no biggie.

Our minds may—read: definitely will—wander. We may substitute a 4 for a 6 

in a critical numeric entry. We may leave out a step. Suddenly five or 10 minutes 

worth of mind-numbing effort ends in a visual train wreck. Oh, the humanity!

And how do we recover from errors like this? Photoshop’s History Panel gives 

us a list of recent operations we have made, so there is a quick way of tracing 

backwards by clicking on earlier steps. But will we actually recognize that the 

11th step in a 20-step process was the one that went haywire? 

Fortunately, the Actions Panel in Photoshop CS5 is one of its greatest tools, 

because it lets us memorize scores—hundreds, even—of exact Photoshop steps 

to produce a desired visual result again and again.

Quick, Memorize this list of activities:
•	 Blink	three	times
•	 Wet	your	lips
•	 Flare	your	nostrils
•	 Crook	your	finger
•	 Lift	your	gaze
•	 Purse	your	lips
•	 Wink	your	left	eye	only
•	 Say	the	word,	“Sprocket”
•	 Smile	slightly
•	 Look	to	the	left
•	 Wink	your	right	eye
•	 Clap	your	hands	twice
•	 Sniff
•	 Slap	your	forehead	once
•	 Clear	your	throat
•	 Look	to	the	right
•	 Fake	a	hiccup
•	 Mutter,	“Ooo!”
•	 Touch	your	nose	with	your	still-crooked	finger
•	 Spin	around.

Each easy to do, but virtually impossible to remember by 
someone who isn’t a performance artist. And this is only 20 
easy body gestures. What if you had to make a sophisticated 
marionette accomplish all these steps? You’d probably get 
strung out.
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SEEING AND STORYTELLING
A photograph can be a story in a form analogous to speech. Every 

photographer is free to invent a new way of speaking through images. 

Photographs start with light, composition, framing, subject matter, 

gesture, life and color. Good photos are somewhat like a sentence. 

Subject, verb and modifiers are all represented. The verb idea is what 

your subject is doing. The modifiers are the elements like juxtaposition, 

perspective, color, environment, motion and tonality that enter into the 

communication. At the fundamental level, a photographic sentence might 

be, The Flower Exists, and that may be fine for evidence photography, but 

you usually wish to say more. 

The Flower Glows with Life, or The Flower is Covered With Dew, suggest 

an amplification of the image and tells a more interesting story by includ-

ing mood and/or environmental conditions.

When you get into the idea of mentally captioning your images as you 

take them, you will have transcended the obvious. As your photographic 

prowess expands, you will feel moments of storytelling coming together 

as you view, frame, compose and capture. 

Knowing that you have a range of options to complete your image later 

produces a mental feedback that expands your possibilities as you shoot.

THINKING IN ACTIONS
Included with this eBook are the over 700 iNovaFX Actions. Each 

expands the vocabulary of your photographic/storytelling options.

• Errors . Things like native barrel distortion, chromatic aberration and 

shots made at the wrong white balance can largely be eliminated from 

images with a key click. “The shot looks correct.”

Invent a story caption 
for each image. I’ll 
get you started. For 
the hydrant: “There’s 
one in every crowd.”
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Almost all images can be altered and 
improved. Some can be transformed into 
completely different representations of 
the original subject. The shot at left has 
been changed from a color scene into a 
pseudo-infrared monochrome image.

• Limitations . Aerial photos can have atmospheric haze removed. Low 

contrast images can be delicately improved by applying a localized contrast 

effect, which doesn’t alter exposure or brightness—just snap. Slightly miss-

focused shots can be sharpness-enhanced. Higher ISO sensitivities than 

those available in the camera may be implemented. Grain and color noise 

can sometimes be reduced in special ways that preserve detail. “In spite of 

unusual conditions, the shot looks like what my eyes saw.”

• Filters . Grad filters, cross star filters, color tint filters, color filtration for 

B&W exposures, infrared, polarizing filters and controllable diffusion filters 

may not need to be physically present on your lens to get the effect you 

wish. These software filters produce camera filter effects without the glass, 

reflections, flare or fingerprints. “We added some magic to the lens.”

• Conversions . Photographers have always sought to turn certain images 

into artwork, hand-crafted illustration and bold graphic results. Now digital 

techniques deliver on that promise in depth. Photos processed through 

certain Actions become oil paintings, watercolors, striking designs and delicate 

line drawings. “And you thought this was a simple photograph!”

• Amplification . Some images may feel ordinary at first, but with the right 

Action they can become—more. Bigger in their impact on your mind, stronger 

in their inherent story or more connected to 

your viewer’s attention span.

Since the eye of the beholder is in your head, 

you get to shape them so they reach their full 

potential. For some, these Actions are going to 

make all the difference. “Wholly cow!”
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ACTION ANATOMY
Actions* frequently duplicate layers, adding and combining opera-

tions into an orchestrated result. In most cases, the results are simpli-

fied into just a few layers or a new single layer image.

Some Actions change the whole image, producing a completely new 

image. Repairs to barrel distortion (iBC-series), for instance, pull the 

image back into straight-line linearity by tugging and pushing all of 

its pixels around until pinches and bulges are corrected.

Some cause tonality changes to global or local areas. When white 

balance or color correction is wrong (iCC-series), every pixel will be 

altered, but geometry, sharpness and exposure will remain the same.

Others retain the original image but add to it in various ways. Glass 

filter effects such as diffusion, halos, grads, cross star effects and 

vignettes usually keep the original untouched but superimpose layers 

over it to change the look of the shot.

Several series add frame effects to a picture. While the image is not 

changed, its presentation environment is. Now it becomes a sheet of 

film, a stamp or one of many diverse images on a single page.

Still others sharpen contours, reduce noise in areas of color 

and shading, alter tonalities or re-render the image into graphic 

interpretations.

You will have passed another milestone when you shoot your images 

knowing that a particular Action will likely complete the shot.

The Generic Action:

• RECORD MODE ON.

First: You do this.

Then: You do that.

Now: You do the 

other thi
ng.

Plus: Take a sna
pshot 

of what you did.

And: Change som
e-

thing major.

Next: Take anoth
er 

snap—what the h
eck, 

you might need 
it.

Also: Add a little
 bit 

here and 
there.

After that: Fudge it 

like so.
Furthermore: Tweak 

this and t
hat.

Then: Take a final 

snapshot
.

■ RECORD MODE OFF.

* “Actions” in this eBook, when capitalized, stand for the Photoshop Actions as opposed to simple physical 
actions or activities, such as waving your hand, thumbing your nose or clicking your mouse.
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PHOTOGRAPHY AS AN EFFECT
Photography of all kinds is its own sort 

of special effect. In your eye, it’s natural, 

but in a camera, it’s a huge assembly 

of esoteric technologies, scientific 

breakthroughs and oddball techniques 

that cause it to happen at all. 

Digital photography is such a desirable 

capability, and so pervasive, that nobody 

thinks of it as special any more. But out 

of Einstein’s initial understanding of the 

photoelectric effect, Galileo’s appreciation 

of optical craftsmanship, Smith and Boyle 

(Bell Labs, 1969) realization that image 

chips were possible, 

Bayer’s design of 

color separations from 

repeating patterns of 

color tiles—each of these 

being a wonder unto 

itself—digital photography 

has evolved into a mega 

wonder so commonplace 

that we rightfully take it for 

granted.

Is it a watercolor or elaborate pen and marker 
illustration? Of course it is neither. Two are from 
a series of interpretations. The image above this 
text is the original.
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AMPLIFY YOUR IMAGES
Most of your images will be straightfor-

ward representations of things the way they 

look to your eye. Snapshots of life’s events, 

pictures that remember who was where 

and when. Records of what stuff looked 

like under certain circumstances. These are 

photographic staples.

But some of your shots will beg to 

become more than what your eye saw. 

Artists play with images in ways they feel 

may add to their appeal. Communication is 

their art. Trying things in a variety of ways 

is common among painters, graphic artists, 

musicians, performers and achievers in 

every field. So it is with digital photography.

By applying various treatments, 

interpretations, alterations and adjustments 

to an image, you can add to its appeal, 

power and narrative.

Even the very first image ever captured 

and preserved for long term viewing is not 

immune from further treatment, amplifying 

its presence for illustrative value.

The world’s first snapshot; amplified. The snap, in this 
case, took eight hours in full daylight. © 1827 by Joseph 
Nicéphore Niépce. All rights reserved.

The above image isn’t Niépce’s. It has been processed 
with the iNovaFX iHalcyonWarm Action to make it look 
gratuitously “old.” © 2010 by Peter iNova. All rights once 
again reserved.

Niépce’s original is the smaller one at right.
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TESTING 1  2  3
In some production processes, testing one’s results for quality or 

effectiveness is a major part of the job. Actions provide a convenient 

way of testing images for expanded possibilities—because they are 

so effort-free. Actions that either preserve layers or save snapshots of 

intermediate steps may provide a basis for further manipulation. You 

might be only partly finished with a picture after applying just one 

Action.

COMBINING 1  2  3
When a single image is tested several ways with various iNovaFX 

Actions, the History Panel will load up with snapshots of variations 

and alternative treatments. 

Snapshots that appear with layers usually will allow copying a layer 

to the computer clipboard from one version, selecting a different 

variation, then pasting the copied layer onto it to produce new, 

combined results.

For example, the iHalo Action effect layer at middle right was deemed 

not quite enough. An added iCrosstar Action created a different effect 

layer result seen at the bottom. 

Are you thinking what I’m thinking? You 

could run both—halo, then cross star—then 

add both effects to the same shot by 

moving effect layers around. Since they’re 

layers, you have control over how they look.

Snapshots with several layers often retain a filtered 
effect as a separate layer (middle, bottom) riding 
above the original image. Be aware that you may 
have to flatten the image before saving it as a 
composite. If you run a different Action on the 
same original image, you may be able to add the 
effect layers together to achieve a result like the 
top image. 
Here’s a secret: Any light on a black background 
can be added over an image using the “Screen” 
blending mode. Screen behaves exactly like a 
double exposure.
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IN-REGISTER FX
It’s easy to select an Action’s effect layer, copy it and 

paste it on top of a different Snapshot, thus combin-

ing both effects.

i Usually, the effect layer is combined with the 

original image using a Blending Mode (Multiply, 

Darken, Screen, Overlay, etc.), which is displayed in 

a box in the upper left corner of the Actions Panel. 

i Alas, selecting and copying a layer doesn’t 

copy its Blending Mode, so when you paste it in a 

different image, you will have to change its Blending 

Mode to the desired state.

i Screen Blending Mode produces the exact same 

effect you would see from a double exposure. 

Think: two slide projections onto the same screen, 

one projecting the picture, the other projecting 

the effect. For effects like iCrosstar and iHaloCS5, Screen is the usual 

Blending Mode you will use, since those effects are made of light.

i With PS CS5, you can shoot images that are close to being in-

register and have Photoshop line them up for you later. Look for 

iNovaFX Actions called iStackCS5, iReRegister and iBlend[# of layers] 

in the iRegister folder.  (The hand-held image here used iBlend6 and 

is made from six images shot at the Getty Museum in Los Angeles.)

i The CS5 Action, iStackCS5 asks you to identify the shots as 

either ones currently Open, or all that are in a specific folder. If you 

check the Attempt to Automatically Align Source Images box, it will 

perform what iReRegister does, as well.

Museums are notorious for preventing tripod use. But some kinds of shots 
would be better if a tripod were employed. This series of images were 
gathered in Continuous mode, but hand-held minus a tripod. Photoshop’s 
Load Files into Stack and Auto-Align Layers features make setting up 
this stack into quick work. Now it’s a sort of time-lapse still image. Actions 
made this sort of assembly easy. The equal participation of all six images 
and its automatic registration were achieved with the Action called 
iFrameAvg-6Shot seen on page 223-224.
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Here’s a cross star effect overlaying the 
original image. Above the effect layer is an 
Adjustment Layer for Hue/Saturation. It is 
connected only to the layer, X, below it and 
does not affect the Background layer.
The inset shows what the natural color of the 
cross star effect looks like with the Adjustment 
Layer turned off.

LAYER EFFECTS
Many iNovaFX Actions take advantage of Adjustment 

Layers, which alter only the content layer immediately 

below them. Look for the tell-tale Adjustment Layer graph-

ics and a bent, downward turning arrow to the left of icons 

and matte windows.

The chief advantage to leaving a snapshot in this state is 

that further adjustment of layers is instantly available, later. 

It’s easy to flatten all layers into a composite, single layer 

image, then save it under a new name, but as long as an 

Adjustment Layer remains active, its current condition can 

be regarded as a recommendation rather than as 

a final decision. The existence of an Adjustment 

Layer means that editing to this point has been 

nondestructive (not yet resolved). 

In Photoshop CS5, Adjustment Layers can be 

live instances of Curves, Hue/Saturation, Levels, Solid 
Color, Gradient, Pattern, Color Balance, Brightness/Contrast, 
Exposure, Photo Filter (color), Selective Color, Channel Mixer, 
Vibrance, Gradient Map, Black & White, Invert, Threshold or 

Posterize. Previous Photoshop versions offer fewer options.

i If you do move a layer to a different snapshot, then select any other snapshot, 

the move will be lost. After adding anything to a snapshot, immediately make a new 

snapshot to preserve both the move and your ability to backup a step.

If you make an Adjustment 
Layer but forget to tie 
it exclusively to the next 
layer down, there’s a quick 
fix: Highlight the Adjustment 

Layer and press Control 
+ Alt + G (Windows) or 
Command + Option + G 
(Mac).
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ACTION BEHAVIORS
Two basic modes exist within Photoshop to select and imple-

ment Actions. They’re called List View and Button Mode.

Button Mode creates a window full of individual Actions by 

name, each in its own rectangular box that can be pressed 

(with a mouse click) like a button. 

If an Action includes an instruction that stops all continu-

ing operation—perhaps to accommodate input or manipu-

lations you make manually—the button becomes fierce 

red, indicating that it should not be ignored. Re-clicking 

the bright red button continues from where it left off.

i Neither mode is perfect. Button Mode feels overly 

simple, and List View can seem like too many details 

to absorb at a glance. List View allows you to edit and 

create Actions, so it’s worth studying.

When using List View, any stop in the stream—even just 

for a cautionary note—will open the usually collapsed 

list. Now you see all its instructions in a vertical column 

as in the top example here. The cautionary note can be a 

reminder, a heads-up concerning something that is about to require action from 

you or a note telling you of some special condition that now is in play.

STOP
Sometimes you will come to a full STOP, and Continue will not be an option. This can 

occur for a variety of reasons. The Action may have stopped so you can perform some 

activity that can only be done by hand, such as a painting or retouching operation. 

Top, Button Mode with the iBaby1V (one 
of several variations) identified, but when it 
is stopped mid-stream (bottom) the button 
becomes bright red. In use, a second click 
resumes carrying out operations until it 
pauses, stops again or finishes.

At right, List View showing that both the 
iComplexArt folder and the iGrad folder are 
open, and the individual Action, iGradAmber, 
is open, showing its list of instructions. At 
far right, the iCanvasPainting3 has been 
opened—one of the iComplexArtFX-series—
shoving everything farther below. Note that 
the seventh instruction, Curves is also open 
with a down-pointing arrow, showing its 
internal settings.

No wonder Button Mode seems so simple 
and List View seems so complex. But most 
of the time, List View is collapsed to a list of 
Action names, making it more accessible.



  22 | CHAPTER 0       ACTIONS CS5

Some Photoshop activities can’t be fully controlled by an Action and you must do something 

manually. We’ve tried to spot these and warn you about them in alert windows. Reducing an 

image so 100% of its pixels are seen is needed when a basic Paste command is issued. Paste 

attempts to drop a clipboard element smaller than a full frame into the dead center of the 

existing view. If that view is offset—as is often the case when it extends beyond the current 

frame—the pasted image won’t be perfectly centered and this might mess things up. In some 

few Actions, the incoming Pasted image MUST be centered. Where that’s needed, a Stop 

command plus an alert window will clue you into what’s needed.

i You can shrink an open image window to fit on your computer screen with a handy 

keyboard shortcut. For Windows, hold down the Control key and tap the minus (–) key. Each 

tap shrinks the image by about 33%. For Macintosh computers, the same idea uses the Com-

mand key with the minus key. Enlarging the image employs the plus key (+) in the same way.

i For all other keyboard shortcuts, we will write out the Key(s) that must be pressed, fol-

lowed by a plus sign, followed by the character key that activates the operation. Microsoft OS 

/ Mac OS commands will be written in that order.  Oddly, the unique command to enlarge the 

image window would look like this: Control + + / Command + +, which is slightly confusing.  

This one makes more sense: Shift + F, which steps through a loop of three different display 

formats, but you must press it three times to get back to your original floating image window.

RESTARTING
To move forward from a stopped place, close the alert window (when Continue is an 

option), automatically rejoining the next steps. Or if you have Stopped to do some more 

complex operation, click on the right facing Play arrow at the bottom of the Action 

Panel. It will continue with the next instruction, continuing until finished or another Stop 

is encountered.

With the Actions Panel in List View, 
the right-facing arrow in the bottom 
border is the RUN command.
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HOW AN ACTION WORKS
As an Action unfolds, it’s a sequence of steps in a unified process.  You could 

perform these actions manually.  While that is simple in principle, in many cases it is 

unreasonable to ask mere mortal human to apply even 10 discrete steps of manipula-

tion to an image to produce a single, seemingly minor adjustment to it. 

i Bear with us. We’ll show you what’s going on under the hood of an Action, 

then get to the juicy, automatic Actions in a few pages. If you just can’t wait, you 

can jump ahead by clicking on this link.

Here’s an example. The Goal here is to adjust a photographic image that has a 

noticeable degree of chromatic aberration, caused by a particular 

setting of zoom and focus. Photographers often refer to chromatic 

aberration by the acronym CA. Photoshop CS5 has a built-in feature 

that simplifies elimination of chromatic aberration,  but bear with us 

before you decide it’s all you’ll ever need. 

Lens designers try to avoid artifacts like this, but they are faced 

with multiple goals of radial sharpness, tangential sharpness, zoom 

magnification, barrel and pincushion distortion, dimensional linearity, 

flatness of field, evenness of light distribution and CA.  If they fail, the 

image may bulge, have astigmatism, be soft in its corners, vignette 

its light distribution or show small color fringes, especially in the 

extreme corners of the image.

CA appears when light of particular color is either focused behind 

or in front of the image plane while other colors arrive in a more 

coordinated manner. Alternatively, light of a particular narrow 

spectrum can form an image that is in focus but is a tiny percent 

larger or smaller than other colors. This last version is the most 

common, so let’s fix it with a series of manual tweaks.

Image corners reveal classic chromatic aberrations. The phenomenon (enlarged crop) appears as 
a color fringe around contrasty detail. Changing the size of an individual red, green or blue color 
channel can improve the view. The CA seen here is a combination of Red/Cyan and Magenta/
Green, producing a Red/Green result. Digital images are sharpest in their Green channel, so it’s 
prudent to only alter the scale of the Red and/or Blue channels.
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Theory of adjustment . We know that the green layer of an RGB image 

accounts for most of its perceived sharpness, so we use that layer 

as the standard to which other color layers will be compared. We see 

that a Red/Cyan fringe is showing up in the corners of our shot, so 

we will first size-adjust the Red channel of our shot, aligning it more 

in-register with the Green and Blue channels. 

1 . First we select only the Red channel.  (Windows: Control + 1 / Mac: 

Command + 1) Now we see a black and white image of the Red chan-

nel by itself.  If Photoshop’s Preferences > Interface has been instructed 

to Show Channels in Color, then the image is a red and black image. 

Intuitive, but more difficult to see in detail.

Operational caveat . Re sizing the individual channel can only happen if 

that channel can be scaled larger or smaller about its optical center.  Its 

optical center is only intact in an original file that hasn’t been cropped.

2 . We select the whole Red channel image with a Select All command 

(Control + A / Command + A). Selection’s marching ants surround the 

Red channel image at its farthest edges.

3 . To scale the image, we will change its size with the Transform feature 

(Control + T / Command + T).

Photoshop Tool Behavior requirement . Selecting an image is one 

thing, but we must make sure that any change originates in its center. 

In the upper left corner of the Transform 

tool header is an icon called the Reference 

Point Locator that causes transformations to 

operate from any corner, from the middle of 

any side, or from the center of the image. If it 

isn’t already selected, click the center box.

The optical center of the full frame, above, is 
the same point from which chromatic aberration 
phenomena radiate (middle). When the image is 
cropped and leveled, the optical center (yellow) 
stays with the image’s pixels, but any attempt 
to repair chromatic aberration will be tied to the 
center of the remaining cropped image (bottom). 
The moral to the story: Only repair chromatic 
aberrations with full, original frames.
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4 . We want the scaling to be linked in both vertical and horizontal direc-

tions, so we look for the W and H (Width and Height) boxes.  Between them 

is a link. Click the link.  Now they are tied.

Experience notation . Photoshop’s scaling via numeric entries is only 0.1% 

accurate. Image size adjustments don’t change with two decimal places of 

precision.

5 . We guess that the amount of needed change to the Red channel is about 

99.9%, so we enter that amount in either of the W or H boxes and hit return. 

Our image twitches slightly.  The Red channel has become 99.9% of its 

previous horizontal and vertical dimensions.

6 . Dismiss the Transform tool (Control + Return / Command + Return), so 

we can view our result.

7 . View the full color image by pressing the tilde (~) key, or use Control + 

~ / Command + ~. The slightly smaller Red channel has a cyan border a few 

pixels wide surrounding the image.

Whoops, it isn’t quite perfect.  Some residual CA still colors the shot. 

8-15 . Go back to the original image and try steps 1-7 it again, but this time, 

put in a value of 99.7% and see if you like it better.

Drat.  Too much correction. Now the CA is inverted with colors on the 

opposite side of small details. 

16-23 . Go back to the beginning and try 99.8%. 

That’s much better (at least for our example image it was). But there is still 

just one more thing. 

Final tweak . The Red channel has shrunk, leaving the Green and Blue chan-

nels at full size.  A thin cyan border one or two pixels wide surrounds the 

color image. 

At 99.9% scale, the CA still shows (top). The middle image 
shows what we see at 99.7% scale. The fringe is now on the 
other side of details. At bottom, we see 99.8% scale. This is 
about as close to correct as we can produce numerically.
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25 . Interestingly, the Red Channel is still selected, even 

when the RGB image is showing, so clicking on Image > Crop 

will trim to it exactly.  The picture will have lost a few pixels in 

dimension, but nobody will ever notice that. What’s far more 

important is that you will know you’ve done your best to lift 

your image above the limitations of DSLR technologies.

26 . Save that picture with a new name to a convenient 

place in your photo library.

It was simple; it was easy. Somewhere between 10 and 26 

steps later you will have improved any red fringing from chro-

matic aberration that showed up in the corners of your image. 

By now you will be wishing for some sort of power tool to do all 

this grunt-work for you . Until PS CS4 showed up,  that’s where 

Actions came in .

Conceivably, you could record an Action that followed 

all nine image tweaking and cropping steps, thus saving 

yourself all that work for every shot made with this lens 

at this zoom setting.

We have gone one step farther. An Action set called iCrAb, which contains a bunch of 

individual Actions for reducing chromatic aberrations. 

Near the top of the list is iCrAbRedShrinkMaster.  It is to be used ONLY with an 

original image, not a crop, and it automatically performs every Red channel size 

reduction possible from 99.9% to 99.1% in 0.1% decrements, leaving each variation as 

an individual snapshot in the History Panel, so you can click on them and find the one 

that seems to do the job best with the current image.

There are also iCrAbRedExpandMaster, iCrAbBlueShrinkMaster and iCrAbBlueEx-

pandMaster Actions as well, each doing reductions or enlargements of individual color 

channels by 0.1% changes, leaving snapshots in their wakes.

The final image with all its complex detail is far freer of 
chromatic aberration and this is very detectable in prints 
larger than 4 x 6. But the real story here is not how well 
you fixed the picture, it’s all about how much work you 
went through by scaling individual color channels to get 
there.

The Actions set, iCrAb (Chromatic Aberration), may be 
used with Photoshop versions clear back to PS7.

Photoshop CS5 has Lens Correction settings that 
eliminate the need to use this manual process or the iCrAb 
Actions. Though tempting, these may not be as precise as 
you may wish.
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i You may need to alter Red and Blue to achieve a more perfect result. Often it is not techni-

cally possible to completely reduce CA to zero, but usually you can reduce it significantly.

i To move both Red and Blue, run Red first, since its effect is easier to spot. Select the 

Snapshot that seems to reduce its effect the best, then use that for your new starting place 

as you apply a Blue correction.

Other iCrAb Actions in the set (iRedShrink1, 2, 3 ...7, etc.) work through different principles, 

so you may wish to try them on problem images.

i All of the iCrAb Actions work with all sizes and orientations of image, but must be used on 

original camera files before other alterations or Actions modify the shot.

HISTORICAL NOTE:
i This process of expanding or shrinking individual color channels was first embodied in the 

original iCrAb Photoshop Actions that appeared in the year 2000 and were distributed with our 

first digital photography eBook back then. Copies were purchased by people at Adobe, Nikon, 

Canon and other software producers. Around 2005, Adobe and others acted on the idea that 

size control of RGB channels held the key to chromatic aberration repair. Adobe’s latest embodi-

ment of CA repair appears in CS5’s Filter > Lens Correction > Chromatic Aberration and neither the Auto 

Correction (which uses a numerical look-up database for each camera body/lens combination) or 

Custom (Manual) options appear to be as accurate and aberration-free as our own iCrAb series. 

For speed, use the CS5 version. For the greatest precision, use the iCrAb versions.

Within iCrAb’s folder of 
Actions lie four Master 
expand and shrink Actions 
that create every up or 
down scale variation 
within Photoshop’s 0.1% 
range of scale changing. 
The other Actions in this 
series use a different 
method of scaling and are 
a bit more precise, but 
slower to execute.

Original with CA / Photoshop CS5 auto correction 
repair (linked to lens database) / iCrAb two-
pass version. This is the upper left corner of an 
8-megapixel original. Fine details show that the PS 
CS5 automatic option didn’t improve it much, but 
running the iCrAbRedShrinkMaster followed by the 
iCrAbBlueShrinkMaster (after selecting the Red 99.8% 
snapshot) produced the image on the right. iCrAb in 
CS5 runs extremely quickly and not only produces a 
superior result, but takes very little extra time. Original                                                                             CS5 Auto                                                                          iCrAb 2 pass
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POP CA QUIZ:
Find an image in your collection that shows corner chromatic aberration somewhat 

like the iCrAbVatican .jpg image on this CD to practice the steps that reduce this 

aberration.  That practice shot is in the folder called Example Images. 

But before you do, close this eBook and no peeking. It’s not hard. It’s only a 

10-step, easy-as-pie fix with each step logically leading to the next.

If you are like most people, you will gravitate to the power tool of an Action or 

other chromatic aberration reducing utility the next time you need to adjust an 

image this way.

And that goes for almost any image correction, enhancement or transformation 

that you will wish to apply frequently. In the coming pages you will learn how to 

make Actions, how to modify them and how to use the hundreds of iNovaFX Photo-

shop Actions as power tools for your digital darkroom. 

i Photoshop CS2 - CS5 have a new feature not seen in previous versions. It’s found 

under Filter > Distort > Lens Correction and provides some basic Barrel / Pincushion distor-

tion, Chromatic Aberration, Vignette, Perspective transformation and tilt correction 

accompanied by a convenient grid overlay. Our thirty-second review of this feature 

is seven on a scale of ten. Its CA and Vignette corrections are well implemented and 

interactive, while its Barrel distortion and Perspective correction features are less 

accurate or less convenient than using other means within Photoshop to achieve the 

desired results. The best implementation of this feature appeared in PS CS4.

i Photoshop CS5 moved this function to a more directly accessible place right 

under the Filter menu item, added a Green/Magenta Fringe manual correction 

slider to The Red/Cyan and Yellow/Blue versions and changed the emphasis of the 

numerical readouts associated with each adjustment. We wanted this feature to 

be wonderful, but it doesn’t improve much on the previous version and the Auto 

Correction option is not as precise as we had hoped.

Pop Quiz
No Peeking

No Turning Pages
No Crib Notes
No Cheating

No Asking Your Neighbor
No Using the CA Actions

You must do all the steps
from memory, applying the
principles of CA reduction
using Photoshop's tools 

alone.

Begin.
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Clearly the problem with a small fix like this is that you might have to try a number 

of different values to find the one that best matches the problem. And each time you 

did the test, you would have to do all of the steps perfectly, or your results would be 

untrustworthy. 

So our iCrAb(color)(shrink/expand)Master Photoshop Actions do the grunt work for 

you. They perform a series of color channel scale reductions and leaves a string of 

Snapshots in the History Panel for you to choose from. They work with any size image, 

horizontal or vertical. Click on any snapshot to see how much better it has adjusted 

any single color fringe, then run the other color of Shrink or Expand on your first 

result, then look for a snapshot that is even more refined. The green channel is not 

touched, nor should it be, since the green channel of an RGB image contains the most 

accurate record of detail (59%). 

i By appropriately adjusting the Red and/or Blue channels, all variations of color 

fringing may be repaired. Magenta/Green fringes are due to both Red and Blue being 

together in their degree of offset. Yellow/Blue fringes result from Blue channel offset 

alone, and Red/Cyan fringes are the result of only the Red channel being offset.

HISTORY PANEL VIEWING
It is common to have the History Panel open and accessible when using Photoshop. 

If it isn’t open right now, you can make it visible by selecting Window > History in the 

header bar. Most iNovaFX Photoshop Actions generate a new Snapshot when they 

finish working, and it joins others at the top of the History Panel. 

Sometimes it’s simply called Snapshot 1, 2, 3... or it has been custom labeled with 

the Action’s name and shorthand notes such as “xxxLayers” or “Blue 99.5%.”
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i The iCrAbRedShrinkMaster series creates Snapshot titles like this: 

   Red 99 .9% 

   Red 99 .8% 

   Red 99 .7% 

   Red 99 .6% . . . 

It doesn’t take much code-breaking effort to tell at a glance what 

the critical magnification factor is, what sort of operation has been 

performed, and which color channel was involved.

In some Actions we have renamed the original file before running an 

operation, for technical reasons. Often it becomes Original so subse-

quent steps can identify it.  

i In the iCrAb . . .Master series, you end up with ten images in the His-

tory Panel. Your original, intact with its original name or file number, 

plus the nine incremental variations in 0.1% steps. You won’t see many 

images with more than 0.5% chromatic aberrations, but the other, 

higher values are there for emergencies. 

i When you zoom into a snapshot, then select a different snapshot, 

the zoomed-in scale and framing are retained, so you can inspect and 

compare enlarged areas sensibly.

i You can step forward or backward through multiple snapshots with 

these keyboard shortcut strokes:

Windows forward: Control + Shift + Z

Windows backward: Control + Alt + Z

Macintosh forward: Command + Shift + Z

Macintosh backward: Command + Option + Z
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INSTALLING ACTIONS
Photoshop Actions load into the window called the Actions Panel, which can be 

made visible through the Window > Actions command in the Menu bar.

By default, this window will open on the right side of the screen and can be 

sized small or large to your taste. Grabbing its tab and dragging that to another 

Panel will make Actions one of several tabs in that group, only one of which can 

be seen fully at one time. 

The current Photoshop is Photoshop CS5, in its twelfth generation, and many of its 

features are updated, enhanced and improved from CS4 and earlier versions. 

A case in point is the Edit > Automation > Photomerge feature in CS5, which stitches 

overlapping panels of a panoramic image into a corrected single larger image.  Prior 

versions of Photomerge were not nearly as precise.

i The shot here is a three-segment example that used the Photomerge Cylindrical 

option. A special iNovaFX Action in a folder called iPanoCylinderEdge > iPMCylinderEdge3 

(different Actions are numbered matching the number of panoramic elements) pro-

vides a bonus that Photoshop alone won’t give you: The clean round edges seen here 

are very different from the rough, stepped edges Photomerge intrinsically produces.

What’s with this panoramic image? It’s an elaborate sculptural musical instrument 
installation at the Getty Museum in Los Angeles. The people are waiting for it to play. 
Sadly, the magic was that it issued notes and sound at all, not that it sounded good. 
But I digress. The smoothly curved edge of the stitched panoramic image is the 
result of iPMCylinderEdge3 which works on panoramics you’ve assembled using the 
superior Photomerge feature of CS5 with three original images. Without the Action, 
the edges would be stepped, not smooth.

Actions load into 
the Actions Panel, a 
window that you can 
show or hide within 
Photoshop. List 
view allows you to 
see them enclosed 
within folders. The 
side arrows twirl to 
reveal individual 
Actions. Twirling 
an Action’s arrow 
reveals its internal 
steps.
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ACTION REACTIONS
Every Photoshop Action causes its own reaction. For some, like the 

correction of a mistake, aberration or flaw, the viewer never knows a 

correction has been applied.  Had no fix been made, perhaps a nega-

tive reaction would have occurred.

For others, like the conversion of a photograph into a watercolor 

painting, the reaction from viewers can be strong and positive.  Much 

of the impact of an image depends on how well its visual treatment 

mates with its subject matter and technical attributes. 

One rule dominates: Select the Action to produce the viewer 

reaction you wish to bring forth.

i Sometimes you will have to predict how an Action may 

complete the image as you shoot.  For instance, the iPolarizeSky 

Actions work best with strong blue skies since they trigger most 

cleanly off of clear blue pixels.

CORRECTIVE ACTIONS
Flaws from optics, camera settings and pilot errors made 

while shooting are sometimes correctable.  Truly awful color balance 

isn’t always fixable, but often it can be steered into a decent looking 

version of reality.  Most lens distortions can be tweaked into a non-

distorted state by manipulating image geometry selectively.

Sometimes nature hands you a photographic problem with excessive 

haze or natural atmospheric phenomena.  Aerial views look washed 

out, but can be largely repaired with the right Action.
A real photographer would never make the mistake of shooting 
outdoors with the camera set to incandescent white balance. But if I 
ever do, there’s always the iCCDaylight/IncanWB Action.
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OPTICAL FILTER ACTIONS
Optical filters require you to decide to use them before taking the 

picture. They embody the Law Of The Haircut. Un-cutting is impossible. 

Many iNovaFX Actions let you make these sorts of decisions on your 

computer where you have much more control.

Gradation filters, cross star effects, selective focus, refined exposure, 

diffusion filters, halo effect filters, polarizing filters and color filters 

for black and white photography previously were decisions you could 

never make later when things were quieter and more contemplative.

GRAD FILTER ACTIONS
Cinematographers frequently use grad filters to control the extreme 

contrast between sky and foreground subjects. Imaging systems like 

digital cameras often can’t catch the scene the way our eyes do. Not so 

surprising, considering that our eyes—once brightness adapted to the 

local lighting—operate over a tonal range of about 30,000:1. Film, video 

and digital photography are usually working with less than a 2,000:1 ratio 

between blackest black and bleached-out highlight white. RAW images 

provide a superior tonality range for interpretation in the digital dark-

room, but they’re something you must plan for. For JPEG images, you 

may have to resort to a grad filter to supply some missing sky dynamics.

Usually grad filters are clear on one half and dark or colored on the 

other half, blending gradually (grad; get it?) from one state to the other.

Action intervention. No polarizer 
was used to deepen the clear blue 
sky, above, and the sky behind the 
rider was bleached to maximum 
white. 
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FRAMING ACTIONS
Border treatments can complete an image by adding a graphic 

treatment to expand the context of the image. While numerous 

border treatment programs exist to provide this function, we 

have concentrated our efforts in making borders that look 

like the native frames caused by certain film photographic 

processes. Roll film, sheet film and 35mm frames are here. 

Additionally, stamp borders with a graphic perforation allow 

you to make images that appear to be stamps enlarged dra-

matically.

MULTIPLE IMAGES ON A PAGE
With more than one image per page, collections of images 

that complete a theme, sequence or story can be tied together. 

Actions to assemble these in groups of four and 16 are 

included.

Assembling images is an advanced 
form of storytelling. Placing an image 
in the context of a film frame suggests 
to viewers that the image is free of 
manipulation. Like a novel advertised 
as “Based on a true story.”
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VISUAL EFFECTS ACTIONS
The digital darkroom offers more control and a greater range of basic 

image alteration and manipulation opportunities than anything previ-

ous. Skies can be completely replaced, lighting apparently altered, and 

Photoshop’s own plug-in special effects filters can be used in alternate 

ways to achieve a wide range of new image treatments.

PHOTOSHOP FX ACTIONS
Photoshop has “Filters” that produce dedicated effects, most with 

special controls with names including

• Stroke Width • Paper Brightness • Edge Simplicity
• Brush Size • Glow Brightness • Stroke Detail
• Definition • Scaling • Edge Thickness
• Relief • Direction Balance • Spray Radius
• Fiber Length • Cell Size • Grout Width
...and many more. 

Memorizing the implications of all of these will take you months. 

Some of our iPS-series of Actions provide alternative starting places 

for photographic image manipulations using these effect tools. Others 

add some steps to get a better result from the primary Photoshop 

Filter, and still others combine several PS Filters into a logical variation.Photoshop’s own “Filters” can often seem difficult 
to wrestle. Our variations use them to deliver more 
interesting results quickly.
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PRINT PREPARATION ACTIONS 
Wet darkrooms had special chemicals and handling procedures that 

produced numerous printing options. These Actions emulate and 

expand on those techniques.

You can create printer-ready duotones, tints, sepia effects, aging 

effects, contrast enhancements and color tweaks that are more 

effective in printing than in viewing on the computer screen or Web.

We recommend that you shoot in color, even if 
monochrome will become the final result. Above, a 
distressed Sepia aged print effect, at right an Action has 
brought out an inner glow. Below, one image as if seen 
through B&W filters in green, blue, red, orange and yellow.
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GRAPHIC PHOTO FANTASIES
The eye’s the limit. Anything you can visualize adding to an image 

can be achieved, if you have enough time and money. Or the complete 

set of iNovaFX Photoshop Actions.

There is no rule that states you can only apply one idea to an image. Within iNovaFX 
Actions several ideas are usually at work. Sometimes you will wish to add some of the 
ideas as you shoot, and some of them later in the digital darkroom. At left, a panoramic 
was shot in three segments and later turned into a stylized graphic with iSumi-E. Below, 
two shots made within moments of each other have been turned into wild graphics with 
iBubble Actions. Intentional camera motion produced the streaks.
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ACTION PACKING
Actions are a box. They produce the same result over and 

over. But that doesn’t mean you aren’t free to think outside the 

Action.

Tweaks you make to the image—before or after an Action 

runs—can drastically change the result. Sometimes the lens only 

makes the initial sketch. You have to add the rest of the picture 

by hand, by computer, and by experience.

Running an Action is not the end of the process. It can 

be—as with the top image—just one step in a tangled path. 

Here, a fisheye image wasn’t a full frame circle, so a circular 

mask was artificially introduced to force the idea. Extra 

black margin was added to serve as a matte frame. 

Areas of extra sky and foreground sidewalk were retouched to 

extend the original image into the full circle. The iLiner3A Action 

provided the unexpected cartoon-graphic interpretation of the 

manipulated, cropped, retouched, bordered fisheye point of view.

The bottom image was easier. It used the same Action, but was 

shot with a full-circle fisheye adapter1 over the lens.

1 Nikon (not Nikkor) FC-E9 mounted on several step-down rings onto a zoom lens. 
This optic is currently very hard to find. Originally it sold for about $250 US.
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Of all the mighty features in Photoshop, the ability 
to write and recycle sequences of steps as Actions is 
up at the top of the list for power, usefulness, and 
accomplishment, but many Photoshop users don’t use the 
Actions Panel very much. It’s almost a Big Hidden Secret. 

S ecrets are only mysterious when they are kept. I’ll let you in on 

the Big Secret: Actions often seem more complicated at first 

than they really are. In this chapter you will build two different 

Photoshop Actions—one relatively simple, and one relatively complex—

and save them, so any time you wish to accomplish their results for a 

new picture, all you will have to do is look them up and click.

The image on this page is emblematic of a condition that you may or 

may not have noticed. The zoom lenses that make digital photography 

such a pleasure contain a fatal flaw: Barrel distortion.

i Bear With Us, Part II. Chapter 1 shows you how to make Actions. 

But if you just want to get to using them, jump to Chapter 2.

Action Creation
Making simple and complex Actions yourself

Chapter 1

Most people might not notice the flaw in this image, but the architect 
would. The straight lines of the building, at the edges of the shot, 
are not really straight. Straight yellow lines superimposed over 
selected straight features reveal the geometric flaws. Especially the 
line at the top of the window. You will soon learn how to fix this.
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While you will likely never perceive distortion in images of people, flowers, 

skies or sports activities, any time a straight line cuts across your image, 

such as a horizon, building or flag pole, you will see a slight curve distort-

ing the subject. A prime lens won’t show this effect unless it is a fisheye 

lens which shows the phenomenon on purpose.

BARREL DISTORTION REDUCTION
Zoom lenses produce geometric distortions that change as the zoom 

lens moves from wide to telephoto. Typically, barrel distortion at wide 

zoom positions and pincushion distortion at tele positions. 

Barrel distortion bulges the image out from center and pincushion 

distortion pinches it inward. Lens designers try to minimize this as much 

as possible, but inevitably they must compromise the prescription and 

accept some balance of distortion at the extremes of the zoom range.

We are going to create an Action that rectifies linearity for a particular lens 

at a particular zoom setting. Before we begin to record the Action, open 

Images-Demos > ActionsExtras > Example Images > BarrelAction .jpg. 

We use this image because it shows architectural, straight-line detail. 

As you write an Action, you want an example image that will show 

unambiguous results when you get 

the numbers and operations in your 

Action correct. Once the de-barrel 

Action is right, you can use it with 

any image from that lens and zoom 

setting, knowing that straight lines 

will be preserved.

Not every image shows its barrel distortion as much as this. Look at the top line of the 
windows. Below are two additional images made with the same lens at the same zoom 
position. Neither cries out for barrel correction.
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EASY BARREL CORRECTION
Photoshop versions from PS V.6 through PS CS5 (V.12) all contain the same Spherize and Pinch operations found in Filter > Distort > Spherize 

-or- Pinch. These two operations are not mirror images of each other. Spherize renders the image as if it were inflated as a hard-edged 

spherical bulge (positive numbers) or dimple (negative numbers) from a flat surface. Pinch squeezes images into a central concentration 

(positive numbers) or central expansion (negative numbers) while gradually allowing the boundary to flow into the original plane. 

Both work a circular area when the canvas is square. So do lenses. But our photos are rectangular in aspect. We must deal with that.

i Compare upper and lower rows of the distorted grids to get an idea of how these functions operate on images. Each is over/below its 

logical counterpart.

Just to complicate things, many zoom lenses don’t produce a simple bulge that distorts all parts of the image to the same continuous 

curve. A straight line near the edge of an image might look straight in the corners while bulging nearer the middle of the frame. In a way, 

it would form a very shallow M along the bottom, and indeed, some have called this a “moustache” curve. 

Any well-tempered de-barrel Action will have to deal with this complex geometry. The one you are going to build here will.

Photoshop’s two tools, Pinch and Spherize, 
compete for use in reducing barrel distortion. 

Top row: Original grid, Pinch +25, Pinch +50, 
Pinch -25, Pinch -50. Negative Pinch is not the 
same as positive Spherize.

Bottom row: Spherize -25, Spherize -50, 
Spherize +25, Spherize +50.
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ACTION IN PRINCIPLE
Photoshop’s Pinch operation concentrates its distortion in the middle while gradually blending its influence at its perimeter. 

Perhaps embedding the original image in a square canvas of exactly the right size and then by using Pinch at the right amount 

of influence, the whole barrel distortion may go away, having been 

reverse-distorted from the camera original. 

It’s worth a try.

Our goal can be loose or exacting, depending on the use for the final 

image. If it is to be a casual photo of a natural subject, you may not 

need to correct it at all. But if it includes a horizon or architectural detail 

that calls attention to the 

distortion, you may wish to 

correct it just enough so that 

the flaw is no longer offend-

ing the eye of the beholder. 

i If you are using the image 

for precision work, say, with 

other images in a linear pan-

oramic or multi-frame assem-

bly, you may wish to correct it 

down to pixel-perfect.

Bent but not broken.

Certainly Venice’s picturesque old 
buildings are not all perfectly straight, 
but this goes too far. At far right, the 
repaired version with superimposed 
straight lines used to verify if the 
image is more correct.
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RECORD A SIMPLE BARREL DISTORTION ACTION
If Button View is On in the Actions Panel menu, then uncheck it, or set it to List View. 

Open the BarrelAction .jpg image in the Example Images folder on this CD.

Create a folder for the upcoming Action. You do this by clicking on the folder icon at the 

bottom of the Actions window. Call it something 

memorable like, Barrel Begone, or some such.* The 

folder will appear at the bottom of any previously 

existing Actions seen in the List View.

Now create the first Action for that folder.  You do 

this by clicking on the “Create New Action” icon that 

looks like a document with its lower left corner folded 

in. (Next to the trash icon.)

Give it a name that makes it memorable, too. 

Our test image is from the Nikkor 18-200VR DX lens 

shot at 18mm, so Nik18-200@18 works for me.

i None of these procedures are yet being recorded. 

While it is possible to have an Action open a specific 

image, it is not possible to have an Action create 

another Action. You can imagine how confusing that 

might become.

i Set the Tool Panel’s Foreground Color to a color 

that will contrast easily with all the tonalities of the edges of your image. For this picture, that 

could be orange or purple, but gray or dark tan might not be as good. This is for an upcom-

ing step that will surround the image with that color. You’ll see why in a moment or three.

*We called ours iBC-DIY (for do it yourself).
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RECORDING THE ACTION
Click on the round dot, •, at the bottom of the List View if it isn’t 

already active. When recording, it turns red, •, indicating that record-

ing is happening. We will use the dot • in our instruction to mark 

processes that become recorded steps. 

i During recording, the position of the cursor is not being recorded, 

only significant operations from Photoshop’s many features.

• Invoke the Image > Image Size function. Set Width: > 4500 pixels, and 

make sure the Constrain Proportions option is checked. Check Resample 
Image and use the Bicubic Smoother option if enlarging the image from a 

6MP or 8MP original. If the original camera image is 10MP or larger, 

use the Bicubic option. Your image is now 4500 pixels wide by about 

3000 pixels tall if it has come from a 3:2 aspect original. 

i Vertical pixel count may change from model to model. It’s 

because cameras don’t always have perfect 3:2 math in the pixel 

count of their images. 

i Cameras that use the 4:3 format will generate an image 4500 x 

3375 pixels.

• Use the toolbox to reset the Foreground and Background colors 

to their default white background and black foreground. One of these 

will frame the image. Other color frames may be used instead. Invert this 

(by simply clicking the X key) so the foreground is white. 

i Notice that each of these operations leaves its record in List View of 

the Actions Panel.

The act of scaling your original image to 4500 pixels in its 
longest dimension will preserve its details within a large 
surface. Even an 18 megapixel JPEG scaled to this size will 
retain better than 99% of fine detail, since all digital images 
are compromised by their Bayer patterned, single chip 
recording format. At the end, you may scale the image back 
to its original size and virtually no visible detail will be lost.
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• Use the Canvas Size function to produce a square image 6000 x 6000 

pixels. You should use the default Expand From Center option with Relative 
unchecked and the Foreground color being selected as the Canvas Extension Color. 
White also works well with this shot, but it’s a bad choice for scenes with 

bright skies.

i Remember, when you write an Action like this for your own zoom lens, the 

Canvas color will have to contrast with the content colors of your image. If the 

image has large areas of black or white in it, using the available Canvas exten-

sion colors might not be best for your test image. 

i For 4:3 image format, a slightly larger Canvas, say, 6300 x 6300 

pixels, may give better results.

• Select Filter > Distort > Pinch > Amount: 7%. This is appropriate for Barrel 

distorted images. Pinch tends to suck the edges of the image into the center, 

and positive values squeeze inward. If you were correcting a tele zoom 

image that showed Pincushion distortion, you would probably try Pinch with 

negative values.

i Why this number? Research/experience. Several other Working 

Square sizes and Pinch amounts were tried. Trial and error led to these 

numbers. Be prepared to make several attempts before 

achieving success. After a while, you will get good at 

estimating which numbers to try first.

Surrounding your image in a square 
box of contrasting color assures you 
of having operations like Spherize and 
Pinch perform their corrections equally 
in the horizontal and vertical directions. 
The bottom square shows Pinch 7% 
applied to our test image. A white 
circle shows the outer limit of Pinch’s 
influence. A strong background color 
lets you crop the image unambiguously.
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NOW WE CHECK OUR WORK
g  Stop the recording. Click the gray square next 

to the recording dot. That prevents recording any 

steps you may make to verify how well-corrected 

the image is.

i Since you no longer need to maintain the 

selected foreground/background colors, you can 

turn the foreground bright yellow, if it isn’t already, 

then select the line tool, turn off any arrow effects 

and make the line one or two pixels in size.

g  Draw lines over straight subject matter anchor-

ing the line at extremes of distance on the face 

of the shot. Try numerous horizontal and vertical 

references, as we did with the test image.

i Often you can better gauge how close to perfect 

you are by making the reference line parallel to the 

straight line feature in your image, offset by just a few pixels at the 

beginning and end points of the line. Any small drift from that amount 

of offset will be readily seen in the middle portion of the line.

g  Go back in the History Panel to the entry before the first Line Tool 

entry. Since Pinch was the last operation before we stopped to check 

our work, click on that item. The lines will disappear.

When building an Action, you will need to verify your work. 
Suspend recording to check how straight the lines are now. 
Draw lines over the image’s straight line features but apply 
them to a layer above your image, so you can turn them 
off and on for critical reviewing. Once you see that re-
straightening is good, use the History Panel to return to the 
state of your last recorded operation and record the Action 
from its stopping point to memorize the finishing steps. 
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• Click the Record Dot again, re-activating recording. New instructions 

will be recorded, adding below the last highlighted operation. Select the 

Crop tool from the Photoshop toolbar, and shrink the image window so 

you can see the whole rectangular image. Crop the image to its largest 

extents, without including any of the frame area surrounding the image. 

Approximate the crop at this scale. 

i You may need to zoom into the image 200% and manually drag the 

center of the edges of the crop rectangle to find the maximum size top, 

bottom, left and right. Hit return to accept the crop.

• Since the image now is 4448 x 2917 pixels (±2), it is larger or smaller 

than the camera’s original frame. Use the Image > Image Size > Width: (the original 
horizontal size in pixels) with Constrain Proportions and Resample Image: Bicubic Sharper 
(best for reduction) both checked. 

i The test image here is reduced back to its original 3872 pixel dimen-

sion. Shrinking the barrel distortion bulge reduces the size of central 

detail, and a bit of each corner is trimmed away.

i When the opposite effect, pincushion distortion, is repaired, the corners 

are kept while some of each edge is cropped away, because central detail 

slightly bulges outward. Pincushion distortion is most often found at the 

telephoto end of zoom lens images.

g Turn off the Record mode. Pat yourself on the back for having gotten 

through all these tedious, exacting steps and picky, picky requirements.

i The Actions Panel’s List View shows the completed steps, but doesn’t 

immediately show you the values each operation is working with. The 

twirl-arrow next to complex items will open the instruction’s details so you 

can check the numbers and options associated with that step.

Crop out the surrounding box. When barrel distortion was 
reduced, the sides of the frame will bow inward. Crop to the 
narrowest points. Here, all is well except the right side, which 
hasn’t been adjusted yet. 

Question number one: Was detail lost during correction? 
Above is a center crop before and after barrel correction. Ask 
your eyes; Which is Before? Which is After? Verdict: nothing 
of substance was lost.
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COMPLEX ACTION RECORDING
The previous Action was tedious to write. But relatively few 

Actions in the iNovaFX collection are that small and/or that 

simple. Here is an exercise that shows how a more complex 

Action comes together.

i If you elect to just read this, instead of actually attempting 

to build it from scratch in Photoshop, we will understand. The 

completed 55-step Action can be reviewed in the folder, iCross 

Star Set, where it is called iCross Star 1.

Notice that in forming a strategy for recording an Action, 

knowing what the interaction of two or more variables 

imply for each other is a frequent problem to solve. But 

if the problem that an Action resolves is something you 

will encounter in the future, or you will wish to imple-

ment it again and again, it may be worth the effort to not 

only solve the immediate issue but to memorialize it for 

images yet unborn.

Next, the creation of a cross star filter effect that triggers 

off of brilliant highlights only. The iCrosstar-series of iNovaFX 

Actions use this technique, too. 

As you build this Action from scratch, you will learn valuable 

skills for working with multiple layers in Photoshop through 

keyboard shortcuts.

A cross star filter for your 72mm filter thread 
will cost you somewhere in the neighborhood 
of $70US, if it is coated to avoid flare and 
reflections. The cross star filter you are about to 
build is around $70 less expensive and can be 
applied to existing pictures any time you want.
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STAR CROSSED ACTION
Quite often, night shots include shadow and middle tones peppered with the 

bleached out images of lighting fixtures. Most of the pixels in the image are 

under 70% brightness except for those lights (stars, fireworks, neon signs, etc), 

which are driving one or more channels into 100% full brightness. 

We want those dazzling highlights to trigger a cross star filter effect, and we 

want to keep the effect separate from the original 

image, so we can control it to taste, later.

Before recording an Action that will do all this, 

open the image file called CrosstarPier .jpg in the 

Example Images folder, inside the ActionsExtras 

folder on the CD or USB drive.

It has already been cropped to a wider aspect 

and shows full white lights against a rather bright 

post-sunset sky.

• As before, Create a new Action Folder 

(name: Cross Stars or similar) and new Action 

(name: Cross Star 1 perhaps) using the icons in 

the lower border of the Actions Panel. 

i In creating a new Action, recording automati-

cally begins when the new Action is named.

• In the Layers Panel, duplicate the image to a second layer. 

i The easy way to do this is to grab the icon of the image called Background 

and drag it to the Layer icon in the bottom border. That’s the one next to the 

garbage can, an iconic page with a corner folded up.

Brilliant highlights such as these from lighting fixtures and 
signage, can be isolated into star-casting hot spots.
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i We want this layer to only show the brightest highlights 

and no mid-tone or shadow detail at all. 

• Open the Curves control. Drag the shadow anchor 

sideways across to the highlight side of the graph. It won’t 

go all the way, but it will get close. All shadow and mid 

tone detail will turn solid black, but the highest highlights 

will remain bright.

i The edges around highlight areas will often look hard-

edged. Even though the Curve is a steep line into the high-

light corner, it can be shaped somewhat to more smoothly 

accommodate bright highlights and the transition into high 

tonality areas.

• Once the highlights have been isolated, blur them 

with a Filter > Blur > Gaussian Blur > Radius: 1.5 pixels. 
i This takes the hard edge off the highlight sources.

• Double click on the name of this layer in the Layer 

Panel highlighting it. Change the layer name to X.

• Change the Blending Mode of this layer to Screen.

i Screen blending mode produces the effect of a double 

exposure. We want to lay the cross star effect over the 

original image as if it were a double exposure.

The original image will be preserved beneath a duplicate layer 
that will become the star-casting source. This is how it looks 
before being used to generate stars.
To isolate these highlights, a radical curve was used to crush 
most of the tonalities of the layer to full black (left)
As soon as the star casting layer is isolated, set its Blending 
Mode to Screen (below). 
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• Duplicate the X layer. Drag it into the New Layer icon.

i It’s now called X copy.

• Rename this newest layer, Y.

i Visually, not much has changed. This is normal. What you can’t 

readily see is that full bright highlights are even brighter than before 

with the X and Y layers on top.

• Duplicate the Y layer. Drag it into the New Layer icon.

• Duplicate it again.

• Duplicate it a third time.

• Duplicate it a fourth time. 

i This last one will be labeled Y copy 4.

• Perform Filter > Blur > Motion Blur > Angle 45° / Distance: 800 pixels.
i A streak will flow, symmetrically, from every highlight at a 45° 

angle. It isn’t very bright, so it may not show well on the picture. Yet.

i Here’s where using the keyboard shortcut helps a lot. We want to 

select the layer just under the currently highlighted Y copy 4. To do 

that, we use Alt + [ (Windows) or Option + [ (Mac). 

• Select the next layer down with a keyboard stroke. 

• Perform Filter > Blur > Motion Blur > Angle 45° / Distance: 500 pixels. Now 

the streak is the combination of an 800 pixel smear plus a 500 pixel 

smear. Screen blending mode adds them together, so now they look 

like the beginnings of the optical smearing effect that characterizes 

cross star rays.

i A shortcut to repeat the filter is Alt + Control + F (Windows) or 

Option + Command + F (Macintosh).

i Notice that this is just over 50% of the distance applied in the top 

layer. We will continue that trend.

No matter how many layers are above 
the main image, if their Blending Mode 
is Screen, they’ll add together like 
multiple exposures.
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• Select the next layer down with a keyboard stroke. 

• Perform Filter > Blur > Motion Blur > Angle 45° / Distance: 300 pixels.

• Select the next layer down with a keyboard stroke. 

• Perform Filter > Blur > Motion Blur > Angle 45° / Distance: 200 pixels.

• Select the next layer down with a keyboard stroke. 

• Perform Filter > Blur > Motion Blur > Angle 45° / Distance: 100 pixels.
i By now, you are seeing a pretty good looking streak from 

every bright light in the image. Neon signs and perhaps some 

sky glow redness are participating in the effect.

• Select the next layer up with a keyboard stroke. 

i That’s Alt (Windows) or Option + ] (Mac).

• Select the next layer up with a key stroke, again.

• Select the next layer up with a key stroke, a third time.

• Select the next layer up with a key stroke, a fourth 

time.

i This brings us back up to the top layer, Y copy 4.

• Merge the current layer down onto the layer below it with 

a keystroke. 

i The Merge keystroke to join the current single layer 

with the next one under it is Control + E (Windows) or 

Command + E (Mac). 

• Merge the current layer down.

• Merge the current layer down, again.

• Merge the current layer down, a third time.

i The sole remaining layer of this series is labeled Y.

• Select the next layer down with a keystroke.

i Now we are working on the X component of the cross star 

effect. It will be 90° from the first ray.

• Duplicate the X layer.

• Duplicate it again.

• Duplicate it a third time.

• Duplicate it a fourth time.

• Perform Filter > Blur > Motion Blur > Angle -45° / Distance: 800 pixels.
i The first ray was at +45° and this one is at -45°, so the two 

rays will be at 90° from each other.

i I know what you are thinking. Yes, you could have made 

the Y group at some other angle, then made this X group at an 

angle 90° away from Y. That would have rotated the cross star 

effect. Or, you could have made a cross star effect that was 

unique with rays at non-90° angles.

The first of two star streaks is finished at this stage. You will see this 
during recording, but may not during implementation at full speed. If 
you were to insert a Stop command at this point, you could see this 
intermediate step. Most computers are moving too fast past this point 
to stop and see the rays.
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• Select the next layer down with a keyboard stroke. 

• Perform Filter > Blur > Motion Blur > Angle -45° / Distance: 500 pixels.

• Select the next layer down with a keyboard stroke. 

• Perform Filter > Blur > Motion Blur > Angle -45° / Distance: 300 pixels.

• Select the next layer down with a keyboard stroke. 

• Perform Filter > Blur > Motion Blur > Angle -45° / Distance: 200 pixels.

• Select the next layer down with a keyboard stroke. 

• Perform Filter > Blur > Motion Blur > Angle -45° / Distance: 100 pixels.

• Select the next layer up with a key stroke.

• Select the next layer up with a key stroke, again.

• Select the next layer up with a key stroke, a third time.

• Select the next layer up with a key stroke, a fourth time. Each of 

these minor commands are logged inside the Action and will playback 

instantly when you run the Action.

i This brings us back up to the top layer, X copy 4.

• Merge the current layer down.

• Merge the current layer down, again.

• Merge the current layer down, a third time.

• Merge the current layer down, a fourth time.

i Are you getting tired of the repetitious instructions, yet? You should 

be. Although all these &%#$@!! steps are needed, they are mind-

numbing and far from satisfying to your creative neurons. 

Here the Y layer is collapsed and the X copy 4 
layer has received its 800 pixel motion blur.
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i You now see only two layers over the original image. One is X, the 

other, Y. These next steps blend each ray on its directional axis, avoiding 

any hint of banding. They add a small refinement, but one that makes this 

sort of cross star effect look convincingly optical.

• Perform Filter > Blur > Motion Blur > Angle -45° / Distance: 40 pixels.

• Select Top Layer (Alt (Win) or Option (Mac) + “ .” period).

• Perform Filter > Blur > Motion Blur > Angle +45° / Distance: 40 pixels.

• Move over to the History Panel and open its menu. Select Make 

New Snapshot from the list of options and give it a name like Cross Star 

Components.

i This step is to preserve each cross star ray separately in an easy-to-

retrieve Snapshot. You might wish treat the rays separately, later. You 

could save the snapshot image later as a .psd file with all the upper ray 

layers intact, but don’t do it yet, you’re still recording.

• Select the next layer up with a keyboard stroke.

• Select the next layer up with a keyboard stroke again.

• Merge the current layer down.

i This consolidates the two cross star rays into one layer.

• Use the History Panel menu to make a New Snapshot from the list of 

options and give it a name like Cross Star Merged. 

g  Click the gray square next to the Record Dot to end the Action 

recording session. But you are not quite done.

g  Scroll up the list of Action steps in the Actions Panel. The second 

item is Curves.

With both X and Y rays collapsed, a snapshot 
of this state will permit several optional 
treatments that optical cross star filters can’t 
achieve. You have control over each ray layer 
separately.
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g  That’s the step which limited the brightness range to only the 

very brightest highlights, in this case, the light fixtures. Since each 

image is unique, this setting will be custom to each image’s exposure 

and adjustment requirements. To the left of the instruction is an empty 

box. Click on this box and an icon will appear indicating that as this 

step is executed, Photoshop will pause to allow a manual adjustment. 

i If no special handling is entered, the curve you drew when first 

defining this step will become the default.

Now you are done .

i The parts count for this Action has passed fifty steps, many of them 

redundant, but every one of them essential to the completion of the 

desired result. After all that brain-wrecking work, you are allowed a 

long, rasping scream.

Saving Actions is relatively easy. If you quit Photoshop right now, the 

Cross Star Action you just made will be saved along with the program, 

and they’ll open with it next time, just exactly how you left them. 

g  To save an Action folder and all the Actions within it, look for 

Save Actions in the Actions Panel menu. Unless an Actions folder is 

currently highlighted, Save Actions will be grayed out. Highlight your 

Actions folder, THEN come back to the Actions Panel menu. Now the 

Save Actions will save that folder to any storage place your computer 

can use.

i Major Tip: The downward pointing arrowheads next to the Action’s 

name and the folder’s name should both be pointed in, not down, 

before saving the Action. Whatever state these are in at the time the 

Action is saved will be their state when you open or load the Action 

again.

Click the box left of Curves to cause it to become 
interactive when the Action executes. Click it again 
to deactivate its interactivity. Notice how other icons 
change to indicate the existence of an interactive 
step inside their contents.
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GETTING TRACTION FROM YOUR ACTION
Once you make the Action and save it, you can use it over and over 

on other images. It was tedious making the first one, but every time 

you employ it again, the ease of implementation is its own reward.

Since this Action left two different Snapshots in the History Panel, 

you may click on either one of them and continue to tweak the 

effect.

Use Opacity to dial back a ray-layer’s emphasis. Now it is a subtle, 

tasty effect.

Select the second Snapshot, the one with both cross star rays col-

lapsed into a single layer, and manually duplicate just the cross star 

layer. Suddenly the star effect is twice as bright.

You could also add an Adjustment Layer to the cross star effect 

layer. Curves or Hue & Saturation are good candidates.

Duplicate one ray in the two-ray Snapshot and you will have empha-

sized one cross star axis over the other, something rarely attempted 

with a glass cross star filter.

i Digital cross star effects are far more controllable than glass filter 

effects. 

i Smaller points of highlight cast thinner, sharper rays.

i More on the iCrosstar Actions on page 160.

This is the final result of running the Cross Star 1 Action on the CrosstarPier photo. 
If you created a different Curve in the second instruction, your results will be 
unique. Once formed, the cross star rays are saved both individually and grouped. 
The middle image shows how doubling one ray and lowering Opacity on the other 
creates a slashing cross star effect. The bottom version shows how tinting the ray 
layer can produce a subtle effect impossible with optical cross star filters.
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HISTORY LESSON
Once an Action like this one (and most others in the collection) has 

been run, it has preserved its final state(s) in the History Panel as a 

snapshot with a title referencing the final outcome as belonging to this 

particular Action or unique condition. 

Not all snapshots will be multi-layer, and not all of them will arrive 

as several different snapshots, depending on their complexities or 

opportunities for further custom manipulation.

Layered snapshots often preserve the bottom layer in its original 

unaltered state. If this layer isn’t visible in the final composite image, 

it’s just there as a ready reference. Turning off upper layers will reveal 

it, but with many upper layers, this can be a chore.

i Here’s an easy way to group all upper layers into a single clump of 

elements that can be turned on and off to compare the final state to 

the original state:

1. CS2 to CS5: Highlight the layer above the original and shift click 

the top layer. Use Control + G (Windows) or Command + G (Mac) to 

group all the layers together into a Layer Set which can be hidden or 

seen—switched off or on—with the eye icon to its left. 

2. PS 7 and CS: Link the layers together and use the New Set from Linked 
command in the Actions Panel menu to produce the Set.
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PANORAMIC SANITY
In PS CS5, the panoramic stitching ability resides in a Script, 

not a Filter or Image adjustment process or Action. You find 

it under File > Automate > Photomerge. Later in this eBook 

you will find our iPMCylinderEdge# Actions that clean up 

steppy edges that normally result from Cylindrical and Spheri-

cal Photomerge runs. # = the number of shots in the pano.

Photoshop’s Photomerge script can be a bit confusing. It 

offers a quick way to stitch images together. And it does a 

very good job. But it leaves you with less than a final image. 

So we made a new PS CS5 Action that fills in the blanks 

while guiding you through the maze.

Open a bunch of previously saved images shot overlapped 

for panoramic stitching. We use a 50% overlap, but you can 

use as little as 25% overlap from shot to shot. 

From the iPSPhotomerge folder, run iPanoramic. It doesn’t 

care how many shots you’re working with, but it will stop on 

the Photomerge Control Panel awaiting your input.

Choose Layout format. Unless your originals were shot with a 

nearly normal lens, you probably want to use Cylindrical layout. 

Add Open Images and check the Geometric Distortion Correc-

tion box. Blow past (return) any alert boxes and click OK.

Several things will happen. 

It will build the stitched panoramic image. 

It will flatten the result and place it in a fresh new 

image entitled Panoramic Holder and save a Snapshot 

of the multi-layer initial stitched image with a name like 

Untitled Panoramic 1. 

Use that last one when running the edge-cleaning Actions 

in the folder, iPanoCylinderEdges.

Five panel panoramic image, hand-held. Stitched together with 
iPanoramic, then edge-smoothed with iPMCylinderEdge5. The 
layout format here is Cylindrical.
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You knew it was pixels when you shot it, but now it’s time to have a 
little fun. Convert your digital image into a sheet, frame or chip of film 
and print the whole image for instant chemical-cred.

F ilm is so then while digital is so now. But when your 

image needs a touch of then, digital can supply it now. 

This group of iNovaFX Photoshop Actions are com-

plex—far too many operations to list out on a page and expect a user 

to follow—but they reward the photographer by framing the image 

with the appearance of realistic traditional film borders.

We have all seen photographs printed along with the border effects of 

various film formats. It’s usually a message from the photographer to 

his buddies. The photographer is saying, “Look how perfectly I framed 

this shot. Right in the camera, I got it just right, and obviously nothing 

has been tweaked after the shutter click. See that film border? Notice 

how the composition is amazingly well coordinated to the limits of the 

available film area? Oo, I’m hot!”

Now you can be that hot. Or even hotter since you have managed to 

spoof the eye of the observer by pushing your pixels into a film frame. 

Oo, la, la!

Border Crossings
Where film and digital converge

Chapter 2
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THAT’S ALL FAUX
Three iNovaFX film border series are available to you, one series for roll film 

borders, one for sheet film—similar to 4x5 view camera frames, and one for 35mm 

film chips and strips.

They all include potential marginal titles and notations identifying them as digital 

images by default, but you will be able to customize this text with any memorable 

or pithy commentary you wish.

ROLL FILM BORDERS
In the heyday of medium format film, one of the standards dating to 1901 was 

roll film with opaque backing paper called simply “120.” The paper backing was 

printed with marks that could be viewed through a window on the back of the 

camera to line up fresh film for the next shot.

Most film was sold in 12-exposure rolls, although 24 exposure rolls eventually 

appeared for light-tight film holders. Cameras like Hasselblad, Bronica and Rollei-

flex shoot the 6x6 format of square frames (2¼ by 2¼ inches of film) of which the 

image actually covers about 56 x 56mm, and other cameras shot different format 

images on the same stock. 

These formats had names like 6x7, 6x9 or 2¼ x 3¼.

i A similar format, 620, had identical film and paper backing materials on a 

slightly thinner spool.

i The margin outside the image had pre-exposed factory markings embedded 

in it. Most viewers ignore it, but we let you type in anything for the more 

observant beholder. Like the real deal, our text color and brightness is 

purposely kept low to avoid distraction.
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These roll film Actions create square, rectangular and any aspect 

of faux roll film frame you wish similar in appearance to 120 and 

620 film frames.  

Roll film travels in one direction through the camera, unlike 

35mm film, which rewinds into its canister. Sometimes the roll 

doesn’t wind tightly on the take-up spindle. A mushy winding 

could leak light to the edges of the film if you weren’t careful.

One Action has the option of adding and controlling edge fog. You 

get to add a fake flaw to the edges of the image to simulate poor roll-

winding techniques, thus adding bogus authenticity to the picture.

Roll film Actions are found in a folder called iFilmBorders and include:

iFilmBorder2 .25x3 .25, which uses a horizontal 3:2 aspect 

original image, surrounds the shot with a black roll film border 

embellished with factory embedded graphics and text. 

i The transition at the edge of the surrounding frame is slightly blurred, a common artifact in 

roll film cameras. Image area is scaled to 3072 pixels wide by approximately 2048 pixels tall 

before the border is generated. 4:3 cameras produce a narrower result.

iFilmBorder2 .25x3 .25-Text . CS5 adds text to the lower and upper borders one line at a 

time in different colors, using Arial Bold type face—chosen because it is common to both 

Windows and Macintosh platforms. Most real film border notations are written in a sans 

serif font using all capital letters. The image here shows the text added.

The first line is written under the image in a tan color and may say anything for about 120 

characters. Its default is DSLR Digital Image >>47 but the Action stops, handing you the text high-

lighted and ready for anything you type. You can change font and size, too. The second line is 

added near the middle of the top border in dark purple type and defaults to iNovaChrome but you 

can put anything there up to about 60 characters.

Three Point Landing. Complete with 
imaginative margin text.
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Caveats:

i Correct results will be obtained with 3:2 horizontal images. If your 

image is vertical, rotate it before running the Action. A utility Aspect 

Action, iAspectCrop, will help to prepare the shot.

i Type behavior is different between Photoshop 7, CS, CS2 and CS5. 

You may need to change its size with the Font Size box in the Character 

Panel before accepting a title or border text.

i Type is often at the mercy of the camera’s ppi measurement, so the 

title Action can’t always predict it.

FOG BOUND
Every photographer who ever used a roll film camera eventually experienced 

the loose-roll effect. Somehow the multi-layer film and paper roll did not pack 

tightly on the receiving spindle, and light leaked in around the edges of the 

paper carrier as it was being removed, fogging the edge of the film.

And that is just what is being simulated here.

Use the iRollFilm+Border Action to create the border. Then apply edge 

type with the iRollFilm+TitlesCS5 Action, or apply text manually.

i Edge titles should use a dark color with Arial or Arial Bold type, and 

degrade the image of the type to make it look more plausible.

To create the edge fog effect, make a snapshot of the image before 

running the iRollFilm+EdgeFog Action. It creates a separate layer of 

edge fog effect that is quite easy to tune with a Curves Adjustment 

Layer and Opacity controls.

i The Edge Fog effect creates a new layer above the image and title 

layers, preserved in a new labeled Snapshot, so you can apply it and 

still tune the balance of fog and text.

Which looks more “authentic?” The fog effect on the bottom is similar to the 
fogging of film that wasn’t spooled correctly. It happens. You have control 
over its density, color and tonality, since the fog effect is on an upper layer 
of the final result.
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ROLL FILM DU JOUR
Paper-backed roll film came in numerous formats. Aspect ratios in 

various cameras were square, rectangular and even wide panoramic, so 

the iFilmBorderUniversal Action was created to simulate images of any 

aspect ratio.

Crop your shot to any rectangular or square shape, then run iFilmBor-

derUniversal. 

Caveats:

i Turn vertical images to horizontal before adding the border.

i Vertical size on a correctly oriented image scales to 2200 pixels and 

the width of the image is scaled proportionally.

i If type shows up too small or too large in the border, you can scale 

it to an appropriate size with the Font Size detail box in the Character 

Panel. If that’s not open, seek Window > Character.
i Type size comes at the mercy of the camera’s ppi (pixels per inch) 

measurement, so the title Action can’t always predict it. You may need 

to intervene to get the type correctly sized. PPI is set in the Image > Image 
Size > Resolution box.
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NO HASSIE
Square roll film images are usually associated with 6 x 6 cm 

cameras such as Hasselblad, Rollei and Bronica cameras. 

A separate Action in the iFilmBorders folder, entitled iFilm-

Border6x6 creates a square film frame with factory markings 

on the vertical sides of the image area. 

i Square format roll film cameras typically scroll the film 

vertically, so marking the sides makes the most sense.

Caveats:

This Action only works correctly with square-cropped 

images.

i Images are scaled to 3200 x 3200 if they are originally of 

a different size. 

i Final frame size is 3400 x 3400 pixels, equivalent to 

about 10MP over the image area.

i Use the iSquareCrop utility Action to slice a square crop 

out of your rectangular frame. 

i It scales a square, cropped image to 3200 x 3200 pixels. 

i It pauses to let you find the crop, but remember to keep 

your finger on the Shift Key as you adjust the cropping border. 

That keeps the crop perfectly square.

i iSquareCrop adds Photoshop’s Smart Sharpen filter, which may not 

be available with older versions of Photoshop.

i For best results, complete all image retouching before running the 

iFilmBorder6x6 Action.

i Type will need to be added manually. Remember to run it in the 

side margins.

When you shoot for eventual iFilmBorder6x6 treatments, learn to use any 
available viewfinder marks (grid, focus points) to help you compose the 
required square image.
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SHEET FILM BORDER
Cameras that shoot 4x5 sheet film are used for images 

that will be reproduced extremely large. View cameras in 

this format allow swings, tilts and perspective control. 

Slow and deliberate to set up and shoot with, they are 

often used with architectural subjects in which vertical lines 

are maintained in perfect vertical alignment with the edge 

of the frame.

Today, that sort of perspective control can be achieved 

digitally with manipulations in Photoshop, so to complete 

the idea, here are horizontal and vertical versions of 

iBorder4x5.

Caveats:

i Correct perspective, and level your images before 

running iBorder4x5 Actions, so viewers will see plausible 

view-camera treatments.

i Crop your horizontal or vertical image to 3:4 aspect before running 

iBorder4x5 Actions.

i Two utility Actions facilitate cropping your shots, iBorderCrop3x4H 

and iBorderCrop4x3V.

i Type for borders is subject to many variables that can’t be fully 

anticipated. If the border text isn’t behaving the way it should, the 

work-around is to hit the backspace key, erasing the default text, then 

add border text manually.

Suddenly you will be able to 
show view-camera results of 
nearly any focal length from 
fisheye to cosmic telephoto. 
Moreover, the shots can be 
taken from places tripod-
bound view-cameras seldom 
go. The bottom image was 
shot with a Nikkor 10.5mm 
fisheye from a ledge that 
would have worried a 
mountain goat.
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i iBorder4x5 (Horiz and Vert) don’t make a true 4 x 5 sheet 

film aspect. You see a 3:4 aspect image which is a compromise 

between the 3:2 aspect of most DSLR camera frames and the 

more boxy 4:5 aspect created with a view camera.

i Most DSLR cameras produce a frame with the 35mm 

aspect of 3:2. The iBorder4x5 frame is reminiscent of 4x5 

sheet film but produces an image that is a slightly more 

pleasant 3:4 aspect and not the true (and squarish) 4:5 

aspect of its namesake.

i When the image is as close to view-camera correct as you 

can manage (perspective corrected, level), it helps to “sell” 

the sheet film idea.

The 4x5 Actions are 3:4 aspect, which is less persuasively tall or 
wide than the images from most DSLRs. The graphic at far right 
shows how the common 3:2 aspect compares with the 3:4 final 
image in the center. Above is the shorter, more boxy 4:5 aspect 
that view cameras actually capture. All three image areas are the 
same identical maximum width.
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35MM
35mm film has been with us since the late 1800s. Practically everybody recognizes 

35mm frame images. Slides have eight holes and movies four, per frame. They 

tell us immediately that this image came from a authentic film camera.

But look closer at this image. Something’s strange. This filmstrip isn’t chemical. The 

entire frame—sprocket holes and markings in the borders—is an elaborate fake artistic 

rendering. Yeah, that’s the ticket. One you can make, using your own eight images with 

an Action called iMovieStrip8 in the iFilmBorders35 folder. You load eight horizontal 

3:2 aspect shots (any size) in top to bottom order, then run the Action. Separate 

iFilmStripWarp actions can then curve the resulting strip of images for graphic effect. 

(iFilmStripWarpV-Manual working at left.) And there are others.

Single film chips are generated by the iBorder35mm and iBorder35mm+ Actions. These 

will create endless faux, sham, phoney, counterfeit, hoax, forged, fraudulent, dummy, 

ersatz 35mm bordered still images from your 3:2 aspect DSLR. No matter what the 

original’s pixel count, the final result will always be the same size, 4207 x 3896 pixels 

(16.4 MP), frame included. The format is identical to slide film transparencies.

i The difference between the two Actions is minor. One, as on the next page, cuts the 

frame between sprocket holes (technically this is the “right” way to embed images in 

35mm film), and the + version cuts frames right through a sprocket hole (which has a 

strong graphic appeal all its own).

Caveats: 

The single frame slide-format Actions only work on horizontal images. Any muti-layer shot 

will automatically flatten before it gets imbedded in the film frame border.

i In the iFilmBorders35 folder you will find two utility Actions that rotate image’s 90° clock-

wise and 90° counter clockwise.

i Other utilities let you crop 4:3 verticals, 3:4 horizontals, 2:3 horizontals and 3:2 verticals.



  68 | CHAPTER 2       ACTIONS CS5

i If your image is wider than 2:3 (H:W) aspect, it will arrive letter-boxed 

on the film frame with black borders (areas of unexposed film) above and 

below. You may use the utility, iLetterBox2:3 to prepare images beforehand 

in this form.

i If your image is narrower than 2:3 aspect —something you get from 

native Four Thirds format images—you must extend its size horizontally 

with black bookends. Make this container frame 150% as wide as your 

image is tall to force a 3:2 aspect final source. In the iFilmBorders35 is a 

utility Action, iPortraitBox2:3 that will scale this for you, converting your 

photo into a 1920 x 2880 pixel horizontal image, temporarily.

i Titles can be added with the iFilmBorder35TitlesCS5 utility Action. It 

stops to let you recompose the text. It works on either version.

i To make a film strip, run iFilmStrip8. That will produce a four slide or 

eight movie frame strip for manually inserting images. 

Or, you can auto-assemble eight horizontal shots into a chunk of 

movie film. Open the horizontal shots first, in top to bottom order. Run 

iMovieStrip8, and all the images are placed on the vertical strip of film in 

sequence as on the previous page. Multiple Snapshots in the History 

Panel give control over individual images.

Got eight vertical shots? Open them in left to right order, run iVFrames8. 

That makes portrait-framed movie-like strips like the one on the cover. 

i For four horizontal slides, open the shots in 

order first, then run iFilmStrip8, to generate the 

frame strip, then run iHSlides4, and the result 

will resemble the shot here.
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Borders Beyond Film
STAMP OUT IMAGES
In the not too distant past, postage stamps used circular holes to allow 

stamps on a sheet to be ripped apart neatly. The icon of the multi-hole 

stamp is still with us, and the iStampBorders Actions give us several alterna-

tive aspect ratio and perforation-count options in graphic stamp borders for 

use as creative, non postal expressions.

i Variations exist for 3:4 aspect and 3:2 aspect images with Small, Medium 

and Large numbers of perforations forming the borders.

Caveats:

i Images are forced to 2048 pixels in the 

image’s longest dimension before becoming faux 

stamps.

i Fine line image border options are built into 

the Actions.

i Background color options are made on the 

fly. The ones here were all made on a white 

background for this page.

i Type treatments are up to you after the Action 

has finished. Creativity counts. Complete this 

idea: “Stamp of...”

i Utility Actions for 3:4 cropping and 

90° rotations are provided within the 

iStampBorders folder.

i Please note: attempted postal fraud may earn 

you 18 to 24 months of quiet time. 
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PAGES O’ PLENTY
Printing multiple images on a single sheet of paper is not only 

handy, it’s a way of telling brief stories. Sure, that camera is 

capable of poster-size results, but frequently a gaggle of images is 

more compelling than sheer size.

Two folders are here to help, the iFourPrint and iMulti16 

series of Actions. You know from the names how many images 

are involved.

FOUR IN HAND
iFourPrint does what its name implies; it scoops up any four 

horizontal or vertical prints and drops them onto a single 

sheet of letter paper. Moreover, it lays them down in the 

reading order you opened them, left to right, top to bottom. 

Two variations allow for all-vertical and all-horizontal layouts. 

A narrow mullion of white separates the images, should you 

wish to snip them apart. Separate versions exist for 3:2 and 

4:3 aspect originals. Four Actions in all.

Load your four images in reading order. Adobe Bridge can 

help with that, or you can make a new folder on your desktop 

and put copies of the shots in there, then renumber them 

001, 002, 003, 004 and have Photoshop load them as a 

group. Loading them one at a time into Photoshop assures 

that sequential order.

Resolution of the final page is greater than printers gener-

ally need. Letter pages are stunning. You can even print the file 

to Super Tabloid A3 (13 x 19-inch [329 x 483 mm] sheets), and 

the results will be compelling.

Be aware of the compositional direction of subject matter as you 
lay out the images. Composition is altered by the assembly. You 
may wish to try the Action several times before you are happy 
with all factors. The outline here shows US Letter page bounds 
when used with tall 3:2 aspect originals. 4:3 aspect images are 
accommodated by H and V Actions named for them.
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Caveats: 

i Optimum results come from 3:2 (horizontal) or 2:3 (vertical) 

images, each feeding the iFourHorizontals 3:2 or iFourVerticals 2:3 

Actions.

i Mixing horizontal and vertical images is not as graceful as keeping 

all the images in the same orientation. Steps are taken to correct 

letterboxed or pillar-boxed images, but vertical images in a horizontal 

layout or horizontal images in a vertical layout will be compromised.

i The easy way to assure that odd-aspect images fit into their 

assigned quadrants is to expand the canvas that contains them so 

white space around your image completes the 3:2 aspect the Action 

expects.

i For horizontal images narrower than 3:2 aspect, white space will 

be added to top and bottom or to image sides to make them fit in 

their quadrant.

i US Letter (8.5 x 11 inches) and A4 Letter pages (210 x 296 mm) 

are accommodated. Similarly, tabloid and Super A3 (A.K.A. Super B) 

sheets will work with the correct output printing settings.

i The final files will be 3086 by 2052 pixels. At 294 ppi, these print 

on letter paper for 10.5 inches of image. At 171.5 ppi, they print on 

large Super A3 sheets for 18 inches of image.

When working with mixed aspect images, the Action respects only the long dimension of each component image 
relative to its placement. You may need to expand each shot’s Canvas size to force it into 3:2 aspect. The bottom 
page shows what this group looked like without Canvas expansions on the square and stamp images. Note that the 
wide format cross star pier image automatically arrived with letterbox space above and below the picture. 
So for a page of horizontal images, the rules are 

3:2 horizontal = No Problem. 
Wider than 3:2 horizontal = No Problem. 
Taller than 3:2 horizontal = Problem. Horizontal extensions needed.
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SWEET SIXTEEN
The iMulti16 folder holds several variations of the 

16-image assembly Actions. 

Some layout all 16, 2:3 aspect images, in a block 

with sides touching. Look for iMulti16H and iMulti16V 

to achieve these close-packed groupings. If you wish 

to have narrow mullions between images, use the 

“+Mullions” variations of each.

Two more variations exist: iMulti16VTwist and iMulti-

16VTwistPow. These are for vertical images only. The 

-Pow Action adds the bevel, lighting and drop shadow 

effects. Rock on.

Final iMultiVTwist files are 2116 x 3072 pixels, 

producing letter page prints at 292 ppi and A3 prints 

at 170 ppi (13 x 19 inches or 329 x 483mm). Both are 

comfortably photographic in detail.

The H versions look exceptionally comic book-like. 

Think storyboard. You may mix in only 3:2 horizontal 

aspect photos, graphics, titles and blank white frames 

to layout your page.

The outer line here shows the extent of the final file. It is narrow 
enough to fit on European A4 Letter paper or US Letter paper. You 
will need to size it in Photoshop using the Image Size function. Don’t 
“Resample” the picture. Uncheck that box and put in the dimension 
you wish to see on the page (10.5 inches for most printers). The ppi 
(pixels per inch) will change as you adjust this number.
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Caveats:

i Like the iFourPrint series on the previous pages, 

the images must be opened in 1, 2... 16 order to read 

like a comic strip.

i If you have less than 16 images for your page, 

create blank white frames after loading the others 

until 16 open files are on your screen before running 

the Action. Any white frame will substitute for an 

image.

i Use 2:3 (wide:tall) vertical images only for the Twist 

versions. Or float your non 2:3 image in a 2:3, vertical 

Canvas before starting.

i Alternatively, crop 2:3 aspect images out of your 

shots for inclusion in the assembled page.

i Only the -TwistPow version can’t be given blank 

images. You could make titles that drop into empty 

spaces, however. Just remember to keep them vertical 

in a 2x3 proportion.

i iMulti16 image files end up 3072 x 2048 pixels in 

dimension. The iMulti16H/V+Mullions versions end up 

3195 x 2119 pixels.

i Since the threshold of excellent photographic 

printing is about 170 pixels per inch, these files look 

good up to Super A3 prints.

i Once you have generated a satisfactory page, save 

the file for later printing.

This is how iMulti16H gathers 
images and places them on US 
Letter paper at 292.6 ppi for 10.5 
inches of print width. The bottom 
pages shows iMulti16H+Mullions 
using the same source files, 
printed at 304.5 ppi.
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Since day one, Photoshop has had a sturdy complement of “filters” as 
a major feature. When you open them for the first time, they have 
default settings that greet you. We have regarded them with a more 
photographic eye and have come up with new, improved default settings 
and expanded steps that deliver tastier images.

At first look, the Photoshop set of Filters seems capable 

of anything. They have categories like Artistic, Blur, 

Brush Strokes, Distort, and so on—14 in all. Within each 

is between two and 15 different filters for a grand total of 107 unique 

items. The list has been growing slowly with every new version of Pho-

toshop. Version 6.0 had 101 distinct items, all of which are included in 

Version CS5, so these are solid, continuing features of Photoshop in a 

broad sense.

They have hundreds of adjustments. Each one may have three or 

more sliders, settings, options or choices with names that are unique 

to the current filter. Getting used to them takes time. But once you 

understand a filter, it will be your friend forever.

Photoshop™ Filters, Plus, Plus, Plus
New life for the old standbys

Chapter 3



  76 | CHAPTER 3       ACTIONS CS5

iNovaFX iPS-series Photoshop Filters are collections of 

settings we favor commonly with the Photoshop Filter 

sets. Here are new starting places for you to use on 

photographic images—places that we think will give you a 

better, more graphic image treatment right away.

Most of them go beyond this simple premise. Extra steps 

are added that complete the general idea of the Photoshop 

Filter. You will find 98 individual treatments here, many of 

them bringing your image into a new light.

We employ Photoshop’s own designations to group 

them into eight categories found in the current version of 

Photoshop CS5, and we recommend that you set aside an 

afternoon or three to play with them on your images. The 

categories are:

iPSArtistic	 21	Actions

iPSBrushStrokes	 10	Actions

iPSDistort	 23	Actions

iPSPixilate	 6	Actions

iPS+Noise	 2	Actions

iPSSketch	 29	Actions

iPSStylize	 15	Actions

iPSTexture	 9	Actions
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iPSArtistic
The set called iPSArtistic holds 21 interesting effects made 

from the 15 Photoshop Filters of the Artistic group. They seek to 

convert photographic images into more graphic images, reducing 

the bright, gleaming presence of a digital photo while adding the 

look of an artist’s intervention.

iColorPencilWhite
The White is the paper color, and this 

iColorPencilWhite Action produces a 

convincing pencil sketch from many 

different types of photograph. Good for 

images from 8MP to 18MP, results are very 

artful indeed.

i If results are not to your liking, try 

changing the contrast and/or brightness of 

the image before attempting it again.
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iColorPencilGray
On a medium gray paper, lighter colors can show as 

highlights, emulating what many illustrators use to bring 

life to pencil sketches. iColorPencilGray retains the broad 

highlight areas that Photoshop’s Filter dismisses.

i It may help to force highlights in the photograph to 

nearly white in order to achieve light pencil marks in the 

final image.

i Gray is, of course, the paper color. White pencil or china 

marker-like highlights add to the effect.

iColorPencilGray mixes bold 
outlining strokes, pencil 
hatching for tonality and detail 
plus light colored highlights on 
a middle tone gray paper. 
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iDryBrush
Dry brush techniques generally apply water-based paint on 

dry paper or board with a brush that’s merely damp, not wet. 

Strokes are made to transfer color in a range of coverage effects 

from solid areas to feathered areas where the tooth of the 

medium picks up color in random spatters, forming intermedi-

ate tonalities. In a sense, it’s like paint being used as a colored 

pencil, depending on the substrate to build up tonalities.

iDryBrush imparts some of this flavor by reducing similar 

tonalities to a flatter look while adding sketchy intermediate 

tones and a rough look to areas of blended, non-focused detail.

i It works well with subjects like flowers and faces, producing 

compelling images that deserve a second look. From a distance, 

photographic attributes dominate, but on close inspection, it 

looks painted by hand.
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iDryBrushG
A more extreme variation, 

iDryBrushG produces more 

graphic results. It enlists extra 

Photoshop tools to emphasize 

contours and add some outlin-

ing, while altering little in areas 

of soft focus.

i This Action is worth experi-

menting with over a broad 

range of photographic images.

iDryBrushG creates a heavier 
graphic effect. 
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iFilmGrain1 / 2
Photoshop’s Film Grain Filter can 

produce a range of effects from nearly 

imperceptible to severe. These two 

settings create the look of film grain 

associated with color film having 

nominally ISO 800 and ISO 2000 

indexes.

Why would you want to produce 

a grainy image? “Film look” and the 

impression of dimly lit subjects are 

two reasons. Grain can add authentic-

ity to documentary images, too. The 

rest is up to you.

i Highlight areas stay relatively grain-

free while shadows pick up consider-

able grain noise in both of these.

iFilmGrain1, left, is about as 
noisy as ISO 2000 color film. 
iFilmGrain2 on the right is about 
ISO 6400. Your camera’s ISO may 
vary from these estimates.
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iFresco
The Photoshop Fresco Filter creates a mottled effect 

that is powerful for photo illustrations in B&W and 

color.

Fresco painting is water-based and is applied to wet 

plaster so paint and architectural surface dry together. 

It’s permanent, relatively damage-proof and takes the 

texture internal to the plaster.

This setting is our improvement on the default set-

tings. It punches up contrast and produces an artful 

effect with images from 5MP up. 

Feel free to experiment with the Photoshop Filter 

beyond the iFresco Action.

i iFresco is an Action worth trying on images that 

don’t appear to be dramatic on review. Sometimes 

we take a shot thinking it would be good, only to find 

that it’s pedestrian. iFresco may revive the drama you 

thought you were capturing originally. 

i It works quite well with images that missed out on 

perfect sharpness, too.

iFresco often makes semi-interesting 
images into interesting pieces of art.
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iNeonGlow1 / 2
Color images turn to monochrome and shadows pick up a golden 

glow. It’s an illustrative effect with occasional (rare) use.

iNeonGlow1 presents the glow inside a B&W image while iNeonGlow2 

stops to let you select Foreground and Background colors in the 

Tool Panel. The foreground color will replace white in the resulting 

monochromatic plate while Background color will be the darker tint.

iNeonGlow1 is at left and iNeonGlow2 with a light yellow 
Foreground color and deep brown Background color is on the 
right. 
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iPaintDaubs
iPaintDaubs turns your photograph into a blobograph in color or 

B&W. Detail becomes blobs of wet paint applied thick with a soaked 

brush. Our version gives you the added control of a Curves Adjustment 

Layer over the finished image so you can change the relationship 

between tonal areas in the final result. 

These images used the default curve for the top one to reduce con-

trast and an almost diametrically opposite curve for the bottom one to 

punch the colors up to full saturation.

i Remember to flatten the image once you 

are happy with the Curve. Shift + Control +E 

/ Shift + Command + E will do that.

iPaintDaubs images are best viewed very large so the 
blobby nature of the effect can be experienced. 
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iPaletteKnife
Like the iPaintDaubs, iPaletteKnife 

reduces the image to lower-detail areas 

of color, but has its own signature look. 

When painting with a palette knife—

usually in oils—thick blobs of paint 

are picked up with the tip of a thin, 

spatula-like, flexible blade and applied 

to the like buttering bread with warm 

butter. The artist exercises control 

over the size and shape of the area and 

direction of the spread.

The effect adds flat color along con-

tours, so large areas of similar color stay 

large. Shape is maintained well for detail, 

but subtle detail disappears. 

i This effect is best with large subjects, 

but you may find pleasure in how it turns 

detail into impressionistic texture.
iPaletteKnife is one of the effects to try with 
many kinds of subject matter. It can surprise you. 
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iPlasticWrap
What happens to an image when the scene is covered in a large sheet 

of transparent cling wrap, cling-film, Glad Wrap®, Stretch-Tight® or 

Saran Wrap®? 

They’re all the same thing around the world, polyvinylidene chloride 

(or sometimes polyethylene) appearing as a stretchy, clear food wrap-

per for temporarily preserving leftovers.

Try the iPlasticWrap Action on your leftover images and it will make 

the shot look ...er... like it was preserved while all the air was sucked 

out of the package. You know; to avoid spoiling.

i iPlasticWrap works with a wide range of image 

types, following the contours of tonal areas, 

making the image look like it was a shallow bas-

relief sculpture, now packaged for distribution.

iPlasticWrap preserves your 
images for freshness.



|   87Photoshop Filters Plus    ACTIONS CS5

iPoster
Posterizing an image involves more than simply reducing its tonalities to flat 

areas of color. The ideal Poster image is a throwback to the days when posters 

were vivid, simplified images that told their story in a glance.

iPoster is an improvement on the default setting of Photoshop’s talented 

Poster Filter, which cleverly reduces tonalities and outlines the contours that 

show sharp, contrasty transition.

i iPoster works on color and B&W images of all sizes.

i If the effect looks promising, but the tonalities don’t seem to work with the 

effect, try altering the Curves or Levels of the original before running the Action.

iPoster graphic treatments.
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iRoughPastelsBoard / 
iRoughPastelsCanvas
Chalk scrapes off its hard, dry 

stick grinding onto the paper or 

board in dusty islands of color. 

The rough surface acts as a sort 

of sandpaper, building up an 

image in layers of opaque color. 

Final images are delicate, but 

fast to generate.

i So delicate that a clear 

varnish fixative is often sprayed 

onto the art to immobilize the 

clinging chalk.

Photoshop’s RoughPastels 

Filter emulates this paper/chalk 

relationship, but the results are 

digitally preserved.

iRoughPastels presents two 

different treatments for 8MP 

to 18MP images tuned for 

toothy board or paper surfaces 

or textured art paper with a 

canvas texture.

i Although they work with any 

images, large subjects tend to 

look best with these Actions.

iRoughPastelsBoard and iRoughPastelsCanvas 
look similar, but the Canvas option (above) has 
a more woven texture. At left, the original image. 
Enlarge this image to 300% ~ 400% on your 
computer screen to see the textures clearly.
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iSmudgeStick
Smudge sticks are often made of paper, tightly wound 

into a cylinder. Pointed but frayed at the working end, 

they softly move chalk around on the paper, spreading 

it and averaging colors together. That’s the intent of the 

Photoshop Smudge Stick Filter.

Our iSmudgeStick Action makes choices generally useful 

for this effect with 6MP to 10MP images.

i As with actual smudge sticks, the image builds up some 

contrast with iSmudgeStick.

i It’s harder to predict which images will work with 

iSmudgeStick than with many other Actions. Experiment.

iSmudgeStick spreads 
areas of single tonality and 
simplifies detail. 
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iSponge
The blot thickens.

Using a small sponge instead of a brush lets you 

blot your way to artwork. The Photoshop Sponge 

Filter achieves much of this and our tempered 

iSponge Action lets you apply the effect to many 

kinds of images.

Detail will become 

generalized with larger 

areas of color or tonality 

and a texture will pervade 

areas of continuous tone, 

but the effect is quite nice.

i One may add this effect 

to images that have already 

been treated with iSmudgeS-

tick or iPalletKnife.
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iUnderPainting
Often an artist will sketch out a canvas with a quick underpainting made with 

broad strokes and thin paint that catches the texture of the canvas. 

iUnderPainting uses Photoshop’s Underpainting Filter to deliver low-detail, 

textured boundaries at scales appropriate for 6MP to 18MP images.

i A hybrid image can be made by combining the under-

painting with a more finished one. Stack the finished one 

above the underpainting and erase areas to let the under-

painting layer show through.

iUnderPainting forms 
a smeared, canvas-
textured image. At 
right; the original. If a 
painting interpretation 
is overlaid, any areas 
of it that are erased will 
let the iUnderPainting 
show through. 



  92 | CHAPTER 3       ACTIONS CS5

iWaterColor1
Turning a photo into a watercolor image can take unexpected twists 

and turns. While Photoshop has a Watercolor Filter—see next page—

we favor the more graphic result from iWaterColor1 which uses other 

techniques to emulate watercolor and ink artwork.

iWaterColor1 can find graphic validity where 
a straight photograph (above) falls short.
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iWaterColor2 / iWaterColor3
Both of these Actions use the Photoshop Watercolor Filter to create 

their primary effect. Each has a distinct look of its own.

i As with many Actions, iWaterColor2 (below) and iWaterColor3 (left) 

work most effectively with particular kinds of images. Experience with 

each will be your best teacher.

iWaterColor2, above right, adds a strong outline to well-defined 
areas of liquid color. iWaterColor3, above left, creates fewer lines 
and more liquid color areas.
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DIGIMARC
Some of the items in the Photoshop Filters list aren’t really filters at 

all. Not in the sense that they serve some graphic service. 

The two Digimarc filters at the bottom of 

Photoshop’s filter list don’t perform any aesthetic 

functions, but embed a holographic digital data 

watermark in the image that can be read to estab-

lish copyright. At most, it resembles 1.8% noise. 

You’ll never notice it.

i Tip: To embed serious data with Digimarc, 

you must purchase a license from Digimarc from 

about $80 to $500. The version in Photoshop is 

only a Demo. But it will let you embed a range of 

copyright dates in any image for free, and read 

that data at any time. For a minimal copyright 

protection, you could enter the any four-digit 

number from 1922 to the current year, comma, 

any subsequent four digit number equal or less 

than the current year. 

i For instance, “1922,1923” works as well as 

“1922,2010” or “2007,2010,” so you have poten-

tially 89 first numbers and 88 second numbers to 

code into your shot. That’s 7310 potential codes. Enough to be useful 

in a copyright fight.

Do a screen capture of this image and run it through Photoshop’s 
Digimarc Watermark Reader. You should discover a pair of 
copyright dates and cautionary messages concerning the image.
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iAccentedEdgesInverse adds outlines around 
contrasty contours. Compare the unaltered 
detail at left to the effect, above.

iPSBrushStrokes
Within this set, nine Actions contribute variations that interpret your 

images in brush, pen and pencil strokes.

iAccentedEdges
Images become nearly cartoon-like with 

smooth, airbrushed color areas outlined in 

tightly drawn ink. Any contour that has a signifi-

cant contrast with its neighbor is an immediate 

candidate for outlining, but smooth transitions 

generally don’t acquire outlines. 

iAccentedEdges moves the image somewhere 

between drawing, painting and photograph.

iAccentedEdgesInverse is a variation that 

draws its lines differently. It’s a goopier, more 

fluid effect.

i Gee, I wonder what an image looks like when 

the Action is run twice?

i Many different kinds of images will work 

interestingly with either iAccentedEdges.
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iAngledStrokesLg
iAngledStrokesLg turns tonal areas into a 

wet-media brush stroke that can redefine the 

surfaces of subject matter.

i It works best with 6MP to 8MP images. 

Larger files will experience less dramatic 

results. 10-12MP images work well with this 

Action if natural presence of detail is high, 

people are of medium size and you wish to 

take the photographic realism out of the shot.

i You can always re-size an image smaller 

before running an Action that has more impact 

on smaller shots.

i Photoshop’s Angled Strokes Filter displays 

the strokes more vividly with higher Sharpness 

settings. That introduces artifacts in areas of 

contrasty contours. The iNovaFX Action takes 

steps to reduce the artifacts while maintaining 

the stroke presence.

i An image deserving this treatment does 

not have to be the sharpest pencil in the cup. 

You may add noise to the shot to pump up 

the presence of brush strokes in an otherwise 

slightly soft image.

i The snapshot, PS Original Angled Strokes, 

in each version shows the image before detail 

and edge clean-up.

iAngledStrokesLg. Texture feeds the Angled Strokes Photoshop Filter. View closely to 
see the stroke detail. At right, the same effect on Cellphone Cowboy.
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iAngledStrokesPortrait
For full-size large-head portraits, iAngledStroke-

sPortrait equalizes the contrast of the image and 

applies a tuned balance of shadow and highlight 

brush strokes to the image.

Photoshop’s Angled Strokes Filter edge contour 

artifacts are reduced while stroke textures are 

emphasized.

You don’t have to use it with portraits, but it 

was developed for them. 

i Best with images in the 8MP to 12MP range, 

detail drives generous brush strokes.

i Images with many small objects will lose 

recognizability. If this one doesn’t work for 

your image, try the iAngledStrokesLg varia-

tion.

iAngled Strokes Portrait used 
for ...what else?... a portrait. 
Notice how beard and hair are 
diminished and generalized 
while the teeth appear quite 
natural. Angled Strokes Filter 
artifacts have been aggressively 
reduced. Obviously the designer 
of his shirt beat us to the punch.
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iAngledStrokesSm
In this Action, the stroke 

length is small. It works 

best with smaller images in 

the 3MP to 7MP range and 

takes the realistic edge off of 

detailed shots.

If you crop into an image 

severely and still wish to 

create a painterly effect, try 

this one.

i Notice how fine detail 

becomes diminished, adopt-

ing a less intrusive texture 

while the flat planes of the 

strolling couple render them 

more abstractly.

i Printing small images like 

the one seen here can be 

facilitated with the exceptional 

enlarging program called 

Photo Vista Pro. It’s one of those wonderful 

utilities that is worth its weight in silver.

iAngledStrokesSm used on an image only 1000 x 667 pixels large. 

http://www.benvista.com/main/content/content.php
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iCrossHatch
Photoshop’s Cross Hatch 

Filter has three adjustments 

and nearly three thousand 

permutations.

We have exploited a sweet 

spot to produce the appealing 

iCrossHatch Action.

i Try this Action with 

different types of images 

to see how it behaves as it 

makes photographic qualities 

into abstractions of shape 

and texture. It’s almost like 

applying a fine grit sandpaper 

to your image.

 

iCrossHatch buffs out detail while applying a sheen to surfaces. 
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iDarkStrokes
Illustrators often connect with viewers by simplifying the visual 

standards of sight and smoothly substituting the visual standards 

of emotion. On some kinds of subjects, the iDarkStrokes Action 

achieves this sort of balance and turns photos into plausible finished 

illustrations.

Images stay quite photographic with tonalities preserved, but small 

detail is glossed over, as if the 

illustrator were quickly painting 

in the fine points.

i Photoshop’s Dark Strokes 

Filter is worthy of greater 

experimentation in your hands.
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iInkOutlines
Every illustration style is unique. Some illustrators pride themselves 

on reproducing scrupulous detail while introducing a factor that takes 

the image out of reality and into the realm of drawing. iInkOutlines 

adds a fine-outline structure to a vivid airbrush and/or watercolor layer 

and describes some middle tones as a mix of line and color.

i To achieve the best result, you will probably have to adjust contrast 

or Curves values before running the Action.

iInkOutlines. 
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iSpatter
Diffusion can take many forms. iSpatter creates the sort of 

diffusion that a rough ground glass produces when it is floated 

over a photographic print. Images blur, but by tiny, discrete, 

hard-edge chunks—the ground glass’ degree of roughness.

i With night subjects, the result is almost like a coarse, 

quickly-spattered airbrush sketch with opaque paint sprayed 

onto a dark surface.

i The Photoshop Crop tool can be instructed to deliver 

a specific-size result, and setting this for a 3000 x 2000 

pixel result (6MP) will give images with the detail level seen 

on this page.

i Blurred shots with good composition are fair game for 

iSpatter. Lack of detail becomes abstraction. You may get 

new images out of them.
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iSprayedStrokes
What if you could shake up a can of spray 

paint and have every droplet come out as a 

brush stroke? That’s what the designers had 

in mind for this Photoshop Filter. It tears the 

image into directional shards, causing an 

abstract effect you’ve seen on canvas.

What if the strokes in shadows slashed to 

the northeast while strokes from highlights 

slashed to the northwest? That’s our 

iSprayedStrokes version, and it makes an 

interesting abstraction of the original image.

i You may wish to run Auto Contrast, Auto 

Levels or Auto Color before running the 

Action, in an attempt to provide a reasonable 

level of shadow and highlight values to work 

with. We did, here.
iSprayedStrokes. Note how the detail panels below create mini-impressionist paintings. 
The original at lower right.
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iSumi-E
Photoshop’s Sumi-e 

Filter emulates black 

ink on white paper. Our 

variation takes this to a 

new level. Serigraphic 

art on rice paper.

iSumi-E first creates 

the rice paper layer, a 

textured surface with 

occasional streaks of 

tawny imperfections. 

Then the photograph is 

rendered as a dark line 

drawing with trapped 

silk screen styled color 

areas.

i Best with 8MP+ 

images.

i Best when enlarged 

above letter size.

i Tonality pre-adjust-

ment experimentation 

recommended.

iSumi-E creates bright silkscreen images from 
original photos. It works surprisingly well with darker 
shots. 
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iPSDistort Series
Distortion is often geometric but can take other forms. Case in 

point:

iDiffuseGlow1 / iDiffuseGlow2 / iDiffuseGlow3
The glow takes on Photoshop’s Foreground Color. We have turned 

this white to cause the effect of glare seen through foggy lenses. 

The three iDiffuseGlow(#) Actions are progressively more intense and 

progressively less realistic.

i Changes to the tonalities of your image will dramatically alter the 

effect of each Action.

iDiffuseGlow1 on top, iDiffuseGlow2 in 
the middle and iDiffuseGlow3 on the 
bottom. Below is the original image.
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iGlassRipple
Rippled glass lets all the light through but breaks up the image. Every 

ripple acts as a distortion lens, bending the reality beyond.

The iNovaFX iGlassRipple applies maximum distortion to the image 

and saves a Snapshot in the History Panel.

i Judicious use of the History Brush will allow you to paint selected 

details back to reality, as we have done here.

iGlassRipple allows the 10MP image 
to be recognizable but not observable. 
The History Brush restored just the 
figure.
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iOceanRipple
Although Adobe’s nomenclature links this to an ocean effect, 

it appears as a finer-grained glass ripple distortion of the 

image.

iOceanRipple is scaled for images in the 8MP to 12MP range 

and breaks up the image as if a glass shower door were placed 

near an image. General shapes survive, but are quite fractured 

without being truly blurry.

i Note that the effect spreads the original image slightly right 

and down, then crops the shot a bit smaller. This is its natural 

function.

iOceanRipple is like 
a finer-grained Glass 
Ripple Filter. 
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iPinch
Photoshop’s Pinch Filter indents or bulges the image, depend-

ing on whether a positive or negative value is set.

iPinch-50 causes a bulge, while iPinch+70 causes an indenta-

tion. An H or V in the name of the Action tells you it’s for a 

Horizontal or Vertical image only.

i There are four Actions in all.

i The final image will be 4500 x 3000 pixels. Any size original 

may be used.

iPinch-50, top right, produces this bulging center. 
Below is iPinch+70, which reduces the image center 
while stretching the image sides. Compare to the 
original, bottom left.
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iSpherize
Like the Pinch Filter, Photoshop’s Spherize Filter distorts the image 

with an inward or outward bulge or indentation. Spherize renders 

the image onto a continuous curve as noted on page 31.

Here are four iNovaFX Actions with variations of Photoshop’s 

Spherize, as applied to the whole image. The weight of each is a full 

±100%. Horizontal and Vertical versions of both bulging and indent-

ing variations are available, four in all.

iSpherize±100[H/V] Actions force the image to 4500 pixels in its 

longest dimension, square its canvas for maximum effect and apply 

a circular spherical distortion, then crop the image back to 4500 

pixels at maximum.

i Some of the corner detail is lost with iSpherize-100 and some 

edge and side detail is lost with iSpherize+100.

iSpherize-100H on top squeezes subjects inward while iSpherize+100, above, inflates them outward. The original at right.



  110 | CHAPTER 3       ACTIONS CS5

iRipple
Photoshop’s Ripple Filter looks at first like another Glass 

Ripple variation and it does a similar job on images, but this 

one applies a repeating pattern whereas Glass Ripple and 

Ocean Ripple are more random.

iRipple merely facilitates the application of PS Ripple, but adds 

the step of preserving the effect as a Snapshot in the History 

Panel.

i You may change the settings, but the default of 333% is a 

balance between order and chaos.

iRipple creates a different sort of regular 
ripple texture over the image. 
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iShear
Photoshop’s Shear Filter only works on shearing the horizontal axis 

of an image. Options are given to Wrap the image or duplicate edge 

pixels. Our variations of iShearH and iShearV for both horizontal and 

vertical images selects the latter.

i Objects with blank or monotone backgrounds work best to mask 

any pixel repeating. Some hand retouching of repeat pixel areas may 

be called for. Backgrounds made of blank skies and featureless walls 

often are your best bet.

iShearH on top uses the default S curve. 
iShearV must turn the image sideways 
to perform the distortion. At bottom, the 
original.
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iTwirl
Photoshop’s Twirl Filter can twist an image around its center up 

to 999° or just over 2.75 complete spins. But that doesn’t look very 

good. 

About the most you can get away with is 90° and the iTwirl±90 

Actions do that. 

i It’s rather like putting your image on psychedelic drugs.

i Positive [+] twists clockwise.

iTwirl+90 gently twists the center of the 
image 90° clockwise. 
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iWaves
Photoshop’s 

Wave Filter asks 

you for input data 

and gives you the 

world’s tiniest 

thumbnail to help 

you see what the 

effect will be. 

The iWaveH and 

iWaveV Actions 

are designed 

around that. 

Use them inter-

changeably with horizontal and vertical images. Each 

delivers a somewhat different effect. 

i The real juice flows when you use them many 

times. After the Action runs, it leaves a Snapshot, 

but run it nine more times (or use the easy way by 

simply hitting Control + F / Command + F nine more 

times and waiting for the final result), and the image 

becomes a swirl-fest of texture, using the colors of 

your original only roughly correlating to the image. 

The effect is reminiscent of paper marbling —a 

decorative printing process used in book binding.

iWaveV, having been run 10 times (left half 
of left image). Its distortion is more obvious 
than the detail in iWaveH, (left half of top 
image) also run 10 times. The right side of 
each shows what the first application of the 
Action looked like when performed just one 
time. The small image is the original for the 
top effect.

http://www.google.com/images?client=safari&rls=en&q=paper+marbling&oe=UTF-8&um=1&ie=UTF-8&source=univ&ei=AY4BTOzWJZGwNpC63Ds&sa=X&oi=image_result_group&ct=title&resnum=4&ved=0CDgQsAQwAw
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iZigAround
Zigzags are back and forth motions. Photoshop’s ZigZag 

Filter influences a circular or elliptical area you select. 

The iNovaFX iZig-series of Actions facilitate setting up a 

defined area in your image, then applying a tuned version 

of the ZigZag options Photoshop provides.

iZigAround makes seven concentric circular rings of 

zigzags around the center of a selected circular. The Action 

sets up the selection, then stops so you can move and 

shape that area to your liking. Run from this point to com-

plete the effect. A labeled Snapshot will show you the effect.

i Note that the keyboard shortcut to transform a selection 

is Control + Alt + T / Option + Command + T (Windows/Mac).

i iZigAround softens the edge of the selection area so a 

hard edge will not surround the effect.

iZigAround delivers 7 radiating 
concentric rings. Here, the 
effect was steered into the 
existing ceiling. 
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iZigCenter
What if the zigzag were in and out of center?

iZigCenter makes 12 ripples, each of which push or pull 

pixels toward the center of the selection area.

The Action sets up a elliptical selection area, then stops 

so you can move and shape that area to your liking. Run 

from this point to complete the effect. A labeled Snapshot 

will show you the effect.

i Reminder: Note that the keyboard shortcut to trans-

form a selection is Control + Alt + T / Option + Command + 

T (Windows/Mac).

i An interesting sunburst effect can be made with a 

photo by centering the selection ellipse, running the 

iNovaFX Action, then 

pressing Alt +F / Com-

mand + F numerous 

times to apply a large, 

centered concentric 

ring effect.

iZigCenter starts with a selection 
that can be steered over the detail 
deserving treatment. At right, the 
Sunburst effect.
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iZigPond
The ZigZag Filter has one 

last effect, and perhaps the 

most realistic. It's a pond-

ring, like the ripples from a 

stone cast into the water.

The iZigPond Action 

draws a selection circle 

high in the frame and 

comes to a Stop. 

You must manipulate this 

selection to the place and 

shape you wish to add the 

effect, then run the rest of 

the Action from that point, 

forward. A snapshot will 

show you the effect.

i Use Perspective, Scale, 

Rotation and other Trans-

form options to shape the 

area you wish to influence. 

With CS5, Warp is also 

available.

iZigPond allows you to select the area of the image that will receive 
the effect. Look carefully, it’s easy to miss. 
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iPSPixelate Series
The French neo-impressionist painter, Georges Seurat was the 

first artist to tear an image into spots of pure color that only 

revealed form and subject through viewing them in aggregate. 

Mechanical reproduction (in print) does that, too.

iColor Halftone[L/T] / iBWHalftone
Two iNovaFX Actions are scaled for Letter paper, 

iColorHalftoneL, and Super A3 or Tabloid paper, iColorHalftoneT. 

The difference is in the apparent dot size, which is significant at 

normal viewing distances. 

For monochrome, iBWHalftone turns the image monochrome, 

then corrects its tonalities and generates a large 45° halftone.

i Vertical images only. Turn a horizontal image vertical before 

running the Actions.

i The images are subjected to a density curve correction as part 

of the Action and are scaled to a standard 

size before being halftone separated.

iColorHalftoneT. The printing dots are spaced 34 
pixels apart for effect and colors are arranged at 
different angles. The effect becomes more obvious 
at 300+% viewing.
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iCrystalize
This cracks me up. It fractures the image into irregular shards that 

are a single color each, averaging the color under the shard. iCrystalize 

breaks a 10MP image into cells about 15 pixels across and adds the 

local contrast Seurat brought to his images over 100 years ago.

iCrystalize will take the 
reality out of your images 
in a colorful way. 
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iPointillizeSeurat / iPointillizeSeurat+
Drawing on several techniques, iPointillizeSeurat comes 

closer to replicating the master’s spot color technique. The 

result is vivid and quick. iPointillizeSeurat+ takes longer to 

operate but produces an image with three different sizes 

of paint points. Both impose local contrast that heightens 

dark against light and light against dark boundaries.

i Control of Local Contrast is available separately in a later 

Action.

iPointillizeSeurat with 
one size of paint dab. 

Seurat’s technique came as photography was just getting 
interesting in the late 1800s. Notice the “local contrast” effect 
around dark and light subjects. Seurat was sensitive to this 
before photographic retouching techniques achieved it. This 
image, “Sunday Afternoon on the Island of La Grande Jatte,” 
is ten feet wide. Courtesy of the Art Institute of Chicago

http://www.artic.edu/artaccess/AA_Impressionist/pages/IMP_7.shtml#
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iPS+Noise Series
We use the Photoshop Median and Dust & Scratches Filters to remove 

details that are better left obscured from some kinds of photos. Trade-

marks, license plate numbers, and perhaps faces of some individuals 

might require obscuring.

iMedian / iDust/Scratches
iMedian stops to let you select an area with the Lasso Tool. Use either 

the continuous, round Lasso Tool or the Polygonal Lasso Tool that 

makes a selection as a series of connected clicks. Run the Action from 

its stopping spot and the surrounded area will receive a soft edge to 

the Lasso line, then Median-ize the enclosed selection. Each pixel will 

blend with all others in a three-pixel radius, blurring them together 

without looking like a simple blur. Small detail disappears but the 

general color stays correct.

iDust/Scratches sets the selection up in the same way, but when it 

completes, a 10-pixel detail removal/obscuring function is the result. 

i Both Actions destroy fine type, small texture, and tiny flaws.

i As the Action ends, the Selection area stays active. You must dis-

miss it intentionally. Use Alt + D / Command + D to delete the selection. 

Immediately after running either Action, use Alt + F / Command + F to 

repeat the Filter.

i iDust/Scratches has a greater impact than iMedian. Its selection 

edge is not blurred, so it can work tighter zones of influence.

i Use either to obscure faces. iMedian will require more repeat 

applications.

iDust/Scratches applied four times in a row. Where? There are four areas where 
trademark names have been obscured. Where? Check out that Jaws T-shirt. 

The one you can’t find is up in the Benji.
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iPSSketch Series
Getting good hand artwork from a photo is an art in itself. The iSketch 

series contains a feast of 29 potent artwork generators.

iBasRelief
Triggering off of light and dark areas, iBasRelief applies settings that 

are good for many 8MP to 18MP images. The result is monochromatic 

with image bright details pushed forward and image dark areas recessed.

iBasReliefColor
The original image’s colors are 

retained, but below the color, the 

Bas Relief effect gives the image 

dimension.

i iBasReliefColorInverse merely 

reverses the relief direction.

iBasReliefColor. 
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iChalkNcharcoal / iChalkNcharcoalColor
Chalk is light and scruffy, charcoal is dark and wide as the paper 

catches each stroke, receiving opaque dashes of tonality or color.

iChalkNcharcoal produces a monochrome sketch of your photo. Done 

with a light hand, it preserves much of the photo’s tonalities but detail 

is necessarily lost.

iChalkNcharcoalColor takes its time with the subject, using a rainbow 

of pastels from a well-tempered palette.

iChalkNcharcoal’s monochrome 
result is much like charcoal drawing.
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iCharcoal / iCharColor™
Colored charcoal? Isn’t that just chalk? What will we dream up next? 

Physics aside, these are single media art conversions made with 

routine black charcoal—the kind that is made of carbon  —and colored 

charcoal, um... possibly the kind that is made of carbon nanotubes of 

various sizes, you know, to get the colors. Yeah. That’s the ticket.

In the digital world, all 

physics are possible. But I 

digress.

iCharcoal is the mono-

chromatic option, and 

iCharColor is the version 

dreamed up here at iNova-

Labs in the Nano Carbon 

Color Department.

iCharcoal turns some photos into detailed 
monochromatic sketches. iCharColor 
produces color charcoal drawings.
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iChrome / iChromeChroma
Today, you can metallize anything. Including your photographs.

iChrome turns a photo into a reflective, bas-relief version of itself. 

Detail is lost in droves, but the general shape of the original remains. 

Try it with different kinds of images and soon you will be able to see 

between the pixels and know what kind of image will work or not.

iChromeChroma plates the final surface with anodized colors, and 

leaves you with a two-layer 

Snapshot which can be further 

manipulated.

iChromeChroma.
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iContéCrayon1 / 2 
Conté Crayons are actually hard pastel chalk that are often sold in 

limited pallets of color. Black, white, and shades of brown and ochre 

are the most common, but skin-tone sets for portraits are also to be 

found. The most common use is on paper that has color of its own, so 

the crayons define shadow and highlight areas.

iContéCrayon1 produces a rich white and black crayon effect as 

applied to middle gray paper.

iContéCrayon2 is appropriate for images that are largely middle tone 

to begin with. The final is on slightly tan paper. But you can control the 

paper color somewhat with the Opacity control 

of the upper layer in the resulting Snapshot.

i Both are made with Canvas texture.

iContéCrayon1, above, delivers rich tones from 
mid-value originals. iContéCrayon2, right, is on 
tinted paper. [Note that the canvas texture will look 

much better in your prints than in these reproductions.]
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iContéCrayon3 / 4
Color paper often provides a default middle tone to 

typical two-color Conté crayon drawings. That trend 

continues in version 3 and 4.

iContéCrayon3 adds a warm paper and contrasty 

tonality overall.

iContéCrayon4 is positively sepia in its tonalities.

i Sandstone texture simulates rough paper.

iContéCrayon3 on top and 
iContéCrayon4 beneath. 
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iContéCrayonColor
Although Photoshop doesn’t have a 

Conté Crayon Filter in color, this may 

help. iContéCrayonColor retains the 

hues of the original image, and layers 

them onto a Conté crayon substrate.

Sometimes artwork derived from a 
photograph can tell the story of the image 
in ways that photographic realism won’t 
convey. iContéCrayonColor. 
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iGraphicPen1 / 2 
Forget the photo. What 

you really wanted was a 

sketch made with a fine 

point pen. And here it is. 

iGraphicPen1 uses India 

ink, modest strokes and a 

steady hand to redraw your 

shot as a nice rough sketch.

iGraphicPen2 uses longer 

strokes and is tuned to pick 

up on shadow detail a bit 

more.

iGraphicPen1 at right and iGraphicPen2, above. Both 
may require that you find the right balance of contrast and 
brightness before running the Action. 
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iGraphicPenColor1 / 2
Now for the color drawings.

iGraphicPenColor1 (strawberries) 

uses shorter strokes and its own 

selected tonalities.

iGraphicPenColor2 (clock) gives 

you the hands-on opportunity to 

tweak the color layer before it 

consolidates the image into a single 

layer.

With iGraphicPenColor, the original 
tonalities become merely approximate. 
It’s difficult to predict the effect simply by 
looking at the photo, 
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iPhotoCopy
Back in the early days of office copy machines, reproductive accuracy 

was rather Neanderthal. It was deemed sales-worthy when it could 

reproduce type well, but pictures? Fuggeddaboudit. On a scale of 10, 

Xerographic copying equalled 0. (Not to be confused with current 

products.)

iPhotoCopy is a tuning of Photoshop’s Photo Copy Filter that matches 

the spirit of those old copiers, delivering an interestingly degraded 

graphic image.

i You might press your face against a window and 

shoot that from the other side, passing off the final 

image as an old X.

i To increase the contrast-spread, 

reduce the size of your image first. 

These are 6MP.

iPhotoCopy with several different images. Notice 
how Photoshop’s Photo Copy Filter works on 
the contrast transitions, not so much tied to 
the absolute brightness of given areas. The 
seaplane image is a crop, the others, full frame.
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iPhotoColorCopy
When color copiers came into being, they were 

still living in caves, too. The color came through 

vividly, but the quality was low. Perhaps not as 

bad as we are making out here, but you get the 

picture.

iPhotoColorCopy will get the picture as an 

exaggerated graphic, tuned for 6MP to 8MP 

images. 

i These are 6MP originals.

iPhotoColorCopy with several different images. 
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iReticulation 1 / 2 / 3
Reticulation is the surface of the varnish on a 

100 year old piano. It’s an irregular beading up 

of the image into random, but same-size areas. 

Of course, detail is lost, but the effect has charm.

iReticulation1, iReticulation2 and iReticulation3 

are variations that tweak contrast and reticulate selectively.

i Above is the meandering classic reticulation shape found in 

middle tones.

i Two utilities (Horizontal 

and Vertical) are in the folder 

to reduce your image to 6MP 

for larger, bolder reticulation 

patters.

Ascending from left, iReticulation1, -2 and -3 were all 
generated from the color original.
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iReticulationColor
What if 100 year old paint were to reticulate? The color would flow 

with the clumps.

iReticulationColor performs the Reticulation Filter and is colorized by 

the image.

i Shading of the original influences the final result, dramatically.

iReticulationColor likes colorful images. 
While it is true that many owners ran their 
VW Bugs into the ground, the name of the 
picture at left is “Eye Opener.” 
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iStamp
Not like stamping your feet. More like stamping with a rubber stamp. 

Tonality is not allowed. But results are not guaranteed to apply the ink 

perfectly. A little bleeding is inevitable.

iStamp prints its image as a detailed rubber stamp using dark blue ink. 

i You can always change the ink color with Photoshop’s Hue & Saturation 

control. Activate that with Alt + U / Command + U in your favorite operating 

system.
iStamp makes its mark in blue ink, but you can change 
that with a quick application of Hue & Saturation. 
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iStampColor
Color separations in a rubber stamp? That’ll be the day. 

Welcome to The Day.

iStampColor is far from realistic and far from photographic, but 

it can please the visual senses, nonetheless. Sometimes.

iStampColor is quite sensitive to tonality settings of the 
original image, but may find use as you search for a 
colorful, high-contrast effect. 
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iTornEdges
Photoshop’s Torn Edges Filter is best applied when used interactively. 

Settings of Image Balance, Smoothness and Contrast are all available 

for manipulation and our version uses 25 (mid range), 15 (maximum) 

and 17 (high mid range) for a default result.

iTornEdges only produces a hi-con image, and does not do well with 

most originals. But for some, it makes striking results. 

i The Action stops to let you adjust the effect to your taste, and 

leaves a labeled snapshot in the History Panel.

i Low settings for Smoothness and 

Contrast produce blurred, grainy 

images. If you find a good use for these 

controls, let us know.

The best use for Photoshop’s Torn Edges Filter that we 
have found is to produce quick high contrast versions 
of subject matter. 



|   137Photoshop Filters Plus    ACTIONS CS5

iWaterPaper / iWaterPaperLite
The name is a bit misleading. It uses Photoshop’s Water Paper Filter, 

but the result is more like a photograph applied to woven cloth where the 

colors have bled into the weave.

iWaterPaper loses detail, but gains in its non-photographic effect, now 

looking like a Madras print that is in mid-bleed.

iWaterPaperLite is a variation that produces the effect that the cloth has 

been washed more times, and the bleed is considerably greater.

i Try adjusting tonalities in your image if first results aren’t to your liking.

 iWaterPaperLite produces a 
washed-into-fabric look. 
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iStylize Series
Drama can come to an image in many ways. Certainly these images 

are dramatic, but nobody will simply assume they are made from 

photographs. And isn’t that the point?

iEmboss / iEmbossColor
We met the embossing idea back in iBasRelief. Here it is, pure and 

simple. iEmboss combines some extra tweaks to Photoshop’s Emboss 

Filter.

iEmbossColor creates the embossing, then adds some color back to 

the image.

iEmboss and iEmbossColor. 



|   139Photoshop Filters Plus    ACTIONS CS5

iExtrudeChalk
Photoshop’s Extrude Filter is fun, and we have all played 

with it. Its greatest use is as a curiosity or occasional 

background generator. 

That changes now. Here is an iNovaFX iExtrudeChalk 

Action that redefines what can be achieved. For one thing, 

it turns the effect into sculpture. Your image is floated in 

black, morphed into slightly round-edged chalk sticks, then 

stacked in an interesting manner. 

i You may need to crop the final image out of the 

final black background that the Action produces.

i Offset the perspective vanishing point. Use Photoshop’s 

Canvas Size tool to generate a canvas much larger than 

the image, so it grows from any place except the center. 

Specify the change as percentage. Any percentage up to 

200% will place the vanishing point within the image. Crop 

after chalk has been grown.

iExtrudeChalk turns photos into stacks of color chalk, or 
wild-color Lego-like sculptures. The top image shows how 
offsetting the vanishing point (Canvas Size menu) can 
steer perspective. 
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iExtrudePlanks
Like a lumberyard stack of boards, 

iExtrudePlanks turns your image into 

a rainbow stack of two by fours.

i Photoshop’s Extrude Filter some-

times casts artifacts when it is used 

with large images. Some of these 

might show up as flat, middle gray 

areas around the perimeter of the 

extruded image. A special iNovaFX 

Utility Action, iXtrudeGrayClean, lets 

you clean these up. Just circle the 

offending gray areas with the Lasso 

Tool (hold shift down to select more 

than one area) and run the Action. 

Usually that does the job.

i Trick: Turn an image negative, 

run the Action, then turn it negative 

again—back to positive. Now dark 

tones are peaks and light tones are 

less deep.

iExtrudePlanks casts your shot as a bunch of colored lumber. 
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iExtrudeSpikes
Instead of blocks or planks, iExtrudeSpikes turns your image into an 

abstract aerial view of San Francisco, in which every building is a color 

version of the Transamerica Tower—a tall slim pyramid.

i It’s especially good with abstract shots and subjects floating on 

dark or solid color backgrounds.

iExtrudeSpikes sculpts on a 
black background.
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iFindEdges
Have you ever felt that you have lost your edge? Now Photoshop’s Find 

Edges Filter may help you out.

iFindEdges comes in five variations. E.g. iFindEdges3, etc. Contrasting 

tonalities are revealed as edge lines. Various combinations of the bright, 

dark and edge + image are available as shown.

Left to right, iFindEdges1 through 
iFindEdges5 plus the original.

1

2

3

4

5
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iGlowingEdgesA / B
More than just finding an edge, the Glowing Edges Filter turns 

contours into lines of light hanging in space.

iGlowingEdgesA and iGlowingEdgesB operate at different 

intensities and line weights. 

i You may have to try both.

iGlowingEdgesA, 
far left and 
iGlowingEdgesB.
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iGlowingWind L / R
A blast of fresh air, iGlowingWind[L/R] blows the 

glowing edge into the next level of photographic 

impressionism.

i The L or R designation tells you from which 

direction the wind is blowing.

i Appropriate for 8MP- 

18MP images, vertical or 

horizontal.

i What happens if you 

twist an image before 

running this? Just asking.

iGlowingWindR, above has the wind blowing 
from the right. The image at right has wind 
from the left. 
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iCraquelureA is light on texture and heavy on stepped embossing. 

iPSTexture Series
Photographers work diligently to preserve sharpness and detail. But 

sometimes those aren’t enough. Sometimes the photographic story 

needs less-precise words. 
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iCraquelureA/B/C
Photoshop’s Craquelure creates a crazed surface that is broken 

into smaller areas by either a tile size or by image contours.

iCraquelureA leaves a multi-layer embossed effect with a hint of 

regular patterns only in large blank areas of the image.

i All of the iCraquelure series are appropriate for images from 

6MP to 12MP.

Amplifying the amount of irregular texture, iCraquelureB leaves 

behind a larger pattern in open areas and a deeper crack structure.

iCraquelureC tears into the image with greater embossing and 

craquelure depth.

iCraquelureC, above, generates the most texture, and 
iCraQuelureB, right, emphasizes subjects that already have 
some surface texture. 
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iMosaicPatchwork [10/20]
Photoshop’s Patchwork Filter was created before digital pho-

tography became 6MP and above. Its largest patch is 10 pixels 

square. When coordinated with the Mosaic Filter, a photographic 

image becomes a dimensional, tiled image. 

What’s in a name? iMosaicPatchwork10 uses the 10 pixel tile 

maximum. But why stop there? iMosaicPatchwork20 expands the 

tiles to 20 pixels square.

iMosaicPatchwork10, above, turns a 10MP image into a tiled 
surface with over 100,000 color tiles. At right, a detail showing 
iMosaicPatchwork20. 
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iStainedGlass
Photoshop’s Stained Glass Filter breaks the image into irregular flat color 

polygons, each surrounded with a border.

iStainedGlass makes the border dimensional. Like heavy grout between 

irregular Roman tiles in a 2000-year old mosaic floor or wall decoration.

i Yeah, it looks more tile-like than glass-like.

i Best when used with large, simple images.

i Subject images may be blurred—it won’t show in the final. Often small 

details can be lifted out of more complex images, then blown up to 2000 x 

3000 pixels or larger before running the Action.

i Since the patterns are quite random, several tries may be required before 

you find a satisfying pattern for your subject.

iStainedGlass. The above is a small detail cropped 
out of a larger photo. Can you tell the subject at left? 
Back up from the computer screen to see it more 
clearly. 
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iStainedGlass++
Often individual stained glass panels are painted, etched and 

given pictorial content. Rarely, the panes are faceted like jewels. 

Let’s do that! iStainedGlass++ brings a little bit of the original 

photograph back into the separate color panes and turns each 

irregular polygon into a custom-shaped convex, faceted piece of 

glass.

i In general, the larger and more graphically obvious the 

subject matter, the better the result.

i Smaller images will produce larger faceted jewels.

Snap from an iPhone, 1600 x 1200.
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iTexturizerBurlap / Canvas / Grit
Burlap is coarse and irregular. Canvas is regular but pronounced, and 

Grit is irregular and bumpy.

iTextureBurlap, iTextureCanvas and iTextureGrit use Photoshop’s 

Texturizer Filter to generate their effects, tuned here for 6MP to 18MP 

images. 
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Covering the lens with glass to produce a desired effect is nearly as old 
as photography. Here are filters that can’t be chipped and won’t take 
fingerprints. But it’s a trade-off. They won’t protect your lens, either.

F ilters protect and serve. But once you have protected your 

lens with a Clear, UV, or Daylight filter, adding another effect 

filter becomes a management chore: Take off the protec-

tor, then add the effector. Total time: way longer than it takes an 

emu to e-move. What if you could have many of those filter effects 

instantly—later?

This section deals with several types of filtration phenomena that can be 

achieved digitally, rather than optically. They can produce results similar 

to—but not exactly the same as—optical, polarizing, or even holographic 

filters.

iFiltersX
As Photoshop has evolved, so have the number of interesting things you 

can do with its features. The halo filter seen here can only be achieved in 

PS CS2 or higher. But until the Action that produced it appeared, its effect 

was not easily available at all, unless you used a very expensive piece 

of glass and committed to the effect during exposure. What follows are 

iNovaFX Actions that take the place of glass—and beyond.

Camera Filter Fantasticks
Glasstronomic Delicacies

Chapter 4

Night images that include spectral highlights can trigger certain effect filters. 
Here is one that produces circular halos around each fixture suggesting dynamic 
movement. This is the iHalo2X Action.
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A Typical 
Day At The

 Lens

Glare from
 a back-li

t sky fill
ed the vie

w-

finder, do
minating t

he scene. 
But it was

 the 

foreground
 that held

 the inter
esting sub

ject 

matter. As
 the photo

grapher sq
uinted, th

e sky 

diminished
, but no p

hotograph 
would hold

 sky and 

foreground
 in the sa

me shot ju
st right. 

Only one 

thing woul
d help. Th

e photogra
pher would

 have to 

darken the
 sky witho

ut darkeni
ng the for

eground. 

Reaching i
nto her ca

mera bag, 
her finger

tips 

found the 
Master Dim

ming Contr
ol. Slowly

 she 

twisted it
, darkenin

g the sun 
and sky wh

ile 

leaving th
e foregrou

nd subject
 in perfec

t light. 

“There,” s
he whisper

ed, peerin
g into the

 view-

finder onc
e again. “

Just what 
I needed.”

 

Bystanders
 hardly no

ticed how 
the photog

rapher 

had altere
d the outp

ut of the 
sun and ac

hieved a 

more pleas
ant image.

 Then agai
n, what di

d they 

know about
 photograp

hy?
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iGrad 
Grad is short for gradual or gradation. Gradation filters are sheets of 

material—glass or polycarbonate, usually—that have a clear area and a 

color area blended together gradually through a soft edge. Photogra-

phers and cinematographers use these to selectively control color and 

density of exposure in one area of the scene. The brownish, smoky 

appearance of the example at left might be used to deepen, and warm, 

the tonalities of a sunset sky while leaving the foreground relatively 

untouched

The iGrad series creates a large, square grad filter over your 

shot. Like the glass versions, it covers more than the full 

image so it can be positioned and twisted to taste. In Photo-

shop, it shows up as a new Layer riding above the image.

i Important: Two utility Actions exist in the iGrad folder to 

prepare images for iGrad Actions. iGradSetupH is the one for 

horizontal shots, iGradSetupV is the one for verticals. One of 

these MUST precede running any iGrad Action.

i Advanced users may realize that the Blending Mode of the 

grad filter will change how it affects the tonalities of the shot. 

The default Blending Mode is Multiply.

iGradA-series Actions appear in the following colors:

NEUTRAL   TEAL   SMOG   AMBER   RED   BLUE   SKY   LAVENDER   ROSE

i The Setup Actions embed your shot in a big square white 

canvas. A grad Layer is applied above the image. It’s a big 

square grad you can slide around, distort, scale or rotate as you 

wish. After you position and accept it, you must crop, flatten and 

resize the image yourself.
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Often, the color of the grad will be selected to augment the 

native color of the sky in the shot. Its density will be dialed back 

to about 20% of the full strength color available in iNovaFX iGrad 

Actions—the ones shown here are adjusted to 20%.

Default density is 30% so you can visualize the blend region 

more clearly as you move it.

Once you Setup the shot for an 

iGrad, the image of the gradation 

filter will superimpose over your 

shot. The filter is much larger than 

the image, and it is in 16-bit color 

space to avoid artifacts.

The Action pauses to let you 

manipulate its geometry and position.

i You will adjust final Opacity and/

or Bending Mode from the resulting 

Snapshot in the History Panel.

i While further transformations of 

the Grad Layer are possible from 

the Snapshot, it is laid down as an 

8-bit image, so artifacts like band-

ing might result if you get too busy.

i The final step sets up a crop, but 

you must adjust it yourself, since 

the chance that it is exactly what 

you wish is zero.
At the top is the original. Below it is iGradANeutral. Clockwise from there are 
Amber, Blue, Lavender, Red, Rose, Sky and Smog. In the center is Teal. All are 
presented here at 20% Opacity.
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iGradB-Contrast produces a different sort of effect. It uses the 

image itself as a color and density source combined with a grad 

effect that is only obvious while you build the image.

Use the standard iGradSetupV or H Action to prepare the image. 

Run iGradB-Contrast and it will pause for you to adjust, scale, rotate 

or transform the grad area to your liking. Then it continues and uses 

that grad figure to deepen the tonalities of the image. 

A Curves Adjustment Layer appears as the top layer. A duplicate 

image layer below it provides the source material for the effect. 

Manipulate it to adjust your image. What it is doing is adding the 

density of the image back onto itself, as if two transparencies were 

laying on top of each other on a light table. But the blend moderates 

the overlay image, controlling its placement while the Photoshop 

Curve controls its intensity. 

i If any original image tonality is available within the dark part of 

the grad, it will end up intensified in the final. Pure white, bleached 

out highlights won’t deepen, but they can be darkened a bit by 

lowering the intensity of the right-most point of the curve.

i Altering the Opacity of the duplicate image layer will also change 

the effect. Try both.

An overexposed sky that still retains some degree of tonality can often 
be brought back to “normal” with the iGradB-Contrast Action. 
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iGrad2Taste
The iGrad2Taste Action adds a two and a half twists. It creates 

the Grad layer, allows you to set the grad’s hue and saturation 

(leave Lightness at +50), so you can control the color and tonality 

appearance of the grad. Further, it superimposes an upper layer 

that lets you selectively re-brighten highlights to achieve the look 

of a glass filter modifying a bright subject. This top layer has an 

extra Curves Adjustment Layer attached to it for highlight control.

The Action drops a 16-bit Snapshot into the History Panel 

for convenience in re-tweaking. But if you like the result as is, 

Continue past the final instruction window to convert to 8-bit, 

flatten and set up a crop.

i Very bright highlights can be brought back to an exposure 

appearance that transcends the attenuation of the grad layer.

i Blending options change the effect of any grad filter layer. 

Try Color Burn or Overlay on the grad layer. 

i It gives you a much wider range of tunable results than 

physical glass filters do.

i The half-twist is that the upper layer’s Curve Adjustment 

can recover dark shadow detail, too. Lifting the lower end of 

the Curve lifts the dark areas, as in this image.

i Crop tip: The crop is set to a 4200 pixel square, 

which coincides with the longest dimension of your 

image. So you need only adjust the side boxes to fit 

your image. Hold down the Alt / Option key as you 

adjust the Crop rectangle by either side box, and 

both sides will adjust symmetrically.

iGrad2Taste 
lets you add a 
color grad and 
re-introduce light 
highlights that will 
punch through 
the grad tones, 
preserving bright 
highlights.
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iFog
Fog filters add fog to the image while trying to create a misty 

overall look. The iNovaFX iFog-series gives you five balanced foggy 

effects, triggering off the lighter tonalities of the image. Some breathe 

on the image, fogging everything. 

i The Snapshot has the Fog Layer separate from the untouched 

image. You may change Opacity, Blending Mode, tint or tonality of this 

layer to suit your photo.

iFog1-5 turns brightness into fog. 
One through four are increasing in 
intensity, spreading farther from the 
light areas. iFog5 is a different sort 
of special fog-like effect. Notice how 
it produces an outer band that hugs 
the contours of light areas. 

Original                           1                                       2                                       3                                       4                                       5
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iDiffuse

Diffusion filters are used to soften fine detail and to glow light areas 

of light and color. Unlike iFog Actions, iDiffuse Actions bring color to 

the blooming tonality. 

Three increasingly strong Actions give you different effects. 

i iDiffuse Snapshots keep the bloom layer separate, so you can 

further change their attributes to suit your image.

iDiffuseHighlights concentrates its energy on the brightest highlights 

only, ratcheting them up to full blast.

i Car headlights all become high beams.

i Only iDiffuse1 presents its bloom layer at 100% Opacity, so the 

others can be driven more intensely, and all may be tuned lower if 

desired.

Each iDiffuse-series Action produces 
different results qualitatively. Note the 
muted effect of #1, the effect of elevating 
bright colors and the striking lift very bright 
tonalities of the Highlights variation. Notice 
how the bright distant city progressively 
fades into the diffusion effect.

 Original                                  1                                              2                                              3                                              Highlights 
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iHalo
Exotic filter materials can cast a circular ring around 

the image of light sources.

Digital manipulations can mimic these exotic filters 

and the iHalo Actions (PS CS2+ only) can render rings 

surrounding any bright spectral highlight. Six varia-

tions of circle size and intensity are provided. iHalo1 

is the smallest. iHalo3 is the largest. iHalo2, 2A, are 

smaller, suitable for smaller files.

i Unlike glass filters, the effect sticks closely to only 

the brightest, highest tonality subject matter such as 

fierce glints and images of light sources.

i Images with large areas of high 

brightness may not work well with 

these.

i iHalo4-color creates a halo that 

is made of concentric colors—a full 

circle rainbow, similar to holographic 

ring filters. The mix of colors depends 

on the color of the triggering highlight.

i iHaloMultiplier is a halo brightener that must be 

run just after the iHalo Action. It will raise the halo 

intensity.

Caveat:��

The iHalo series is computationally intense, using 

the Shape Blur feature of introduced in CS2, so run-

ning these Actions takes a little extra time.

iHalo4-color (top) makes colorful chroma halos around bright 
lights, taking color from the source. iHalo2Large (bottom) shown 
intensified with iHaloMultiplier. 
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iCrosstar: The Series
We’ve built a cross star Action back 

in Chapter 1, but now we can play 

with a bunch of them.

iCrosstar1-5 are at a 45° angle and 

each leaves a multi-layer Snapshot so 

you can further manipulate the cross 

star effect. #1 is small and bright. A 

twinkle. #2 is larger; #3 larger still. 

#4 is long and subtle, but you can 

embolden it with Opacity adjustments. 

#5 has two separate ray layers. Each 

ray can be colored individually.

iCrosstar30 is like iCrosstar4 but at a 

30° angle.

iCrosstar15 is at a 15° angle.

iCrosstarHex shows with six rays.

iCrosstarNeo is more like a cross 

star filter with consolidated rays.

iCrosstarCarnet runs all of them on 

one image, leaving a series of labeled 

Snapshots in the History Panel. 

(Carnet is French for a book of tick-

ets. Or in this case a book of History 

Snapshots you can flip through to 

find the cross star effect you like.)

ICrosstar1

ICrosstar15

ICrosstar2

ICrosstarHex

ICrosstar3

ICrosstarNeo

ICrosstar4

Original
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iScratchStar
A more fantastic version of the cross star 

effect is the “scratch filter” which imitates a 

physical filter that’s literally a piece of trans-

parent material, which has been scratched 

in a relatively random way producing a 

disorganized, but very interesting multi-

point star. 

The iScratchStar series gives you several 

variations of this technique. Each is its own 

random pattern.

iScratchStar1 produces a strong diffusion 

star effect. iScratchStar2 resolves high-

lights as finer streaks with greater internal 

detail. It can turn landscapes into fantasy 

wonderlands.

iScratchStar3 produces a scattering 

of delicate stars plus a few random 

twinkles that populate darker toned areas like electronic fireflies.

i All arrive on the History Panel as two-layer labeled Snapshots. Each 

has an additional Curves Adjustment Layer connected to the effect 

layer (labeled FX). Opacity tweaks to the effect layer are also possible.

i An iScratchStarCarnet utility runs all three of them with one 

button press, leaving three Snapshots in its wake.

i The iScratchStars take time (the Carnet can take over 3 minutes for 

a 12MP image), but are worth the wait.

iScratchStar1 (above) is 
a more exotic cross star 
effect. Below, the original.
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iPolarizeSky
While polarizing filters perform magic at the photon 

level, they’re used by photographers mainly for deepen-

ing the tonality of blue sky. 

Why? As it turns out, at 90° away from the sun, the sky is 

extremely polarized. Two crossed polarizers cancel light. 

With a polarizing filter on the lens, the polarized area of 

the sky can be crossed out by twisting the polarizer to the 

right cancelation angle.

But try that on the sky near or far away from the sun 

and polarization doesn’t work well.

iPolarizeSky Actions give you a new set of sky-darkening 

effects that do the same job, but in a different way, and are not 

locked to the polarized portion of the sky.

What is sky blue? Technically, it’s a color between the deepest pos-

sible blue (240°) and cyan (180°). Most often it shows up as a digital 

hue of 210°–220° on a standard color wheel. (Red=0°)

iPolarizeSky Actions mainly target this band of hues, separate it out 

and deepen it. 15 variations are provided because skies are so variable. 

iPolarizeSky1-5 are in increasing strength. Some encourage you to 

select the sky color to work on. iPolafNeoA&B involve your choice and 

iPolaNeoC sets up the image for simple blue adjustment with a Hue/

Saturation Adjustment layer you must tweak. iPolar2Taste-series (six 

Actions) give you a mix of controls to be applied along the way. The 

iPolarPale-series are for pale blue skies.

i The reason there are so many variations is to cover the widest range 

of different sky hues and saturations.

On top is iPolarPale2. The bird 
was made with iPolar5. 
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iIRbw: Faux Infrared Filters
Three iIRbw-series Actions turn your well-exposed color image into a 

false infrared black and white image. No, it’s not a true infrared inter-

pretation—we leave that to the physics of light as perceived through a 

real infrared filter—it simulates much of the look of infrared photos.

i Most DSLR image chips have a residual sensitivity to infrared which 

can be exploited with various IR filters and long exposures. Typical 

ISO performance is in the ISO 1 to ISO 50 range, requiring looong 

exposures and tripods for stability.

The iNovaFX iIRbw-series lighten bright and middle greens, darken 

blue skies and give you an Adjustment Layer to fine-tune the resulting 

monochrome image.

i A Carnet version, iIRCarnet, runs all three filters on your original 

image, leaving labeled, multi-layer Snapshots in the History Panel for 

your fine tuning.

Topmost is iIR3, the stand of trees is 
interpreted with iIR2 and the reach at 
left is with iIR1. 
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iShatter: The Broken Image
Somebody dropped the image and broke the glass over the 

picture. Or so it seems. The iShatter Actions aren’t emulations of 

camera filters, but they simulate an effect of glass over your image.

iShatter-series Actions break the image and highlight the cracks along 

the breaks. Three different patterns are available. 

iShatterA looks like the image took a hit in the upper right 

corner and all the shards radiate roughly from there. iShatterB 

was obviously smashed with a blunt object within the image. 

iShatterC has roughly equal vertical shards, as if it were sat on.

During operation the iShatter Action draws a fresh pattern, finds the 

cracks and inserts the most recently opened desktop image between 

these two linked layers. You than have the opportunity to re-size and 

re-shape the pattern and lines together.

i IMPORTANT: When you resize/reshape the Shatter Pattern, 

hold down the Alt key (Windows) / Option key (Mac) to constrain 

the Pattern around its center. If you don’t, the next steps will likely be 

messy. Size the Pattern to be just a tad larger than the image.

After the image forms, you will be presented with an interactive 

Crop Frame. Use that to trim your shot. A snapshot will appear in the 

History Panel.

i After the iShatter Action is finished, you can alter the upper 

Lines layer by Opacity. You can alter its drop shadow, too. The 

second layer down is the shattered image without lines. 

i Below that, a Default version called Image+Lines 24% exists as 

a single layer. Its lines were applied at 24% Opacity. You must turn 

off the top two layers, Lines and Image, to see it.

iShatterA seems to have been dropped on 
its upper right corner. 
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iShatter++ Utility
One last effect is available for any of the iShatter Actions.

Once the image Snapshot appears, you can apply the iShatter++ 

Action and tweak the appearance of the shatter lines in the glass. It 

tears up the reflections within the breaks and hopefully produces a 

more realistic effect.

Notes:

While you resize/reshape the Shatter Pattern with Alt or Option held 

down, you can drag side or corner control points around in several ways.

Any side control point can be dragged to the other side of the image, 

thus reversing or flipping the shatter direction. 

Corner control points will let you drag the Pattern to any corner, trans-

forming the whole pattern symmetrically.

iShatterB has been punched in its face, 
seen here in the iShatter++ version.

Can you break a 50? 
Now you can with 
iShatterC, seen here 
with its Lines layer 
doubled up manually 
(duplicate the Lines 
layer) while being 
converted to Blending 
Mode: Screen.
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iBaby
A clever series of optics are available under the Lensbabies brand. 

They’re flexible lenses for your DSLR that can be fingered into focus, 

twisted away from the optical axis and manipulated to yield smears, 

blurs and areas of focus that have a view-camera-gone-wild character. 

Much of what these specialty lenses accomplish can be achieved with 

the iBaby Actions. And you don’t commit to the effect as you snap the 

shutter —you can do a shot over with a better-refined effect.

i iBaby Actions will work with any existing image from any focal length 

lens—even fisheye.

i Separate versions marked H and V are for horizontal or vertical images.

As iBaby1(H/V) progresses, it stops so you can size, 

angle and shape a large soft area over the image. 

Whatever is behind this blob will stay in focus—so hide 

the area you wish to keep. That graphic is only a guide. 

It disappears and the effect completes. You will adjust 

the crop manually.

iBaby2Taste(H/V) gives you more control over focus 

center, radial blur center and general blur strength. 

i Practice brings experience. 

By the time you do your tenth 

image, you will be an expert.

iBaby1H was used for the pool and fisheye 
shots, while iBaby2TasteV was used on the 
Phil X solo image.

http://www.lensbabies.com/
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iToy

What makes a photo of a small model look so small? One giant 

factor is the narrow depth of field cutting through the image. When 

backgrounds and foregrounds are blurred while the main subject is 

in focus, the scene looks miniature.

iToy2Taste lets you position a band of sharpness across an image. 

Then it allows you to decide how much blur to add outside that slash 

of sharp focus.

i iToy2Taste(H/V) works best with images shot from above—using 

a horizontal band of sharp focus—or with a large wall in perspective, 

using a vertical band of sharpness. Arrange the focus band to isolate 

subjects and their adjacent areas of equal distance from the camera.

The more ambitious iToyPaintOut and iToyPaintFocus Actions 

stop to let you literally paint the area to be kept in or out of focus. 

Both depend on your retouching skills, but they produce the most 

convincing miniature scenes by selectively isolating subjects.

i Areas you paint on the mask with white stay in focus. 

Those are not sculpted miniature strollers and that’s not a 
toy truck. iToy2TasteV blurred the pier and foreground while 
iToyPaintFocus allowed sharpening the truck, the RR sign and 
grass at the focus distance. 
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iFocusMeCS5
For fast object isolation effects, the iFocusMeCS5 trio of 

Actions give you the opportunity to paint focus back into a 

de-focused image. These are similar to iToy in results but use 

a different method.

iFocusMe 1 through 3 blur the image strongly, strongerly® 

and strongestly® in that order. Then each hands you an Eraser 

brush 300 pixels large, with which you paint over the subject 

matter that you wish to keep in focus. But you don’t have 

to stick with a 300 pixel brush—change it to anything else 

you wish to use. You can adjust brush size and hardness to 

whatever the picture calls for. This shot seems to be selling 

hardware and was achieved with the default brush.

As soon as the Action runs, it creates a new Snapshot in the 

History Panel, so if you make a mistake, starting over is a 

breeze or a snap, whichever comes first.

i If you make a few touches that don’t do what you intended, 

you can back up in the History Panel and perhaps find a previ-

ous step that keeps all your work right up to the mistake.

i You must have the set, Basic Brushes, available to your 

Eraser tool for this to work.

Focusing attention. This is the effect from 
iFocusInteractive2 applied to a 12 megapixel 
image. If you study it large, you see that it 
presents focused areas selectively, something 
no lens can achieve this way. By reducing the 
Eraser brush, you can paint away fine detail 
against blurred areas you wish to retain. 
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With basic retouching skills, you can turn 

prosaic images into poetic stories, simply by 

isolating the focus area from the whole shot.

These two images were nothing special 

before touching them with iFocusInteractive3.

i If you run one of the Actions but feel that 

the level of blur is not enough, you can cause 

a quick doubling of the focus by pressing Ctrl 

+ F (Windows) or Command + F (Mac).

i To create the effect of a much longer 

lens on the bride shot, the brush was nar-

rowed as small as 20 pixels in diameter. 

Notice that the plane of the bride and 

groom was revealed in the sand to create 

the feeling of narrow depth of field. The 

lens was only 200mm at f/8 but it feels like 

1000mm at f/2.

i Change the strength of the Eraser to a 

lower figure than its default 50% to partially 

erase the blur layer. 

i Raise the size of the soft Eraser’s brush 

to paint out broader areas. The aerial shot at 

left used a 1000 pixel brush to turn the shot 

into a model city.

i Practice.
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iVignette
Physics causes lenses to distribute photons more plentifully 

in the center of the image, and less into the corners. Corner 

darkening = vignetting. 

You see it all the time without noticing the effect, but three 

of the shots on pages 166 and 167 demonstrate the phenom-

enon at long, medium and short (wide angle) focal lengths. 

Can you see them?*

i Check the darkened corners on the originals.

It can be a problem, but it can be a subtle way of directing 

the compositional focus of the image. The iVignette-series helps 

to guide your viewer’s eye into the part of the image you wish to 

call attention to.

iVignetteNeo lets you force a vignetting mask onto your shot. You 

get to Transform the position, height, width and angle of the effect.

iVignetteNeo2x is a quick corner-darkening effect that subtracts 

exposure from the corners of the image, making only mid and 

shadow tonalities go darker. Bright highlights stay bright.

iVignetteNeo3x combines the two ideas and lets 

you shape the vignette area while darkening by 

underexposure.

iDarkCorners2TasteA lets you darken—or lighten—the 

natural vignetting that many lenses produce.

Sometimes a vignette effect is obvious, as with 
the image on top (iVignetteNeo). But you might 
miss completely that a vignette effect has been 
applied to the bottom photo (IVignetteNeo3x). 

* The iToy truck (slight), the iToy pier (moderate) and the iBaby pool (considerable).

To adjust a vignette 
pattern, shrink the image 
on your monitor, but resize 
the window a bit larger, 
so you can work the 
Transformations into areas 
outside the canvas.
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Like any complex technology, digital image errors can crop up from 
numerous sources. Film had its own special set of errors, but not much 
could be done with them in that world. Now we can fix more things 
than we can shake a digital stick at.

ho among us has never made a big whopping 

image error—show of hands? I didn’t think so. 

When we shoot fast, shoot under pressure, 

shoot after a few days without that camera in our hands, our 

humanity sets in, and there can be only one outcome for that: we 

forget to (fill in the blank), so we shoot a less than stellar picture. 

Sometimes it can’t be helped: 

•The zoom lens has barrel distortion at wide angle, and only a 

few cameras have settings to fix it. Yours doesn’t.

•You’re shooting at 20,000 feet and no camera adjustment will 

see the ground the way your eye sees it. The camera sees haze. 

•You walk outdoors and leave the white balance back in the 

living room/studio/office, sunlight turns out cyan-blue images 

instead of the colors our eyes were certain they witnessed. 

If only we could fill in those blanks, later. 

With the right repair Action, the correction is often just a mouse 

click away.

Corrective Measures
Fixing images on the fly

Chapter 5

W
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GEOMETRY REPAIRS
Typical zoom lenses have 7 to 24 elements. The ability to twist a ring 

and cover all the focal lengths from widest to most telephoto is such a 

useful quality that attributes like image distortion take a bit of a back 

seat. Current DSLR lens designs have as much as 14:1 zoom ratios, 

making these a good choice for photographers on the go who don’t 

want to swap lenses frequently. Wide range requires many elements to 

keep focus and aberrations under control. Zoom range. Image quality. 

Number of elements. Cost. 

It’s a juggle out there.

When the image comes back distorted, due to an intrinsic compro-

mise in lens design, it’s time to hug your computer. Barrel distor-

tion and its complement, pincushion distortion, are things you can 

correct with Photoshop. Look for the Filters > Distort > Lens Correction tool 

in PS CS2 through CS5. It does a pretty good job of flattening barrel 

and pincushion distortion.

If you are using an earlier version of Photoshop, then the Lens 

Correction tool is not available, but the iNovaFX iBC Actions 

may help.

i As noted earlier, you can adjust barrel and pincushion distortion 

yourself in a few steps, but doing these numerous steps for every 

image you wish to fix is an activity that gets old, fast.

i As with the CA filters, Photoshop is your best tool when you are 

working quickly. When you wish to achieve exacting results, you 

may find the iNovaFX Actions more precise.
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Most DSLRs use an image chip that is smaller than a full frame of 

35mm film. A film format called APS-C made images approximately 

the size of movie frames, and many DSLR image chips are referred 

to as being “APS-C size,” but it’s only a rough scale reference.

At their largest, 35mm movie frames are 3:4 aspect and half the 

size of 35mm still frames. In DSLR photography, this means that all 

the image qualities you see in a theatrical movie can be achieved by 

your DSLR. Depth of field and angle of view per mm, especially.

Nikon calls their small DSLR sensors, DX format and their full 

frame format is called FX format. DX sensors have about 367 mm2 

of surface area. 35mm full frames (36 x 24 mm) have 864.

Canon refers to their smaller DSLR sensors as APS-C Size with an 

area of about 330 mm2. Full frame DSLRs are simply referred to as 

being Full-Frame.

Cameras with 4/3 (four thirds) format imagers contain a chip 

in 4:3 aspect with a 17.3 x 13 mm sensor covering a 225 mm2 

area. Close enough to APS-C or movie frames to share almost the 

same DOF and optical behavior characteristics.

All of the zoom lenses we have seen for any of these formats 

exhibit some degree of barrel or pincushion distortion. Barrel 

distortion appears at wide angle, and pincushion effects show 

at the longest focal lengths. Some lenses show nearly zero 

distortion at one extreme or the other, and most that show 

distortion have a middle zoom setting that is distortion-free.

i Once you find it, you could use this setting for distortion-free 

copying.
35mm movie frame (Super 35 at 24.8 x 18.7mm). 
Images are to scale.
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iBCGeneral

Here is a series of 20 graded barrel / pincushion distortion Actions 

that work well with most zoom lens images. The trick is in picking the 

right one for your lens at any given focal length. Since focal lengths of 

zoom lenses is completely variable, results will be variable, too.

i Picking the right iBCGeneral Action may take some trial-and-error.

i Correction is well suited for straightening images for panoramic 

stitching, but a Batch version (two pages later) facilitates that 

better.

Images are converted to a standard size, surrounded by a larger 

working canvas, distorted with Photoshop’s Pinch tool, then turned 

over to you for cropping and saving.

The series is designed for horizontal images. iTwistCW90 and 

iTwistCCW90 utilities facilitate Clock Wise and Counter Clock Wise 

rotations easy.

i You can detect barrel and pincushion distortion on straight-line 

subjects with an overlay grid applied to your image. Windows: 

Control + ’ (the apostrophe key) / Mac with Command + ’. This is 

most helpful with subjects shot straight-on.

iBCGeneral Actions are numbered, with larger numbers produc-

ing the greatest counter-distortion. iBCbarrel# and iBCpincush# 

versions are for barrel distortion and pincushion distortion, 

respectively. They also are quite symmetrical. Running iBCbarrel7 

followed by iBCpincush3 delivers a result similar to iBCbarrel4.

i In any geometric operation, some fine texture loss is inevitable. 

But since we enlarged the shot before correction, detail loss is 

microscopic when the image is returned to its original size!

At tele focal lengths, pincushion distortion is the usual 
effect. Part of the horizontal bar’s bend has to do with 
gravity and frequent stress by athletic users, but iBC 
Actions can deal with those, too. 

Barrel distortion images may be fixed, too. The top line of steel and yellow markings 
along the bottom of the image give away how much barrel distortion is present
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iBCcornerA / B / C / D
Once the barrel distortion Actions run, 98% of the distortion is 

gone. The remaining 2% might show up in ultra-critical shots in the 

extreme corners of the image—but only from certain lenses. Not all 

zoom lenses produce continuous curve barrel distortion. The crop at 

left is the top right quarter of a shot made with a lens that exhibits 

Moustache barrel distortion that looks like a very shallow M. 

This sort of distortion is barrel in the center and ever so slightly 

pincushion in the extreme corners, and only shows up in certain 

lens designs at the widest settings.

In our example, the left edge of the crop is the center line of the 

original image. Notice how the barrel distortion curves downward, 

then turns up in the extreme upper right corner. This effect is in all 

of the original frame’s corners, so we ran the iBCcornerC Action on 

the image after running the iBCbarrel8 Action to correct the barrel 

distortion that covers most of the shot. 

The lower image is the corrected result.

i How much is this degree of correction needed? Only straight 

line subject matter (architecture, product shots, graphic copy work) 

may demand it. This degree of tweak is often not noticeable, but 

may be needed for architectural shots or images with the horizon 

near the edge.

i The Moustache-correcting Actions are not always needed. iBC-

cornerA is weakest—iBCcornerD; strongest.This is a crop that shows only the upper right 
quadrant of a larger image. The left edge and bottom 
are the original image’s center lines. See text.
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iBC Multi Horizontal / iBC Multi Vertical
Preparing a bunch of images for a precision panoramic image can be a chore. It might 

seem reasonable for three shots, but for 16 it is a pain personified. So we turned the 

process into a batch operation. 

Here we see two separate folders, iBCMulti Horizontals and iBCMulti Verticals, each 

delivering the same de-barrel or de-pincushion correction to multiple shots all at once. 

Resulting images are left open in Photoshop for instant application of File > Automation > 
Photomerge or our iPSPhotomerge > iPanoramic Action to stitch them together as panoramics 

or as giant, multi-segment photos captured with generous overlaps.

Giant Caveat:

You MUST copy your original images into a new folder before loading them into Photoshop 

for these batch processes. Why? During processing, each image is corrected, then is saved 

over itself, because Photomerge needs to see any altered image as freshly saved. By 

saving over a duplicate, the originals aren’t harmed.

i You do not want to save this working copy over the camera original image, so copying it into a 

new folder before loading it into Photoshop prevents any corruption of the original image.

i Batch corrections usually lead to Photomerge. Photomerge insists that shots be Saved 

before it will consider stitching them together.

i You must have iBC-Batch in your Actions Panel for these to work.

i Check out the iTelePanoBlend Action and support files in ActionsCS5Extras > PanoPractice > (2 sets) 
folder. These will let you open two different sets of 3-pane panoramics for experience.

Nine shots taken from the Tower Bridge in 
London on a dreary day have become an 
interesting panoramic nearly 18,000 pixels wide 
with Photoshop’s refined Photomerge tool. 
The original was captured hand-held. All nine 
horizontal shots were corrected for a bit of barrel 
distortion with an iBCMulti Horizontals Action 
before Photomerge tied them together. Another 
iNovaFX Action, iPanoCylinderEdge9 refined the 
rough edge that Photomerge usually leaves on 
images like this. 
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Detail of default Photomerge Cylindrical edge. Straight 
edges are just as rough. iPMCylinderEdge3 created the 
smooth version.

iPanoCylinderEdge
Photoshop CS5’s pan-

oramic utility, File > Automate > 
Photomerge is miles ahead of 

prior versions of Photomerge 

that have been included with 

Photoshop as far back as V6. 

Photomerge CS5 stitches 

images together along a hard 

transition line, not a blend, 

as in some past versions. 

The line’s path attempts to 

avoid conflicts of tonality crossing between images. It’s a path of greatest 

coexistence, and it allows hand-held panoramics with high-accuracy results.

i If you were to use a nodal-point camera mount—one that pivots the 

camera around the lens’s parallax-neutral point—Photomerge would have 

no trouble delivering perfect results. 

Cylindrical panoramics bend each image backwards like a sheet of paper 

squeezed from the sides (in horizontal panels). The image at the top of 

the previous page is a good example.

UN-fortunately, when Photomerge does this, the curved edges become 

quite steppy. Extremely jagged. The shape follows the cylindrical curve 

roughly, but the stair-step edges are very unfortunate. Until now, your 

only remedy was to crop the edges out of the final stitched assembly.

A set of iPMCylinderEdge# Actions can fix this ragged edge. They’re 

numbered from 3 to 10 and two more for 15 and 16 panels.

Photomerge hard at work. The hand-held panoramic is 
made of three 10MP images and is over 8000 pixels wide. 
This example shows its optional drop shadow.

http://gregwired.com/pano/Pano.htm


  178 | CHAPTER 5       ACTIONS CS5

Ultra wide-angle lenses deliver stunning, bulging, curved 

panoramic images through Photomerge’s Cylindrical 

option. 

While most photographers will use Photomerge and the 

iNovaFX edge cleanup Actions for panoramic images, 

there is another application for these two technologies 

in combination: Giant— humongous, even—super 

megapixel photos.

If you shoot image segments in a tic tac toe board 

pattern, offsetting each segment with about a 33% to 50% 

overlap, you can use Photomerge to assemble a 45+ megapixel 

image shot with a 12 megapixel camera. Use iPMCylinderEdge9 to clean up the 

edges and the dynamic image will gather oo’s and aah’s.

Now the reason for the iPMCylinderEdge15/16 can be revealed. They’re to clean up 

the edge of a 15 or 16 segment giant image. iPMCylinderEdge15 is for a 5x3 panel 

giant wide-aspect image, and iPMCylinderEdge16 is for a 4x4 (or 8x2) array assembly.

i Note that when 3x3, 5x3 or 4x4 panel giant images are generated, the edge-

cleaning iNovaFX Actions halt with error messages because they have run out of 

edges to clean. Simply move past them with the Enter key to achieve the final.

i When running an array, if you get an error message, simply hit the OK option, 

and the error will become a non-issue. It happens only when interior panels don’t 

need their edges processed.

Extra detailed examples of 9-panel giant images are presented 
large on the next two pages. With edges cleaned up and worthy of 

presentation, wide-angle panoramics like the 
down-angle example from the Getty Museum, 
above, and the up-angle shot from the Paris 
Metro, right, can now be displayed in full.
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The swoopy Walt Disney Concert Hall in Los Angeles was captured in nine shots on a Nikon D200 with a 50mm Micro Nikkor lens 
with each exposure 1/320 sec @ f/5.6. The final image may be cropped to over 8100 x 5500 pixels large, equivalent to about 45 
megapixels. Here Photoshop CS5’s Photomerge feature has scaled, warped, adjusted, bent and perfected the 3 x 3 panoramic. Our 
iPMCylinderEdge9 Action cleaned up the steppy outer edge, making the image self-framing.
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Nine exposures, 
one image. The 
final file can be 
cropped to over 
10,000 pixels 
wide
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Perspective
Geometry repair extends into other areas. View cameras allow perspective 

control by offsetting lenses, and a few perspective control lenses exist that 

may be fitted to DSLRs, but the smaller sensors in most DSLRs limit the 

usefulness of those optics. 

Photoshop has addressed perspective distortion with a feature in Filters > 
(Distort) > Lens Corrections tool, called Transform Vertical or Horizontal Perspective. 
We are guessing that their software engineers are not view camera 

photographers, since their Perspective Transformation control simply 

spins the image out of its current image plane rather than twisting the 

undesirable perspective back into a corrected display. Which is what view 

cameras and perspective control lenses accomplish.

Learning how to achieve good perspective control with a digital image is 

not as simple as Photoshop’s Lens Correction tool would have you believe.

The tutorial here—based on iNovaFX Actions—will get you started with 

superior perspective control for your images.

If you were to see this fantasy paddle wheel ship sculpture in a 
magazine or brochure, you probably would not notice that it had been 
heavily corrected for perspective distortion. The bottom image shows 
what the camera recorded. Several adjustments are required to retain 
the look of certain types of subject matter. Square features and true 
circles are the first to give away a poorly scaled result. Notice that the 
circular horn bell just above the paddle wheel is accurately round in 
both the original and perspective corrected versions.
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iPerspectiveTutor
iPerspectiveTutor works with a specific image to demonstrate 

the process of changing perspective in an image. In this case, an 

upward angle shot within the Getty Museum in Los Angeles. Open 

the image file inside the Images-Demos > Bonus Files > PracticeDe-

moImages > Perspective Tutor  > GettyInterior.jpg location.

When you look up at a billboard or building, you perceive what 

you are seeing as a flat, vertical, rectilinear surface, not as a visual 

wedge that has a vanishing point above you. The camera, not being 

quite so clever, sees only what’s optical reality: a wedge.

Photoshop’s Transform tool (Edit > Transform > [Option]. Shortcut: 

Control + T / Command + T) has several modes. One is called Skew 

and it lets you turn the image rectangle into a parallelogram. For 

some images, it’s a good choice to bring central verticals into a 

straight up stance.

Next, the Perspective option will let you spread the narrow end 

of the image so all the vertical lines look more vertical. But there’s 

more to it than that. Spreading the top causes a vertical squeeze, 

compacting the image downward. Another option, Scale, allows 

you to stretch the image vertically until people, objects, and espe-

cially circular features look right.

i Major tip: Leave a small amount of perspective in the image. It 

makes the result look more believable.

i If needed, run the appropriate iBC Action, first, to straighten 

any barrel distortion.

i It’s a good idea to enlarge the canvas vertically before starting 

to correct perspective. Otherwise, Scale will pull part of the image 

off the top or bottom of the frame.

First, a bit of Skew may 
be needed to make 
central vertical features 
perpendicular.

Next, Perspective 
widens the top of 
the shot.

Scale is needed to 
stretch the image 
into a plausible 
vertical proportion.
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Once you have played around with the iPerspectiveTutor 

Action, you should attempt corrections to your own images.

Notes:

i Circles (clocks, arches, wheels) facing the camera directly 

are often a good guide to Scaling operations. Stretch the 

image just enough to return the image of the circle to 

normal. Next to that, the proportions of people in the image 

may guide you. If none of these are present; guess.

i It’s not uncommon to adjust the Perspective option too 

much before Scaling the shot. Go back and forth between 

these two operations to achieve greater perfection.

i Shrink the Photoshop window and drag it open to see a 

work area much larger than the image. Transformations will 

need the extra room.

Wide zoom settings exaggerate images shot 
at up or down angles. Fixing a shot like this 
requires coordinating Skew, Perspective and 
Scale Transformations. The inset shows what an 
intermediate step looked like on the computer. 
Notice how extreme the Scale was stretched to 
keep people and circular features in the correct 
aspect ratio.

Note that the final image is not FULLY corrected. 
Some amount of convergence still remains. This 
is not an error, although the shot could easily 
have been tweaked to absolute parallelism. 
Human perception is often better served by 
retaining some small residual convergence.
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iCC-series or Color Wrong > Color Right 
When all-gold and or all-cyan images look hopeless, because the 

camera was set for the wrong white balance, they usually are sal-

vageable with the right series of Photoshop steps.

In the iCCMetrics and iCCMisc folders, the iCC Actions have names 

that tell you what went wrong. iCCIncanWBshotDay means Incandes-

cent White Balance was set on the camera, but the image was shot in 

Daylight and looks —ugh— blue.

i The name first identifies the camera WB setting, then the actual 

lighting experienced during exposure.

Putting the image through this Action is like putting an 85b (gold) 

filter on a camera loaded with indoor film, then shooting outdoors. 

Except here, you get to put the filter on after the shot was made and 

no filtering has reduced the available light.

i These Actions aren’t perfect, but they’re way ahead of looking 

like total mistakes. 

i The reason there are so many of them is that each balance of 

shadow/mid tones/highlights may look better when using a different 

treatment. Try several. Your particular model of camera, exposure 

conditions and current lighting conditions may respond better to 

certain ones and not others. 

i If your shot has a neutral gray object in it, you can often fix much 

of the color with the Neutrality eyedropper in Photoshop Levels or 

Curves by simply clicking on the target gray object.

i Overexposed outdoor scenes shot with Incandescent WB are the 

worst. Normal or slightly dark shots are more fixable.
Top: Outdoor image shot with Incandescent WB. Bottom: Incandescent lighting 
shot with Daylight WB. The repaired versions (large) compare quite well with 
correct WB exposures made at the same time (smaller insets). Medium scale inset 
images are the originals with wrong white balances.
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iSodium1-6
Sodium area lighting is a problem for photography. Sodium 

vapor lamps produce the gold street lighting that floods many 

urban areas at night, and matches no known standard WB. 

Worse: They each have unique color qualities. &%$#@!! Not all 

night area lighting can be improved with these Actions, but we 

include them here, just in case they may do you some good.

i Take some test shots with Tungsten (incandescent) white 

balance settings, just to see if any of the iSodium-series 

Actions deliver a better looking image.

iSodium2Taste may do more good. It’s an interactive Action that 

helps you steer the color correction by eye through nondestruc-

tive Adjustment Layers to achieve a more custom result.

iCoolerWarmer
Sometimes it’s just handy to have a quick shot of warmth or 

coolth* added to a picture. iCFWarmer adds just a hint of golden 

warming to your shot, while iCFCooler tweaks the image a tad on 

the blue side.

i They’re symmetrical. You might add six iCFWarmer’s and four 

iCFCooler’s to a picture to get the right effect. Using the History 

Panel, you could start over and add just two iCFWarmer’s to achieve 

the same result.

* Coolth is the natural antithesis of warmth.

iSodium2
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iAerialShotCorrection
Images shot from an airplane often 

have as much sky between camera 

and scenery as we see in the canopy 

of sky from the ground, hence all 

that extra blue. These two Actions 

recover a much more normal view 

of the ground. Since the contents of 

the atmosphere change from hour 

to hour, you must decide how much 

correction to keep or discard. So 

they’re tunable.

i Use the Opacity slider on the upper layer to dial-in the amount 

of correction needed or alter the Adjustment layer’s Curve to taste.

i It is often best to leave in some of the sky effect—a bit of its 

haziness—to create the suggestion of a high or distant aerial 

viewpoint.

iAerial2Taste is best for very high points of view, such as from 

an airliner. iAerial2TasteLow is appropriate for shots made with 

milder haze from private planes or helicopters (under 10,000 ft. / 

3,000 m).

If needed, a utility Action called iPrimaryBoosts may help recover 

saturated red, green or blue hues in the final image.

Original

Top: Horizontal haze 
fogs this helicopter view 
of Avalon, CA. At right, 
a 25,000 ft. view of the 
California desert required 
heavier adjustment. 
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iDeJPEG
Every camera shoots smaller pixel-count images and/or more 

compressed settings for JPEG. If you shoot the smallest format with 

the greatest amount of compression, your images will  be—in many 

cameras—25% of the largest frame’s physical size (pixel count) and 

about 30% of the least compressed image’s data density. So instead of 

a 4300 x 2850, 12MP JPEG image that eats as much as 9.5MB, you 

store a 2150 x 1425 3MP image that consumes around 650KB, 

or roughly 7% of the best large image. It’s big enough for an 8 x 

10 print and your memory card will store thousands of them. But 

there’s a catch.

The smaller image will likely show obvious JPEG artifacts. 

Crumbles of grainy stuff can be seen near contrasty contours of 

detail. It’s called spiderwebbing by some, schmutz by others. A 

quick application of iDeJPEG reduces it while reducing image detail 

by small amount.

i As camera pixel density has grown to 12MP and beyond, the 

surface area of phenomena like compression artifacting has 

steadily diminished. Artifacts that are visible at 6MP may be below 

the visible threshold on a 12MP image printed to the same size.

i JPEG artifacts are an organized form of digital noise. While its 

character isn’t random, its appearance is. But what if the noise you 

see in an image were more random? Turn the page.

The arrows point to visible areas of JPEG 
compression artifacts in this extreme blow-up. At 
right, the iDeJPEG result. Most of the JPEG artifacts 
are gone, but detail remains strong. 
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iDeNoise-series
High ISO usually brings the appearance of random 

digital noise—very much like the grain effects in 

high ISO film. Every upward boost in ISO brings its 

own increment of noise. To diminish this phenom-

enon, care must be taken to preserve detail and 

subject matter contours while smoothing out the 

tonality of pixels in broad areas. 

i Grain tends to show up strongest in dark areas 

of the image.

iNRNeoA/B/C reduce noise in progressively 

stronger degrees. iCNRNeoD reduces color noise 

but retains more texture and detail.

Bright areas often appear noise-free, but the 
mid to dark tones are gritty. Above left, the 
noisy original. Above, iNRNeoC aggressively 
reduces color noise and grain while preserving 
detail well. 

Far left, color noise is in the shadows, but 
more texture and contour detail remain when 
the image is processed with iCNRNeoD. ISO 
6400 image with a Nikon D300.
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iShadowLift-series
These Actions provide repeatable quanta of shadow lift while leav-

ing highlight areas unscathed. 

iShadowLift1-5-series bring dark shadow areas up to greater 

brightness without affecting highlights. Since lifting shadows 

lowers contrast, starting with iShadowLift2, local contrast is pro-

gressively boosted. Each creates its own named Snapshot, so you 

can perform a number of these Actions in series from the same 

original and take your pick.

iShadowLiftNeo places a Curves Adjustment Layer over the 

upper image layer with a default curve that lifts only shadow to 

mid tonalities. You can adjust the Curves Layer or Opacity to fine 

tune the result.

iShadowLift2Taste gives you shadow control with the Opacity 

control of the upper layer.

i Photoshop CS to CS5 all have a tool to lift shadows without 

touching highlights unless you wish to. Look for Images > Adjustments 
> Shadow/Highlight + Show More Options > (make up to 10 slider and/or numeri-
cal adjustments) . Overchoice? It could be if you are working quickly 

through a stack of images.

Sometimes you have to expose for highlights and lift 
the shadows later. Here the iShadowLiftNeo Action 
has brought up shadow detail considerably without 
affecting the marquee. 
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iSODSLR 
In exposure, ISO stands for relative sensitivity to 

light. It’s a number derived by the International 

Standards Organization. An ISO 100 exposure in a 

digital camera should nominally be f/2 at 1 second 

in 1 foot candle of light. Full noon daylight is 

about 10,000 foot candles, yielding an exposure at 

ISO 100 of f/16 at 1/100th sec or 13 stops lower. 

i Light angle and ambient reflection play a 

major role in rule-of-thumb exposures like these.

Underexposures pack all their photons into the 

darker portion of a normal exposure’s tonal space. 

Getting the proper exposure back is an exercise in 

stretching the dynamic range of the image.

Sometimes you have to underexpose. You’ve run 

out of options like shutter speed or f-stop. When 

you must; you must. So here are Actions that push ISO sensitivity up +1 and +2 stops.

iSOLift+1 turns ISO 100 into ISO 200, or 1600 into 3200.

iSOLift+2 pumps ISO 400 into ISO 1600 or 6400 into 24800. 

Other Actions are included, iSO+1a/b/c each give slightly different +1 stop results 

as do the iSO+2a/b/c versions.

For images that end up with grainy deep shadows after being push processed, try 

the iShadowDeGrit Action.

For maximum control, try the iSO2Taste Action. It leaves you with three upper 

layers that may be changed via Layer Opacity to control contrast, color strength 

and ISO value.

It’s dark out. Underexposed two stops so the star trails 
wouldn’t be four times as long, iSOLift+2 brings the 
Milky Way alive. Inset shows the original. 
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iSOExtreme1-6

Each number reflects a full f-stop of lifted exposure. Six stops? 

Try it. You might discover something in that ruined, underexposed 

image you were about to toss out.

i Best with lower ISO originals shot with ISO 100-400.

i This original dark image is in the Example Images folder.

iSOExtreme at work. A surprising predawn 4-stop rescue.
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iFlawFix
High ISO, long exposures and heat can conspire to cause 

individual pixels to fail. Often called blown pixels, most are just 

extremely noisy pixels revealed by time exposures.

The remedy is to shoot a single duplicate exposure with 

the lens sealed from ambient light. The supplied lens cap—

tightened—should be enough in a dim area. This blank shot 

becomes a special Flaw Frame that you can use for masking 

dotted pixels in subsequent long exposures. File it away 

in a safe place on your computer near or among shots that 

possibly may need it, later. 

i You must stack the Flaw Frame over the original image in 

Photoshop before you run the Action. This layered stack has 

the original as the Background layer and the Flaw Frame in the 

Layer 1 position just above it. 

i These Actions are made for Large Frame images, only—the 

largest your camera captures. Smaller frames will have their 

blown pixels scaled down, making them not repairable.

iFFLum1-3 Actions attempt to erase blown pixels with lumi-

nance manipulations.

iFFRGB1-4 Actions work with individual RGB channels to 

erase the flawed pixels.

i Higher numbers indicate more aggressive repairs.

Dropout pixels and high ISO noise mar this image. The bottom image was 
made using the iFFRGB2 Action. Viewed close, some small white spots 
still show in the sky. Yep. Technically, they’re “stars.”



|   193Corrective Measures    ACTIONS CS5

In spite of aggressive anti-dust technology, this large blob appeared in a 
series of shots with a Canon 40D. It was the only one ever seen with this 
camera, but it was stunning.

iDustAway
The concept of using a second exposure to repair a flaw found on 

a first exposure has an additional application. Early DSLRs have a 

nemesis: dust. Tiny particles of random matter are eternally with us in 

the air and a laser pointer’s sparkling beam can make the point.

A second, blank, middle gray exposure containing the shadow of 

only the dust can be used to wipe away the image of dust in an image.

i No white card handy? A blank diffused cloud cover or completely 

blue sky may work. A monochrome shot of a blue sky is just a shot 

of gray, after all.

i Recent camera models have incorporated active dust removal 

systems that use a repelling charge and high frequency vibration to 

shake off micro and macro dust.

i Non-propellant air blowers such as the Giottos Rocket may help.

Every time the camera is opened, new particulates can get in. At 

first they sit on, or in front of the mirror and shutter blades, but 

with every exposure, the interior air is turbulently slapped around 

by the mirror, and the shutter blades retract, laying the image chip 

open to the airborne contents of the camera’s 

chamber. Statistically, some dust is bound to find 

the surface of the image chip. And when it does, 

dust shadows can occur.

i Dust can land on any sensor, even in cameras 

with sensor-vibrating dust control (Canon/Olym-

pus/Nikon/Pentax).
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Both Nikon and Canon have adopted methods of removing 

dust by taking a special blank Dust Frame and combining 

it with the original image in their proprietary software. Our 

own process achieves much the same result, but uses the 

tools within Photoshop. 

1. As soon as you notice (or suspect) that dust may be on 

your images, point your camera at a blank white or gray sur-

face and collect some Dust Reference Frames. It’s important 

to shoot blank, out of focus shots at the same f-stop and 

zoom settings you typically use. Exposure should produce a 

spike in the center of the review histogram. No ±EV allowed. 

If you can, make notes about your exposures for later.

i THEN you can clean the image chip.

i Dust gets sharper at higher f-numbers. So cover your-

self from f/5.6 to f/16.

2. Later, lay the Dust Reference Frame over the image and apply iDust-

Away1 or iDustAway2 to the image. Tweak Opacity.

iDustaway2Taste may work better for some images.

Notes:

i Of course orientation of both frames must be the same.

i Image texture hides most dust blobs. 

i Advanced: You can condition a Dust Reference Frame by centering 

the exposure grayscale with Levels, then selecting around a major blob 

and surrounding the shadow with 50% gray.

i No white card in the middle of nowhere? Point your camera at blank, 

featureless sky. Drain color and level exposure later.

i In some cases, vignetting will interfere with dust control attempts.

Dust has been erased with iDustAway2. Above right, the conditioned Dust 
Reference Frame. 

Auto-exposing a picture 
of a blank white surface 
produces a nearly 
middle gray image. Its 
histogram is a vertical 
spike. You can force 
that to be exactly 
middle gray by pointing 
the middle value arrow 
in Levels right up its 
center.
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Canvas / print. Oil paint / photons. Vision plus hand-eye coordination / 
lens and shutter. On one side, the tools of traditional art / on the other, 
the tools of photography. People used to debate if photography qualified 
as art. Now no art museum would be without it.  
It is, however, perhaps the most flexible of the graphic arts.

A rt is in the eye of... hey, it’s you! 
The beholder has found its source. When you make a pic-

ture with photons, it tries to portray the light and tonalities 

before the camera. After all, the major convenience of photography is 

that when the shutter has been pressed, your work is done.

Maybe not. Perhaps you wish to take your image farther. A lot 

farther. Perhaps that shot will best be appreciated as a painting, 

drawing, technique-rich graphic or cartoon. Some images deserve 

a life beyond photography as an illustration or iconic picture above 

and beyond the call of photons.

Here is a collection of iNovaFX Actions that convert photons 

into photo illustrations, generating a new presentation and 

appreciation of the subject.

i Close, magnified viewing of these helps in their appreciation.

Artistic Conversions
Painting with Light

Chapter 6

iGraphic3.

NB: The framing treatments in this chapter are not part of the Actions.
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iLiners
Many graphic styles marry color shading with lines that define the 

subject. The Hayes Island Effect—a popular digital-to-art conversion 

effect seen on the Internet recently—inspired these Actions.

iLiner series of iNovaFX Actions convert your digital image into 

several realms of artistic interpretation that go far beyond the Hayes. 

Five basic alternate approaches are provided along with a “Carnet” 

Action that runs them all. Start with only the target image appearing 

in the History Panel. It will be renamed 

“Original” by the Carnet series. At the 

end of the series you will have all eight 

variations, plus, of course, the original 

for comparison. 

iLinerCombo is a variation worthy of 

experimentation by itself.

i Some will only work well with 

certain images. All crops shown here 

are from the default Carnet results 

using a slightly light exposure.

i Note that iLiner5 expects to be run after 

the iLiner5Prep utility has been run first.

Five basic techniques 
produce eight final “looks.” 
Experimentation is 
encouraged.

iLiner5

iLiner4A iLiner2 

Original iLiner3A 
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iComplexArtFX
This one folder holds several types of paint-like inter-

pretations of your digital image. You will have to experi-

ment liberally to find the perfect one for your image.

iAngledStrokes slashes your image with small brush 

marks, and on close inspection turns your image into a 

hyper-realistic, but obviously painted, illustration.

iAngledStrokes2 lengthens the brush strokes, degrading 

detail (in a good way). 

iAngledStrokesPainting reduces all detail to half, then 

fills the canvas with convincing paint and outline effects. 

You can almost smell the linseed oil.

i As photographs are converted into what looks like 

painted media, the level of detail transforms from 

optically exact to interpretive. Images look more like 

they were thought into existence rather than they were 

captured with light.

i Need more artist in the highlights? Try iHighlightTexturizer 

to add depth to those brightest paint blobs.

Clown Prints. A street performer in Paris totals 
up the night’s take. iAngledStrokesPainting 
made the conversion on the right. Interestingly, 
the painted version seems sharper than the 
original due to its delineated areas of tonality. 
View at large scale to see the strokes clearly.

iLiner3A 
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iCanvasPainting1-5

Now we are earning our beret. Paint goes on in 

nicely executed strokes that suggest more than they 

say. Original subject lighting holds up well and close 

inspection reveals how hard the artist worked.

i Although procedural variations give each iCan-

vasPainting# its own character, in general they get 

looser in detail as the Action numbers increase.

i Tip: Inspect your first results closely to see if 

tonalities as painted, are to your taste. It’s easy to 

go back to the original and adjust things like Levels, 

Curves or Hue/Saturation, then run the Action again 

to repaint an image.

At first, it’s photographic. Then a closer 
inspection reveals brush strokes. 
iCanvasPainting5 at far right shows an 
artist’s hand. Original is to its left.
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Above, iLandscape2’s upper layer has 
been additionally run through the Filter 
> Artistic > Sponge Photoshop Filter. At 
left, a detail. Notice how the detail is more 
implicit than explicit.

iLandscape1-3
Landscape paintings often 

share some common qualities. 

The artist wished to show vast-

ness and detail, but the canvas 

was so huge that spending a 

lot of time on every square inch 

became a chore. 

So he fudged the details a 

bit, making you think you were 

seeing detail and letting your 

mind fill in where paint was 

only hinting. The iLandscape-

series does this, too.

iLandscape2 and iLandscape3 

finish with an upper layer you 

can treat with a Photoshop 

Filter of your choice.

i Suggested: Sponge, 

Emboss, Dry Brush, Palette 

Knife, Fresco, Accented Edges, Ink Outlines 

and Paint Daubs (Dark Rough).

i Color is boosted to a palette of hues 

and intensities often witnessed in idealized 

landscape art.

i These Actions are especially good with 

images shot at Golden Hour.
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iWaterColor
Watercolor illustra-

tion is often produced 

in light tones with the 

paper lightly covered 

in thin, transparent 

color. The iWaterColor-

series follows this 

trend.

iWaterColorPainting 

and iWaterColorPaint-

ingEQ float color 

among numerous 

visible pencil lines 

that sketch texture 

and shading. The EQ 

version equalizes the 

image before painting.

iWaterColorIllustration 

flattens the tonalities 

through equalization 

but treats light areas 

and dark areas differently.

i As with many art conversion Actions, Images that might have been 

discarded due to imperfect focus or stability gain validity.

The Lonely Cell. iWaterColorIllustration brings transparent 
color to the page. Dark images are portrayed substantially 
brighter, as you can see with the inset original.
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iPencilSketch
Break out the colored pencils and grab a sheet 

of paper with some tooth to it. iPencilSketch is 

about to interpret your image in a rough, 

sketchy technique, taking advantage of the 

opaque build-up of color that a good colored 

pencil delivers.

When iPencilSketch is through, you will have a 

four-layer Snapshot in the History Panel. The 

original image acquires a toothy stroke and 

each superimposed layer will contain different 

tonalities of shaded and opaque pencil work.

i Tonality of the original is important. You may 

have to adjust tonality and try again.

i Pure white turns into textured paper. Add a 

border to the image with the iPencilSketchBorder 

utility. It frames your image in paper with 

a slight extra lift of your image on the final 

page. Run this before running iPencilSketch. 

Crop the final to taste.

i For a final tweak, add a signature, date and title under the shot 

using a script font that looks like handwriting. Some of the ones 

you may find have the names Bradley Hand, NoteScrawl, Coolzy, 

Enya, Handwriting-Dakota, Koenigsbrueck, LingPrint, Litterbox and 

GoodDog, among others.

Handwriting fonts you may find:

Bradley Hand    NoteScrawl    Coolzy  

enya  Dakota  Koenigsbrueck

LingPrint        Litterbox    GoodDog
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iPencilLine
Shoot the image digital, then let the pencils begin! iPencilLine 

draws images on toothy paper with soft pencils—graphite and 

color—to make the image a precision drawing.

i Helper Actions: iEqualize, to quickly apply Photoshop’s 

Equalize function to the image. iContrast(UM)1/2 to increase 

contrast between areas of similar tonality. iPencilSketchBorder, 

to add a generous white border all around the image.
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iColorBlast / iColorDream
Intentionally exaggerating color will stop eyes in their 

tracks. 

iColorBlast blooms the color louder. 

iColorDream brings it up to memorable unforgettable 

proportions.

Of course, memories are always more colorful than 

reality. As color becomes the intent of an image, the 

eye plays over the photo in a new way. Often, when the 

original scene is viewed, it appears drab in comparison 

to the obviously over-chroma version.

i Try other iComplexArtFX after one of these has 

treated a shot.

i Note that screen display color and Internet color 

can be much wider in gamut than printed color.

Cognac, above, must be the official drink of the 
Eiffel Tower. This window display was extreme, in 
subject, repetition and lighting, so iColorBlast was 
used to bump it up to greater extremity. 

Nightlife in the Left Bank of Paris is colorful, but 
iColorDream has taken the color dial up to 15 (on a 
scale of 10).
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iContrast
At first glance, the image below seems normal enough, but it 

has been contrast-enhanced without looking like it was manip-

ulated in a digital darkroom. An Action from the iContrast set, 

iContrast10-HDR+ has performed two operations on the shot. 

The first lowered contrast, similar to iContrast1-FilmLow, then 

the second applied a Local Contrast effect to that result. Local 

Contrast uses Unsharp Mask with a large radius (here 75 

pixels) and relatively small influence (here 60%).

i Included in the series is iContrast9-HDR2Taste and other 

tasteful presets. Play with them to gain a feel for their 

operation.

Local contrast is produced when 
Unsharp Masking is given a large 
radius and relatively low strength. 
Inset is the original.

This shot received iContrast10-
HDR+.

You see this phenomenon by the 
shovelful in HDR photography, but 
on this image, it merely made the 
structure and detail pop without 
abusing basic image tonalities.
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iDimroomArt
No longer a darkroom, your work area just needs 

to be dim enough for computer screen viewing. 

Yesteryear’s techniques, secrets and crafty methods 

have given away to new ones, this time, achieved by 

numerous 1’s and 0’s.

iLumiBloom1/2/3 play with the bloom of diffusion 

derived from shadow and highlight tonalities. 

i iLumiBloom1 mimics the diffusion of shadow 

tones that are easily achieved by diffusing the 

projection from an enlarger. Negatives throw 

light from shadows and any diffusion of the beam 

spreads the dark parts of the image. Layers give 

you control over dark spread and light spread, 

separately.

i iLumiBloom2 & 3 concentrate on blooming the 

luminance of the highlight areas. iLumiBloom3 

brings the greatest control.

iLumiBloom3 brings 
a healthy glow to the 
highlights of an image. 
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iBloomArt
A bloom of tonalities etches away at shadows, delineating contours 

and creating a unique look.

iBloomArt1 & 2 give immediate and tunable results.

iBloomArtInteractive gives you three types of interactive adjustment 

to achieve the bloom/line form of conversion.

i Practice. iBloomArtInteractive gives its best results after you 

have run several images through the process and gain a feel for it.

i A designer friend found that iBloomArtInteractive could rescue 

shots that were slightly out of focus by contrasting up shadow detail. 

Try it on your marginal focus shots. May the 

luck be with you.

iBloomArt creates an interactive canvas 
that lets you tune the effect by eye. 
Broad areas glow and fine details 
sharpen. 



|   207Artistic Conversions   ACTIONS!

iFleshTona
Recent advertising photography has employed a distinctive mid-tone 

enhancement combined with a subtle shadow bloom to create an 

appealing monochrome image. iBloomArt’s iFleshTona is a black 

and white digital interpretation that achieves much of that look.

Contrast is lowered and a subtle diffusion bloom invigorates the 

deeper tones of the monochrome image. 

Designed for portrait and B&W photo illustration, iFleshTona 

leaves a three-layer Snapshot in the History Panel, giving you added 

control over the final 

result.

i While it can be run on 

monochrome images, 

using it on color originals 

allows it to lighten flesh 

tones selectively.

Thoughtful Rider. iFleshTona 
generates a soft, long-scale 
monochrome image from full 
color images. 

Lost. iFleshTona softens and 
elevates skin tones, creating an 
image that presents a gentle 
mood. 
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iToons
Six variations on the idea of turning your photo into a cartoon-like 

image with airbrushed colors and varying degrees of outline.

i iToonsCarnet will run all six variations for you with a single 

mouse-click, but it will take a few minutes to accomplish all of 

them.

i Final results are stacks of layers that encourage 

control over color and line qualities.

At far left, the original 
image. From left to right, 
iToon2, iToon4 and iToon6.
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iGraphic
“Less is more,” said Mies van der Rohe, and he wasn’t talking 

about his diet. He was saying that simplicity is a virtue.

Our human—or child-like—tendency to appreciate an image is 

often better served when the image is less literal or less complex.

Graphic simplifications are here. iGraphic1 diffuses high-

lights. iGraphic2 adds diffused shadows. iGraphic3 paints 

with broad flat colors and a steady airbrush. 

i Each Action leaves a multi-layer result in the History Panel, 

so you can tune the effect to your preference, then flatten the 

image for immediate treatment by another Action.

i A fourth Action, iGraphicX is iGraphic3 with an active 

Adjustment Layer for Hue/Saturation added.

i A fifth Action, iGraphicZ combines iGraphic2 followed by 

iGraphic3. The iGraphicZΩ variant doubles Z’s resolution.

iGraphic3 flattens color and reduces 
texture to a minimum.

At right, iGraphicZ which 
combines iGraphic2 and 
iGraphic3 (detail). 
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CINE-LIKE ACTIONS
Now that motion pictures have gone digital, the range of image treatment 

his skyrocketed. Every scene is digitized and tweaked for color, vignetting, 

shading, grad filtering and a complex of adjustments that might best be 

clustered under the idea of mood (credit: Digital Intermediate by). 

Here are Actions reminiscent of treatments seen on the big screen from 

major Hollywood films.

iHalcyon
It’s a series of treatments much like those from the sci-fi and fantasy films. 

They move images into the past and hopefully add a sense of peace and 

tranquillity. Uniquely, they add emotion by subtracting and restructuring color.

Several versions interpret your full color shots into the modern equivalent of 

color memories. Where black and white shots may be treated as sepia to give 

them a less contemporary look, the iHalcyon Actions make color pictures that 

seem to come from some distant color process in the past.

i Each one produces a three-layer result, and each layer can be manipulated 

by you before committing to the final flattened image. 

i You can change 

colors, intensify 

tonalities, adjust 

layer opacities and 

have a lot of fun 

with these effects.

Clockwise from above left; 
iHalWarm, iHalMix, iHalGold, 
iHalCool.

At left, a shot of the walled old town area of Dubrovnik, Croatia 
became a night scene by manipulating its iHalcyonCool version 
and adding a candle in the guard tower. 
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iSinCity
Legendary graphic novel artist Frank Miller 

created a movie in stark B&W+. Its plus was 

the design element of isolated bold color, 

often violent red. 

Digital filmmaker Robert Rodriguez invited 

Miller to bring Sin City to the movie screen, 

knowing that digital cinematography was the 

best way to keep the graphic B&W+ design 

elements intact.

iSinCity contains four iSC-series Actions 

that interpret color originals in various con-

trasts. The iSC2Taste version lets you select 

the + color that will remain.

i You will probably want to 

try them all.

i Two utility Actions provide 

iSCPreTweak and iSCSetup 

functions.

i iSC2Taste will keep your 

selected hue, but you can 

change that with Photoshop’s 

Hue/Saturation control.

i For speed, the iSC123Car-

net Action will achieve the first 

three variations with a single 

mouse click. Take your pick.

iSinCity Actions allow quick B&W plus spot color accent mixtures to 
be explored. The above scene started with iSinCity2Taste. At a kinky 
leather street fair in Los Angeles, right, this striking costume became an  
iconic iSinCity effect. Below, iSC1 straight from the original. 
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iJazzAge
Martin Scorsese’s The Aviator used special color 

interpretations to give the look of early Tech-

nicolor two-strip color film. Three iNovaFX Actions, 

iAviator1/2/3, bring some of that strange world of 

1930’s color to your images.

i Since you can’t just look at an image and 

predict how the colors will be restructured, the 

iAviatorCarnet Action allows you to generate all of 

them easily, so you can select the one that feels best to you.

Modern cameras all deliver full-color pictures, but in the 
1930’s technology struggled to deliver a color-like effect. 
Above, iAviator2. 

Early color film had a limited palette made from just two color layers. Some almost 
felt hand-colored. iJazzAge manipulations recover some of these feelings from your 
images. Above is iAviator3 from that series. 
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iDomino
Tony Scott’s highly stylized action 

movie, Domino, processed every shot 

into a heightened state of color and 

contrast bringing the entire work into 

a new attitude. Here are four iNovaFX 

Actions that bring this sort of visual 

dramatic intensity to your images.

iDomino 1, 2, 3 and X each produce 

very different results, but all create 

labeled snapshots in the History 

Panel.

i iDominoCarnet, runs all four 

iDomino variations and leaves the 

multi-layer labeled snapshots in the 

History Panel, ready for your fine 

tuning.

Above, iDomino2 lights the scene in cool tones used for flashback 
sequences. Attitude is abundant, compelling the viewer to pose 
unanswerable visual questions.

Below, tension waits for the text message to arrive interpreted 
with iDomino1. Warmth brings a feeling of age to the scene and 
contrast pumps its theatricality.
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iRustica
Some images look better in black and white. 

Some would look better if something beyond 

black and white were added to their appear-

ance to give them character and presence that 

takes them out of the ordinary.

Art photographer Linda Butler produced 

the book ITALY In the Shadow of Time 

which presents 60 images in a unique 

monochrome treatment. Instead of simple 

B&W—or even sepia—her images are enhanced with degrees of ocher 

coloring that give mid-tones and highlights a distinct flavor of the past.

Now the realm of digital photographs can acquire some of this rich 

treatment through three novel Actions that were inspired by her work. 

iRustica 1, 2 and 3 each give various rustic interpretations to your 

image. Results will vary with different photographs and some will 

look best with only certain iRustica processing. 

i Altering the contrast and gamma of an image before processing 

will produce very different looks in the final set of images. Artful 

results like these take practice and experience. 

i To help you sort through this, an iRusticaCarnet Action is 

provided, which performs all three variations at once for easy 

review and delivers an additional black and white reference image 

for comparison.
iRustica results depend heavily on the exact tonalities 
of your original image. The iRustica3 image has been 
perspective manipulated as outlined earlier.

iRustica1 iRustica2 

iRustica3 

http://lindabutlerphoto.com/?page_id=11
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B&W Tonal Interpretation
The first photographs recorded tonality only, and by default, photographic materials 

responded to particular areas of the spectrum. Panchromatic, i.e. all-color, materials 

eventually solved many problems, and photographers quickly noticed the value 

of using color filters over their lenses to achieve desirable ranges of tonalities on 

panchromatic stock.

Red filters lightened skin tones and deepened blue skies. Green filters lightened 

vegetation and gave skin a swarthy look. Blue filters bleached out skies and made 

people look like they’re deeply tanned.

Some digital cameras incorporate similar filtration effects 

in monochrome shooting 

modes that deliver direct 

B&W images to their memory 

cards. A color image 

is captured, then inter-

nally processed to mimic 

the effect of a color filter 

with panchromatic film. The 

resulting monochromatic 

image is saved, forever 

colorless. 

i Why not do that later, in 

the digital darkroom? 

These iBWColorFilters 

Actions do just that. 

Color	Filters	for	Black	and	White

Original: This is the color image that has 
been interpreted by a Carnet, generating all 
the filtration options in a few seconds.
Red: Skin, lips & blemishes lighten. Blue 
skies, blue eyes & green foliage darkens.
Orange: Skin, lips & blemishes lighten 
somewhat. Blue skies darken. Green foliage 
darkens a little.
Yellow: Blue skies darken considerably. 
Skin, lips & blemishes lighten very slightly. 
Green foliage doesn’t change.
Green: Foliage lightens slightly. Skin & lips 
darken. Blemishes become exaggerated. 
Skies don’t change.
Blue: Blue skies bleach. Skin & blemishes 
darken. Foliage changes little. Yellow flowers 
darken.
Neutral: Image is interpreted approximately 
the way many B&W films perceive colors. A 
balanced panchromatic result.
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Two series variations 

are provided, one 

slightly more accurate 

for images shot by 

incandescent light, 

the other adjusted 

for images made in 

daylight or flash. The 

differences are subtle 

but noticeable. 

As you apply each Action, a new, labeled 

Snapshot shows up on the History Panel. 

Each Action variation is tagged with a name 

identifying the details of its conversion.

i Each series has an associated Carnet Action to generate one each of all the available 

color filtered B&W variations in a few seconds with one click of your mouse. In other 

words, you click on the selected Carnet (incandescent or daylight) and the color JPEG 

image is converted to all six monochrome variations in the group. Neutral, red, orange, 

yellow, green and one of the blues. As the Carnet operates, the original file image is 

duplicated into a Snapshot named Original.

i You can run both Carnet Actions on the same image, if you wish. Now you will have 

12 snapshots on the History Panel. Click among them to see the tonality differences.

i These Actions work with 8-bit or 16-bit images, so if you shot RAW, your next 

best work path is to interpret the image in color as a 16-bit file, then run the iNovaFX 

Action(s) on that to get the effect of the in-camera filters. 

i After converting a color JPEG to monochrome, other Actions may be employed to 

complete the image and ready it for printing.

A:    Neutral, Green, Yellow,

   Orange, Red, Blue.

Guess which filter made which 
B&W image. Answer smallified 
below.

iBWColorFilters nomenclature:
iBWIncanNeutral, for instance, 
suggests it’s for incandescent-lit 
images with proper WB settings, 
and will deliver a Neutral (nominal 
panchromatic) result.
iBWDayRed, for instance, 
assumes a daylight or flash 
exposure and appropriate WB, 
producing the effect of a red filter 
on the lens.
iBWIncanCarnet generates all 
five colors as pan film exposed 
under incandescent light, etc.
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iB&WFilmFX
Photoshop will let you drain the color from your image in the Hue/

Saturation control. And the Lab color mode will let you isolate the 

L, or luminance, channel which looks rather like a B&W photo. But 

neither of these has the substantial look of true B&W film images. 

Their spectral response is very flat, and B&W film’s spectral response 

is not flat at all. 

iB&WFilmFX Actions change all that. Six versions give you varia-

tions of color response the way B&W film formulas do. They are not 

tied to specific matched film emulsion characteristics the way some 

B&W conversion Actions are, but they give plausible and pleasing 

results that are a definite improvement over simpler methods.

To use them, prepare your color image in the standard way. Shoot 

for a good-looking, correctly white-balanced image. Then run the 

iBW Action of choice. Note that some are fine for people colors 

and others simply are not. iBWFilmFX2 works best with scenics, for 

instance, but not with some skin tones.

i If you wish to simulate the look of a light color filter on a 

camera loaded with B&W film, tint the color image before conver-

sion. The iBWColorGel Action facilitates this dramatically and 

produces a B&W result.

After conversion, you still have the opportunity to change Levels and 

Curves, Burn, Dodge, or manipulate the image any way you wish. 

Who said B&W was simple?

i See also, iFleshTona.

Original

iBWFilmFX4+Curves

Saturation Drained
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iBWFXDarkroom
Printing monochrome doesn’t always mean Black and White. 

Photographic artists have a whole repertoire of subtle colors 

for tinting B&W prints, and now, with the iBWPrintTints 

group, so do you. The statue, below, uses iBWWarmDk for its 

pronounced 

deviation from 

a neutral mono-

chrome effect.

Versions are 

available in four 

major colors, 

Cool, Warm, 

Metal and Green. These colors are 

selectable in three variations each. 

One variation, iBWTint2Taste lets 

you pick tint hue, strength and depth 

yourself. A superior Sepia version, 

iBWSepia completes the set.

i Not all ink-jet printers do a superior 

job with monochromatic images, but if 

yours does, these Actions will provide a 

nice sense of variety.

Try them on color images, too, (!) for 

interesting color tint combinations.

Lower left; iBWWarmDk. Above, iBWTint2Taste. 

iBWCool for a subtle cool color 
in three strengths.
iBWWarm for warm duo-tone 
effects in three strengths.
iBWMet for three levels of metal 
coloration.
iBWGrn for three levels of a 
subtle green tint.
iBWSepia creates a dark 
cold-tone sepia that you can 
manipulate to taste.
iBWTint2Taste lets you find the 
hue and strength intensity.
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Images are technically made of light, color, 
shading, sharpness, blur, framing, optical angle, 
grain, contrast, artifacts, anomalies and dynamic 
range. As you exercise dominion over each of these 
qualities, your images grow in stature.

E nhancements can take many 

forms. Some eliminate an 

attribute while others emphasize 

a characteristic. Many of the Actions seen so far 

deal with image elements you may wish to change, and the ones in this 

chapter add to that repertoire. 

Often, you won’t be aware of the need to fix, adjust or enhance an 

aspect of a shot while you are gathering it, but later, when the mood 

becomes more contemplative, some property will become noticed that 

will make you dig into these Actions looking for some help.

i Some of these require a degree of art direction or planning. You 

may have to shoot an image—or multiple images—in a way that pre-

pares it/them for a specific result.

Enhancements/Utilities
Improving the Details

Chapter 7
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iDynamicRangers
Film negatives capture highlights 

better than digital cameras do. It’s a 

fact of light. Negatives get denser with 

brighter highlights, so they hang on to 

bright gradations, but digital images 

reach a point of bleaching out—similar 

in principle to slide film.

What if you could shoot digital images 

with your camera that trounce the 

dynamic range of film? Photoshop offers 

the HDR technique, but results aren’t 

very easy—nor fast—to tweak and pro-

duce practical, intuitively clean images. 

HDR is able to do wonderful things, but 

not the one on this page.

With the iDR series, a new kind of 

appealing image can be built. It is cre-

ated from three separate exposures, 

each up to two stops apart from each 

other. The optimum shooting condition 

would be with the camera rigid from shot to shot, think tripod + remote.

i A special version (iDRv3toTaste-SelfAlign) uses the Edit > Self-align Layers 
procedure, for shots made without a tripod.

The subject must be non-moving over the span of exposures. Slow 

moving clouds may work, but fast moving features like vehicles, flags, 

animals, waves, hurricanes or kids will give poor results. 

This image looks intuitively natural. Yet it’s the product of separate -4, -2 and 0-EV images. The extreme blown-out highlight has 
been controlled with the iDRv3toTasteSuperCS3-Self-Align Action in PS CS3-CS5. Below is the “normal” exposure, its highlight detail 
completely lost to the physics of light and the tonal dynamics of digital cameras.
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The trick, is to shoot all three images 

very close together in time without 

moving camera or focus. 

Some work with over and under 

exposures, but the king of this series 

is the iDRv3toTasteSuper versions. 

These create an elaborate stack of 

image layers and Adjustment Layers, 

giving you ultimate control over each 

individual element, plus the whole 

group as a unit. This series is for high-

light extremes and starts with a normal 

image plus -2 and -4 EV captures. 

There are four variations covering 

±1-stop and ±2-stop exposure groups in 

RGB and Lab modes. 

i Only the iDRv3toTasteCS5-SelfAlign 

version allows you to do this hand held. 

If you don’t have a remote release, use the camera Self-

Timer and touch the camera lightly as you set each shot 

with hands off during the exposure.

i Manual exposure mode requires you to touch the 

camera between shots. Careful! Lock manual focus and 

don’t touch the zoom between shots.

All three shots are then brought into Photoshop and stacked over 

each other with the darkest on top and the lightest on the bottom. 

If necessary, use Photoshop’s Edit > Auto-Align Layers (Reposition) command 

before running Actions without self-alignment.

Another view from the same session started with a slightly 
lighter “normal” exposure as its base, so that exposure 
contributed more to subtle shadow detail. Below, the whole 
stack of Adjustment Layers. Each separate exposure layer 
has its own Curves and Hue/Saturation adjustment giving you 
instant control over its contribution. 
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Then bring all upper layers up to 100% opacity 

and run the Action.

The normal dynamic range of the normal image 

is now extended up to four stops farther (1600%) 

by the extra exposure elements.

i You will be given the opportunity to adjust 

Levels (Highlight, Gamma and Shadow values) 

and then Saturation in some, or Curves and Hue/

Saturation in others.

i The -Lab variations preserve color extremely 

well. So well in fact, that you may need to reduce 

Saturation to achieve good results. 

It is common to arrive at an extended dynamic 

image that lifts shadow contrast while preserving 

highlight detail. Let the highlights kiss the upper 

white point and try to keep the blackest blacks. 

i Crashed highlights are not your camera’s fault, they’re a digital pho-

tography limitation seen frequently in film transparency images, too.

i RAW format images are superior to JPEGs, but test this 

technique on subjects with extended tonalities. JPEG exposure 

clusters usually deliver “beyond RAW” performance for many static 

subjects in extreme lighting.

i Some cameras allow brackets ±2 Stops in a 3-shot string, while 

others allow only ±1 Stop, but collect more than 3 shots in a burst. 

i The best range seems to be -2/0/+2 to about -4/-2/0.

i Use the Local Contrast Action, iContrast7-LocalHi (iContrast set) 

to create an HDR-like appearance after processing.

Worst case scenario: moving water. Hand-held, instead of tripod-
stabilized. Moving subject (water) instead of still. Extremes of brightness 
in the glint is many times brighter than any digital or film camera can 
comfortably accommodate. Yet here the image does not seem “wrong” 
in any way. Below you see the normal and the darkest exposure (-4 EV). 
The iDRv3toTaste-SelfAlign version was required.
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iFrameAverage
Stack several frames all shot at identical 

exposures and blend them together so 

each contributes the same metric amount 

of image to the final result. If the camera 

is locked down and does not wander one 

iota between exposures, the result will 

look like a single shot, with one major 

exception: All differences between shots 

will be averaged out. Meaning grain, 

subject motion and differences in light-

ing will all be blended.

If the subject moves, you will see mul-

tiple ghosts of it in the final result. If 

high ISO is used, grain and image noise 

will diminish to virtual invisibility. If 

long exposures are employed, moving 

lights or stars in long exposures will 

become dashed lines of diminished brightness.

1. Open all the frames at once. There can be 3, 4, 5 or 6 shots, total.

2. Run the iFrameAvg-#Shot Action. The number of shots is the 

number in the Action’s name. Each currently open image will be 

accessed in turn and added together equally. 

i The first image will show as a Snapshot in the History Panel 

labeled as Original for Comparison. Then the combined image will 

appear with a name like iFrmAvg-6Shot.

iFrameAvg-6Shot has compiled six images into one. How can you tell? Notice 
that the clouds are streaked and that no hard-edged distant cloud shadows are 
showing. Below is what a single, representative frame looks like. 
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iFrameAvgAutoAlign
For Photoshop CS5, these Actions 

can be used with images that are 

just approximately in-register. Hand-

held series of images can often be 

used, because the Action includes 

an automatic self-aligning process.

Caveat:

A significant portion of each shot 

must be similar.

i Steady, now.

i The final composite may need 

to crop away edge flaws.

i Load all three to six images 

into Photoshop at once, then 

run the appropriately numbered 

iFrameAvg-#ShotAA Action.

i An intermediate Snapshot of 

the full set of aligned images will 

appear. Run the iFrmAvg-Bright-

est Action to add the images together with all of the brightest pixels showing. Two 

variation Snapshots appear. The INFO file in the folder helps sort this out.

Another set, iFrmAvgFullAA+CropCS5, automatically crops out any transparent 

areas after processing. It also has a Brightness enhancing Action.

Another folder, iRegister, contains Actions for stacking and registering up to nine 

images.

Six images were exposed with the camera held as steadily as 
possible. iFrameAvg-6ShotAA produced the final result. You 
can see a hand-held example filled with people on page 19.
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iPanacea 
If you have ever looked at an image and said to yourself, “I dunno, 

it just seems to need a little something,” then this may be the Action 

series for your shot. It’s a cocktail of local contrast to perk up the 

definition of tonalities, a small boost to the chroma, just to perk up 

the impression of colorfulness and a tweak to the sharpness, just to 

make it feel a tad clearer. 

They are the Doctor Feelgoods of Actions.

i Now images shot on a cloudy day, in the shade, under flat 

fluorescent lighting, backlit, atmospherically challenged and/or 

at Golden Hour have a second chance at crowd-pleasing.

Three strengths are available. iPanaceaTad adds just a tiny 

zing to the image. iPanacea1 adds three zings. iPanacea2 

smacks the image with a major truckload of zing.

i What happens to an image that receives several sequential 

processes with various iPanacea Actions? We are going to have to 

invent a new word for that.

i Many images will simply look a little better after being visited 

by an iPanacea Action. Most viewers (beyond 99%) will not be 

able to spot any change unless they can see the before/after 

comparison directly. The tweak to the image will, however, 

affect them on a subconscious level, often conveying a tiny bit 

more zing to their appreciation of the shot. Unless you overdo 

it, in which case they may say, “What the zing did you do to 

that picture?!”

Above, all seems well. But this image has been processed with iPanacea2. Below, 
the shot has been visited by iPanacea1. No viewer would guess what the shots had 
experienced.
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iLayers 
Adjustment Layers float over the image and several of them may 

be added to alter the image’s appearance interactively.

Photoshop’s ability to stack Adjustment Layers over an image 

gives you a whole world of editing possibilities. Setting them up 

for an individual layer or for the entire stack of all layers can be a 

chore, since there are so many decisions to be made. 

These iNovaFX Actions set up your images for several Adjustment 

Layers at the same time. They’re stacked, but no change is made 

to the picture until you open them one by one, making adjustments 

interactively after they’ve been placed.

iLayerBasic1 works on only the layer selected before the Action is 

run. Three adjustments are stacked: Curves, Hue/Saturation and Photo Filter. 
Each operation works only on the layer immediately below the stack 

and each adjustment operation works starting with the image, 

moving upward through the stack. 

i You don’t have to accept the stack sequence in the order it 

is initially set. If you move any Adjustment Layer up or down 

in the stack (click and drag), you will change its sequence of 

adjustment and this can make a big difference to your image.

i After you make changes with one or more Adjustment Layer 

control, re-run the Action from its stopping point and it will 

create an iLayerBasic1 snapshot and purge the History memories. 

If you are using PS CS or higher, run the separate Action, 

iLayerCSResolve, instead. It uses 16-bit/channel techniques to 

slightly improve the final result while flattening all layers and 

purging History memories. The finished image will be 8-bits/

channel in all cases.

In just a few seconds the 
iLayersTotal Actions will 
set up the most useful 
nine New Adjustment 
Layers for you. Here is 
what they look like when 
tied to a single selected 
layer via iLayerTotal1. 

ADJUSTMENT LAYER SETUP WITH ILAYERS
iLayerINFO  . . . . . Quick instruction on using these.
iLayerBasic1 . . . . Creates Curves, Hue/Saturation & Photo Filter Adjustment 

Layers tied to selected image layer.
iLayerBasicAll  . . . Creates above set of Adjustment Layers affecting all lower 

image layers.
iLayerBC1 . . . . . . Creates Brightness/Contrast & Color Balance Adjustment 

Layers tied to selected image layer.
iLayerBCAll . . . . . Creates above set of Adjustment Layers affecting all lower 

image layers.
iLayerTotal1 . . . . . Creates 9 Adjustment Layers tied to selected image layer 

(as in the illustration above).
iLayerTotalAll . . . . Creates the 9 Adjustment Layers affecting all lower image 

layers..
iLayerPhoto1 . . . . Creates 5 Adjustment Layers, Curves, Exposure, Contrast/

Brightness, Photo Filter and Hue/Saturation.
iLayerCSResolve . 16-bit/channel flattening & resolving utility to complete 

adjustments with PS CS.
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iLayerBasicAll performs a similar function with the 

same three tools but each Adjustment Layers is now 

global, affecting every layer below it. iLayerCB1 provides 

the lesser used Contrast/Brightness and Color Balance operations to 

the single layer immediately below its Adjustment Layers 

stack, while iLayerCBAll provides the same functions 

for all layers below the stack.

The iLayerTotal Actions stack the top nine Adjustment 

Layers operations at once above the selected layer. 

With nine operations to keep track of, it takes up more 

Layers Panel room but gives you all the most useful 

Adjustment Layers functions.

i Important: After making all your adjustments, running 

the Action from its stopping point makes a Snapshot in 

the History Panel that retains all layers and Adjustment 

Layers, then flattens the image to give you a single layer for saving or 

running a new Action. If you need to make more changes, click on the 

Snapshot and continue working, then flatten manually.

i Unaltered Adjustment Layers don’t affect the 

resulting image. When the image is flattened, 

they simply evaporate leaving no visual residue or 

influence.

i iLayerPhoto1 adds five Adjustment Layers for 

Curves, Exposure, Contrast/Brightness, Photo Filter 

and Hue/Saturation.

iLayerPhoto1 stacks five photographic Adjustment Layers 
above a selected layer. If there is only one layer, it will be the 
default target layer. This shows just one of billions of tweaks 
the five layers can achieve. 
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iCrop
Crop smaller images out 

of your larger frames. This 

often is done to achieve a 

more telephoto result.

Here are MP (megapixel) 

numbered center crops.

i Nikon’s 12MP profes-

sional D2 and D2x cameras 

include a central 6MP patch 

and viewfinder mask for fast 

sports photography. The 

principle here is similar.

i An image of 3MP is 2128 

pixels in its longest dimen-

sion and can be printed 

exceptionally sharp at 200 

pixels per inch of paper, 

making a 7.5 x 10-inch print.

i All crops are dead center, 

but you can offset images before cropping..

i Use the iCW and iCCW (clockwise/counter-

clockwise) utility Actions in the iCrop folder to twist/

untwist verticals.

i You may use them directly on vertical shots or 

pre-cropped shots to pull out an X-megapixel sized 

horizontal image from the larger frame.

Dimensions of 3:2 Crops (12MP)
Array Size        H          V        Tele Factor
12MP . . . . .4288 x 2848 . . . .1.00x
10MP . . . . .3872 x 2592 . . . .1.11x
8MP . . . . . .3456 x 2304 . . . .1.24x
6MP . . . . . .3000 x 2000 . . . .1.43x
5MP . . . . . .2784 x 1856 . . . .1.54x
4MP . . . . . .2472 x 1648 . . . .1.73x
3MP . . . . . .2128 x 1420 . . . .2.01x
2MP . . . . . .1728 x 1152 . . . .2.48x

iCrop gives you incremental, inward, 
central crops by numbered megapixel 
size. Tele factors in the chart are 
compared to 12MP originals. Not 
shown: a new crop for 14MP frames.
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iOldTymie 
Age your image by 100+ years. Put it into the late 

1800s. iOldTymie and iOldTymieDistressed alter con-

trast, orthochromatic (darkish) flesh tones, paper and 

emulsion age effects and adds the ravages of time.

i Adjustment Layers let you address tonalities with 

Curves and Hue/Saturation to modify your results.

i Neutral tonality can be achieved in either version 

with a Saturation setting of 0.

iOldTymieDistressed, top left and lower right, darkens reds 
and cooks the paper for a century. iOldTymie, lower left, 
can create a wide range of sepia-like tints and does not 
distress the virtual paper. 
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iRetinex
An image enhancement 

effect worked up by some 

NASA researchers who were 

trying to tease visual improve-

ments out of spacecraft 

cameras has been patented 

as the “Retinex” process. Not 

to be confused with Edwin 

Land’s ground-breaking color 

theory of the same name. 

The iNovaFX iRetNar-series of 

Actions achieve results similar 

to those of NASA’s Retinex 

without the cosmic math.

Two levels of mild effect 

are in iRetNar1 and iRetNar2, 

and three levels of extreme 

enhancement are found in the 

tunable iRetNarRatorHazy1, 2 

and iRetNeo versions.

iRetnART departs into its own world, producing an odd, nearly 3D 

effect.

i Hazy images take on unexpected tints. Try the iAuto utility to 

clean up color cast and contrast. It’s in the same iRetinex folder.

Images hidden with haze can sometimes be teased into revealing more of 
their soul with the iRetNar Actions. Above iRetNarRatorHazyNeo followed 
with the utility, iAuto (in the same iRetinex folder) has brought back much of 
what photography lost, but the eye remembered. 

http://dragon.larc.nasa.gov/
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iBCFisheye (Nikkor 10.5 only for DX format)
For the Nikon DX format cameras, there is an unusual optic, the Nikkor 10.5mm 

f/2.8 fisheye lens. It is fast, sharp and equisolid, meaning that it produces an 

image that resembles a projection onto a geometrically correct hemisphere.

A special variation of the iBC Actions, the iBCFish-series, flattens this image 

into a straight-line, hyper-wide-angle display. These Actions are for this specific 

camera/lens combination only and will not work with other brands or optics.

i Note that the sides of the flattened images suffer greatly from being 

yanked out so extremely, but often the peripheral effect is more important 

than sheer resolution.

i Separate versions serve vertical and horizontal images.

Shooting vertical images with the Fisheye-
Nikkor 10.5mm DX is tremendous fun. Getting 
one’s feet and hands out of the shot is often a 
challenge. The iBCFish Actions amplify the fun 
and give you another reason to check out this 
exciting lens.

iBCGeoMAX fisheye straightening uses every pixel. 
Edges are compromised, but add to the drama. 
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iDots
Photographic looks can make or break a 

picture. Here are some new ones.

Normally we don’t see printing dots 

directly, but we know what they look like 

because graphic artists have used them as a 

design element over the years.

With the iDotsFX iNovaFX Actions you can 

achieve a dot-reminiscent effect on your 

images. These dots are big—a scale you 

choose that overlays your image in a visible, 

but non-disruptive manner.

i They require you to interact with several 

choices along the way.

You may start with either horizontal or 

vertical images of any size, but they should 

be in 3:2 aspect to begin with. Do any 

retouching work on them before you begin. 

 i These versions scale the image to a 

10MP frame. Prints with this treatment look 

best at 11 x 14 inches or larger. Photoshop’s ability to cover 
a layer with a repeating 
selection lets this very 
simple 2x2 pixel pattern 
create all the simulated 
printing dots.
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iCombo
The iCombo-

series gives you 

three variations of 

picture-in-picture 

framing. 

A background 

and foreground 

image must be 

open at the same 

time. 

iCombo3x5A 

or iCombo3x5B 

Actions will pro-

duce horizontal results from two open horizontal images. The A version 

makes slightly smaller tiles and shows more background. iCombo3x5BV 

will create vertical finals from any two open vertical files.

Images can be of mixed sizes. Final files will be 13.5MP.

Multi-layer snapshots of flat tiles, shadowed tiles and dimensional tiles 

will be saved in the History Panel.

A background-treatment Action, iComboBGTint allows adjustment to the 

background layer, interactively. iComboBevelMaker adds or modifies bevels.

i Avoid confusion: No other files may be open. Just the designated 

foreground image that will appear in the tiles, and the background. Just 

before running the iCombo3x5 Action, select the image that you will use 

for the background of the final result.

iCombo3x5B followed by the iComboBGTint Action. 

iCombo3x5BV stopped before the tile option was 
added, followed by the iComboBGTint Action tweaked 
to produce a monochromatic result. After all that, the 
iComboBevelMaker Action was run, creating the hard 
chiseled bevel effect.
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iHandyChanges
Here’s a grab-bag of chore-lightening Actions, each of which 

serves a different purpose.

iRuleOfThirds places a layer of non-destructive lines over your 

image, so you can instantly see the Rule Of Thirds proportionality 

as it applies to your current composition and crop. 

i In general, subject matter that is at approximately 1/3 in, down, 

up or across the face of the image strikes a human chord with our 

collective visual aesthetic. In theory. 

i It’s only approximate, and there are many other compositional 

rules, but this one is the long-surviving frontrunner. 

i If you press Continue in the final data window, the lines will be 

eliminated, and your shot will remain unaltered. The Snapshot in 

the History Panel will preserve the two-layers, intact.

i Your image is not altered. Turn off, or throw away the Thirds 

layer to return your image to its upright position. Re-crop, then run 

iRuleOfThirds again to see it cast over your shot, afresh.

Guest Action: iGolden Section

A prior eBook owner, Klaus 

Nordby, adapted our iRuleOfThirds 

Action to create the iGoldenSection 

Action. It paints the lines at the 

Golden Section division points, 

left, somewhat closer to the image 

center. Ancient Greeks and even 

Leonardo da Vinci used the Golden Section as a compositional 

structure (Parthenon, Mona Lisa) so it’s here for you to explore.

Proof of thirds. Here’s an image straight from the camera with no cropping at all. The 
image has many details, but one item dominates and is locked onto by most people 
now revealed in the RuleOfThirds overlay. The eyes have it.
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iSharpConvert simply ups the apparent sharpening of an image 

made with an in-camera reduced Sharpness setting. A minor tweak, 

but handy if you need to sharpen up all the shots from a single 

session.

iPurge simply dumps the History Panel’s list of steps, bringing the 

Snapshots back into view if they have been hidden by numerous 

listed steps.

iSaveJPEG9 attempts to save a JPEG copy of the current image 

into the folder that originally held the image. The name will 

become appended with copy.jpg, so the original image will not be 

harmed. So XYZ.jpg will become XYZcopy.jpg in the newly saved 

version. 

i Please test this on your computer in case any operating system 

peculiarities defeat the intended preservation of the original.

i The quality setting will be 9 by default, a high quality setting 

that offers a good balance between image integrity and low-impact 

compression artifacts. 

IPURGE

iSharp

JPEG9
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iChannelMixer
Your image is most often made of red, green and blue channels 

that produce full color. This tool sets up Photoshop’s Channel 

Mixer to generate a B&W image by balancing the RGB channels 

in any way that suits you. The Channel Mixer feature is doing all 

the work, with this Action operating as a simple default setting 

generator.

Default settings add the value of each channel equally (close 

enough) so the B&W image is nearly identical to the shading you 

would get from reducing Saturation to zero with Photoshop’s Hue/

Saturation control. 

But when you move these values to other settings, the image 

becomes “filtered” as if the camera had shot B&W film with a color 

filter over the lens. Lift red, and light blemishes that show as a 

shade of pink, fade away. 

i As long as the total values of the three sliders add up to 100, 

the exposure looks correct. But you can take these values far 

beyond 100 for intentional effect, as at right.

i The monochrome option is checked by default, but if you turn it 

off, color channels can tint the image. 

i If you play with this feature a while, you can approximate the 

look of various B&W films and color filtrations.

Just a simple setup, iChannelMixer merely turns on Photoshop’s Channel Mixer 
feature, awaiting your input. You can take this to extremes. 
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iFinger
Now you can shoot a macro close-up of your own—or some-

one else’s—fingerprint and turn it into a decorative piece of 

art. A brand new kind of self-portrait, perhaps?

iFinger is a multi-layer effect generator, scaled for art at the 

fingerprint line weight. It assumes that you have shot a thumb-

print to approximately 60% of the long dimension of a DSLR 

frame. Getting the fingerprint is the hard part.

i Ink your thumb, then press it onto copier paper or the back 

of a stiff white business card. Where do you get the ink? A 

stamp pad is good. Our bank had a fingerprint pad. And sup-

plied a business card. Obviously a full-service operation.

What you want is a nice, clear fingerprint with as much linear 

detail as possible and relatively decent contrast. Then shoot it 

with a macro lens to fill the frame nicely (or scan it). Use the 

preparation Action, iFingerContrast first, to perk up the (usu-

ally) low contrast print image. Then run iFinger1 or iGoldFinger 

to create the image. Fingerprint lines become dimensional, 

floating, metallic.

i A layered Snapshot will appear. You can play with the fx of 

all four print layers and change the background to taste.

i Idea #2: you can apply these to any black and white graphic 

of approximately similar line density.

i Printed poster size and framed, these can become great 

conversation starters.

iGoldFinger. A new portraiture.
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iBubble1 / 2
The Photoshop function, Polar Coordinates, is almost never 

used. So we used it to wrap an image around itself, forming a ball 

of scenery in and environment of sky. At least that’s a common 

result when it is applied to a scenic shot.

i In each variation, an upper layer introduces a highlight glint, 

superimposed over the distorted image. You can turn it off, 

change its color or opacity to taste.

What comes around goes around. Images are 
wrapped around their base in a curiously seamless 
manner, often turning a vista into a new world. 
Above, iBubble1. At left, iBubble2, which extends 
skies gracefully. The one seen here is rotated 90° 
for compositional effect. 
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iBubble1 generates the image rotated about the center point of its 

base. Wha? 

i A mental image of what’s happening: Think of the image as 

being printed on a sheet of easily stretched rubber. Every bit of the 

picture can stretch, except the left and right sides. Pin the center 

of the bottom edge of the shot to the wall and tug both bottom 

side corners into the pin. The whole bottom edge has shrunk to a 

point, and the sides now meet as a radius. The sides touch, and if 

this were done simply with Photoshop’s Filter > Distort > Polar Coordinates > 
Rectangular to Polar function, the edge where they met would be a hard 

line (but we avoided that disruptive look). The top of the original 

image has now become the circumference of a circle.

iBubble1 runs quickest. It pulls the image into a circle and adds 

a superimposed glint at the very center where a star-like pinching 

of all the details along the original bottom get clustered. Often it is 

desirable to disguise this pinch, so the glint may help with that. 

i You can turn the glint layer off and deal with the pinch by hand.

i A final Stop lets you preserve the circle within a square of 

extended sky (or whatever was along the top of the shot). Continue 

past this to trim the image into its maximum square, losing some 

of the circle and replacing the Snapshot with a trimmed one.

With a generous sky and low horizon, the little ball of 
foreground becomes a tiny world floating in a circular 
sky. But objects that stick into space punch into the sky 
strongly. This is iBubble1 was stopped before it trimmed 
to the maximum square. Below is the opposite effect with 
iBubble3. Original at right.
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iBubble2 is like the untrimmed version of iBubble1 except that 

the extension of the sky (or visual material along the top of the 

shot) has been smeared around the center of the image, blurring 

the distinction between circular inner image and extended canvas.

iBubble3 is the opposite of iBubble1. It shrinks the top of the 

image to a point and wraps the shot upward, usually making the 

sky the center of the picture. Now the glint looks like the sun at 

noon over your landscape.

i As with all of the iBubble-series, you may move or remove the 

glint altogether.

iBubble2, above, treats the extended canvas with a blur, 
allowing a more complete framing. Here the glint has 
been moved to create a sun-like effect. The original shot 
was made by using a long shutter speed while moving in 
a train station in Berlin. Horizontal features have become 
concentric circles. At left, the Paris Metro seen through 
iBubble3.
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iBubble Rules

When working with the iBubble-series, all the rules of normal 

photography go out the window. 

• In spite of the extreme distortion, the photographic character 

of the original image emerges and people take a long time 

viewing and interpreting the picture.

• Vertical lines become radial lines.

• Horizontal lines become circles around the center. 

• Vanishing points become spirals within the image.

• Horizons across the middle of the shot become a line of 

demarcation between a ball-like world or fisheye-like sky 

depending on whether the image is a 1 or 3 variety.

• The higher the horizon in a 1 or 2 variety interpretation, the 

thinner the sky and larger the world.

• Flipping a picture 180° turns the shot inside-out.

• Subjects surrounded by continuous texture or tonality often 

work best.

• Shots that start with long shutter durations for streaks and 

blurs lead to exceptionally interesting patterns.

• Each iBubble variation pre-picks a Stamp Tool spot near the 

center so you can blur the pinch point by immediately dotting 

the center with the tool.

• Crop the original image any way you wish.

• Break all rules.

• Play with iBubble4/5/6, iBubble7/8/9, iBubble10 and iBubble11. 

Ooo!

Above, an architectural 
tangle shot for symmetry. 
At left, iBubble11 and its 
original. iBubbles 4 through 
11 have no glints.
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iFace
Portraits serve two purposes. The first is to see the person 

by idealizing their look in general. A good portrait is relatively 

timeless. The second function for portraits is to record just how 

someone looked at a specific time. 

Digital photography excels at the latter, and many portrait 

photographers excel at the former. Here’s a series of Actions that 

helps turn digital images into professional portraits.

Time conquers us all, but the iFace-series rolls back the clock by 

lowering skin texture.

iFace1 is the lowest intensity with iFace3 showing the greatest 

effect.

i Note: Uses Photoshop’s Surface Blur function, so it only works 

with PS CS2 and above.

iFace3 lowers skin texture on 
close portraits without covering 
the details that make the pose 
attractive. And you thought the 
image was the original.
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iButterfly
Almost any picture in your library can become the 

wings of a graphic butterfly with iButterfly2.

An extra Action, iDisplayBox creates a display box 

to house an existing butterfly image. It presents a title 

under the image that is a type layer you can modify.

It’s a graphic novelty, but you will find that many 

people—especially kids—

want one made from their 

portrait. Open any image 

and run the Action. 

i The subject file must 

be the only thing open in 

Photoshop as you begin. 

After some initial housework, the Action opens the 

original subject image with a crop rectangle already in 

Transform mode. Its position, size and rotation are up 

to you. The rest is automated. Separate layers for wings, 

body, eyes and background paper will appear. Each will have its own color 

adjustment layer in one of the snapshots the Action saves. iDisplayBox adds 

type and title card layers for manual placement.

i Note that a right-facing subject works best. If your original image 

faces left, use the iFlip utility in the iButterfly folder to turn the shot to 

the right before running the iButterfly2 Action.

i An iButterfly Flattener utility lets you generate new snapshots after 

working on the multi-layered one.

i Use the iButterfly-Layers snapshot to modify the body, eye, wing 

and/or paper colors separately.

iButterfly stretches any image into butterfly wings. 
The iDisplayBox version allows you to change the 
type label to any text.
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The iButterfly2 Action produces three Snapshots in the History 
Panel. The first has each layer separate and ready for fine 
tuning. You can stop and change the color of the butterfly’s 
eyes, wings, body and background paper. Secondly, a labeled 
Snapshot is saved with the full butterfly on one layer over the 
background paper. If you switch off the visibility of the paper, 
leaving the butterfly over a transparent background, you can 
save the butterfly image in PNG-24 format, which is found in 
File > Save for Web and Devices > Preset: (PNG-24). This 
image is self-matting in many web layout or page design 
programs. The last Snapshot delivers the flattened image of the 
butterfly married to its background paper. Only the iDisplayBox 
Action adds the frame and title strip, and you have to come up 
with the title. Think Latin. Then think Road Runner.
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iBanner
Put your favorite image on a giant banner covering the 

side of a building! Wow! My name up in cloth! Shout your 

message to the passing throngs. Just open your favorite 

horizontal shot, open the special .psd image, Images-

Demos > Actions Extras > iBannerImage1 from its hiding 

place and hit the go button. 

The iBanner1 Action will compose the giant poster, 

pausing for your composition and text 

inputs, then it will let you Stop for more 

complicated layout assemblies. Run 

from the stopping point to put up your 

banner and brighten the result.

i Quick results can be obtained by 

using the default Arial font and default 

framing for your shot. The iBannerIm-

age1 .psd file shows this arrangement, 

but you can go nuts with the giant 

poster if you wish. 

i When you are given the opportunity 

to transform the placement of your 

shot, you can rotate or distort it. If you 

elect to stop after entering text, you can 

change font, color and effects.

+

=



  246 | CHAPTER 7       ACTIONS!

With a little effort, you can get more exotic type treatments and 
even vertical images to work on the banner.
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Photoshop comes in a second version designed for use by web page 
designers, advanced 3D artists and movie scene manipulation. It costs 
$300 more than straight Photoshop CS5. If you already own Photoshop 
Extended, here are Actions that work with HDSLR movie files. 

M ovies can be shot with today’s 
HDSLR cameras. Now what? 
HD + DSLR = HDSLR mash-up. In movie mode, 

many recent DSLRs can acquire high definition motion picture clips 

with frames as large as 1920 x 1080 pixels—about 2MP per frame. 

Photoshop Extended (PSX) facilitates working with movie files, and 

the Actions here do a number of interesting and useful things by 

combining these two ideas.

Movie scenes in Photoshop? Why not? Movies are subject to the 

same needs for imaginative treatments begged for by still images, 

but the elements of motion over time adds unique complexities. 

Digital photography is blurring the distinction between still and 

movie tools, and PSX allows you to work in two universes at once.

PhotoShop eXtended
Actions That Work With Movies

Chapter 8

PS
X
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MOVIES TO PANORAMICS

In 2010, Sony introduced pocket cameras that were able to 

capture a panoramic image by sweeping the lens in a panning 

motion, wiping a much wider image into an image file. They call 

it Sweep Panorama. Now you can do that with your HDSLR plus 

the iPanoHD Action (iPanoFromMovies folder), and get far more 

professional results, quickly. And if you want, you can capture 

360°+ images!

For panoramic images, several adjacent shots are collected. 

Traditionally you do this by methodically shooting overlapping 

still images. But now you can do it by shooting in movie mode 

with an HDSLR, then letting PSX plus an Action do the work. 

The iPanoHD Action is optimized to lift every 30th frame from 

the movie file, up to 14 panels wide. The restriction is that the 

final movie MUST be 390+ frames in length. Movie format can be 

1080p24/25/30 or 720p30. 

A pan using 720p60 will work, but less well because 

it must pan quicker showing potentially more smear. The 

orientation of the camera can be either horizontal or vertical 

and the movie clip should be shot with a high shutter speed 

(1/1000 sec or faster) to avoid blurred frames. 

i With the camera horizontal, it is fairly easy to shoot a full 

circle panoramic movie clip in 390 frames (13 seconds at 30 

fps). With the camera vertical, you would be struggling to 

shoot more than about 210° in that time.

i Best results will come from mounting the camera on a 

tripod, monopod or precision panoramic pan head. Since the 

Action is capturing only single frames, almost any tripod pan 

head (fluid not required) works quite well.

CS5 Photomerge works best when it has many images to work with. At 1080p30, the shot 
took about 15 seconds. It was captured under the most primitive conditions standing on a 
rolling dock, shooting gently rolling boats hand-held—which by rights should have polluted 
the image with a great deal of parallax error, yet only tiny stitching errors remain.
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Your capture technique is critical, but there are some guidelines that will help. 

i You can roll the camera well before panning. As you pan, start a count-

down in your head from 15, 14, 13... 0. Later, in PSX the Animation Panel 

will let you trim off any pre-panning frames.

i If you achieve the end of your pan before your count has run out, 

that’s okay, but keep recording until the time is up. The iPanoHD 

Action will ignore most redundant frames without a fuss.

i The worst shooting technique would be to move the camera in 

a wide arc in front of you. That displaces the lens, causing parallax 

between selected frames. It’s best to pivot the camera around the 

nodal point of the lens—approximately the center of the lens barrel—

as you shoot. 

i Remember that any subject moving through the scene (pets, kids, 

tourists, actors, cars) may create problems for the Photomerge feature 

in PSX. That said, PSX Photomerge is very crafty in selecting subjects 

that appear in overlap areas.

i You don’t have absolute control over the pose of people 

or moving objects in the final, but you do have control over 

your start frame. If a person or subject is in an awkward pose, 

adjust the start time, so the Action will pick a different frame 

when it gets to that part of the pan.

i When monopod shooting, here’s an advanced trick: 

Extend the pod to full height. Angle the camera down about 

2° (very slightly) so when the camera is dead level, the pivot 

point of the back-slanting monopod is under the lens, not the 

center of the camera body. This helps reduce parallax.

i Practice shooting and processing movie panoramics before you 

gather critical shots.

A big HDSLR advantage is the ability to instantly select still images, movie 
images or, in this case, a movie panoramic. Each type of image brings a 
different sort of memory. Side story: I met the late Edith Shain at an eBook 
signing. She was the nurse in Alfred Eisenstaedt’s Life Magazine photo. So 
naturally, I gave her a similar kiss. Minus some of the original passion. She 
was in her 80’s. “You’re not my first,” she said, demurely. 
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PANORAMICS WITH IPANOHD ACTIONS. 
This example uses a clip which was shot vertically. Most of your 

shots will probably be horizontal panoramics, but this shows how 

either orientation will work with the Action iPanoHD.

1. Close all other Photoshop files and Open the movie panoramic 

file. You may need to spin a vertical capture 90° to cause the 

movie file to be oriented correctly. Not all cameras present verti-

cal movies in a vertical window. Two utility Actions, iTwist90CW 

and iTwist90CCW* make this a snap.

2. Open the Animation Panel and change it to timeline mode, if it 

is not already in the form at right (red oval). In the upper right 

corner of the Timeline Panel (green oval), a panel-specific menu 

icon lets you open settings turning the time into 

frames and allowing you to adjust the timeline’s 

scene icon to Large, as has been done here. Those 

settings simplify the next operations.

3. With your cursor, you can click on the green timeline 

bar and slide it left or right. Here we have moved it to 

the left to trim off some of the head of the clip before 

the camera started its pan. You will need at least 390 

frames, so you can move the End Of Work Area Indicator to that 

point and slide the Current Time Indicator there to confirm the 

condition for your end frame. 

i One Action does horizontal and vertical images, and smooths 

the edges adding a drop shadow as in the iPanoCylinderEdge 

sets of Actions. Optionally twist vertically shot scenes using the 

iTwist90CW or iTwist90CCW utilities before running iPanoHD.

When you turn a 16:9 frame vertically, it looks quite tall. Here are the start and end 
frames from a hand-held slow pan of about 200° with the camera held vertically. 
The Animation Panel’s timeline mode allows easy shifting of the full clip to the 
left, to trim off repetitious start frames captured before the pan began. The initial, 
uncropped result is at the top of the next page.

* CW=clockwise; CCW=counter clockwise.
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4. For this shot, a 1080p30 HD file, we used 

iTwist90CW to make the image read correctly on 

screen. Any frame rate will work, as long as the 

total frames are 390+. The Action stops to let you 

make adjustments, but the above step 3 already 

completed those, so you can Continue past all alert 

windows with simple carriage returns.

5. Before the Action completes, it has automatically 

generated a cylindrical panoramic image, and 

if it is a vertical pan—say, up a building—it will 

have magically twisted the image 90 degrees to 

work on it. It will smooth the edges and add a 

drop shadow, pausing so you can place, scale 

and tune the shadow to taste.

Along the way, several layered Snapshots will appear 

in the History Panel ready for tweaking. 

1. The first multi-layer pano assembly, 

2. The flattened smooth edge layered version and 

3. The final version with drop shadow.

i Want to change the shadow? Re-open the fx item 

and re-adjust it.

i Want a rectangle instead of a bubble? Crop to 

the maximum as we did in the bottom example here 

and on pages 248 & 249.

i You can use these Actions with vertical iPhone 4 

HD shots, but you may need to twist the movie files 

90° to horizontal before importing them to PSX.

All these were shot within moments of  each other in San Diego. The top three show how 
they emerged before cropping. The impossible-to-find-a-place-to-put-your-car shot (Parking 
Lotto) is over 340°. If you obtain a full 360° sweep, you will be surprised to see that you 
have no control over where the shot ends occur. Photomerge doesn’t differentiate its first 
and last images. PSX will arbitrarily decide for you. So try to shoot slightly less than full 
circles, unless it is not critical to your use.
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SLIT-SCAN PHOTOGRAPHY
In the early history of action photogra-

phy, designers toyed with various novel 

shutter techniques. One of them was the 

focal-plane shutter that used a pair of 

roll-up opaque blinds called curtains to 

cover the film. At the start of the expo-

sure blind #1 would whip open, and 

after the shutter speed moment had 

elapsed, blind #2 would follow at the 

exact same speed, closing the film back 

into darkness. As the shutter time grew 

very short, blind #1 could be released, 

say, 1/500 sec before blind #2. When 

that happened, #1 had scarcely begun 

its journey, before it was followed across 

the film. Effectively the shutter had 

closed down to become a moving slit.

Fast moving objects looked odd. The instant of exposure 

was not the same at the top and bottom of the film. Under 

the right conditions, speed showed up as a slant.

i Sometimes this same effect—although for slightly differ-

ent technical reasons—shows up in modern cameras, but 

only those with rolling shutters—and that includes most 

HDSLR cameras when shooting in movie mode (but not in 

sill mode).

Wise photographers put this phenomenon to work. Henri 

Lartigue’s famous race car image is an outstanding exam-

ple. He panned while using a high shutter speed, but not 

perfectly in sync with the speeding racer. Both background 

spectators and car were distorted in opposite ways. 

As a result of this technology, the slanting wheel effect 

became an icon for speed in the early 1900’s. But it was all 

due to that slit having been scanned across the film.

Henri Lartigue was just 18 when he shot this in 1912.
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SLIT-STREAK AND SLIT-SCAN DIGITOGRAPHY
Slit-streak/scan images were originally made by pulling film at an even 

rate past a narrow aperture at the film plane. Any object moving past a 

vertical slit would sweep its own image onto the moving film. First use: 

horse race finish lines. DSLR photography couldn’t approximate this sort of 

imagery until HDSLR cameras were available. 

Since the slit plus moving film recorded images over time, the movie 

mode can substitute for the time element formerly occupied by moving 

the film. Every frame is a new element of time, so an image may be con-

structed by sampling frames in a row.

The Action folder, iSlitStreak, has iScanRX(#)K Actions. The “#” is 

pixel width in thousands. Ignore the other utility Action, uScanX. It is 

needed, but does nothing useful on its own. iTwist90 Actions are for 

spinning the shot to read correctly before processing.

iScanRX(#)K Actions follow certain rules. 

1. Every frame contributes one vertical slit, a single column of pixels 

in this version. Images are built by assembling vertical slits. 

2. They build a new image in one direction. In these, they build from 

the left to the right as they are processed.

3. Anything stationary in the original clip will become repeated, 

becoming horizontal parallel swept streaks. Anything moving 

through the shot will scan itself—distorted—onto the final image.

4. Shooting a movie for slit-streak must acquire as many frames as 

you wish to see as the width in pixels in the final shot. Meaning, to 

acquire a 1000 pixel wide image, you need to shoot 1000 frames, 

at minimum. Cameras that shoot high frame rates are especially 

desirable. 720p60 is looking mighty good right now.

5. iScanRX2K makes images just 2000 pixels wide, etc.

Most slit-scan images 
use a vertical slit at the 
film plane as in the above 
shots. But if the slit is in 
front of the lens oriented 
horizontally, you can 
emulate the shot at right 
by Robert Doisneau. The 
couple started and ended 
in the same position and 
spun on a slow turntable 
as the shot progressed.
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http://people.rit.edu/andpph/text-slit-scan.html
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6. Slow moving subjects produce stretched results while 

fast moving subjects appear compressed.

7. All subjects will face in the same direction in the final 

result. iScanRX shows all subjects facing to the right. 

The reason is that even though subjects may be moving 

both left to right and right to left, the image is a record 

of time, not graphic space. As objects move forward in 

time, their leading edges cross the slit before their trail-

ing edges get there. The beginning of the movie is at the 

right of the final image.

SHOOTING FOR SLIT-STREAK
You may shoot with your HDSLR in horizontal, vertical, 

hand held or on a tripod. You can pan the camera if you 

wish, but most images will be quite disruptive if shot 

hand-held or panning. Every bit of camera motion ends up 

looking like the background was painted by an earthquake. 

It will become a graph of your hand’s instabilities.

When the camera is locked on a tripod, backgrounds streak 

into horizontal lines, causing moving elements to stand out 

prominently.

A still from a tripod-locked movie that produced this slit-scan 
image is at the right. But what wide blue subject created the 
blue wall behind everything? It’s the narrow blue post behind 
the car. That’s where the slit (line) was positioned when it 
made the image above. 
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The iSlitStreak folder has Actions for 2K, 3K, 5K and 10K images 

from movie files. iScanRX(#)K Actions require a bit of understanding 

for you to use them easily. 

• 
First, you must open your movie file. It may be any format, but 

720p60 files produce the best results in most cases. They have more 

vertical columns per second from which to build the still image. This 

file should be the ONLY thing open in PSX at that time.

• 
Run the iScanRX#K Action. It will tell you some things up front, 

and you may wish to cancel to make adjustments to the time line. 

• 
The Action will make an arbitrary selection crop to position the 

vertical slit that will generate the image. It politely pauses so you can 

move this slit and/or change its size before continuing. If you have 

opened a 1080p file, the size of the slit MUST be adjusted, usually to 

full 1080 pixel height.

• 
The Action will compute for minutes, depending on the length 

of the movie and the speed of your computer. Only one vertical 

column is added to the final image from each frame. As the final 

image grows, the processing time per frame slows.

• You may stop the process by hitting the Escape Key, or by 

clicking on the square Stop icon g at the bottom of the Actions Panel.

i You can move the clip in the Animation Timeline window to trim 

off head frames. Make a Snapshot in History to remember it.

i You may rotate images by 90 or 180 degrees before starting, 

this allows you to shoot vertical, or swap image directionality.

i Movies up to 10,000 frames are accommodated (6.9 minutes 

at 24 fps, 5.5 minutes at 30 fps or 2.75 minutes at 60 fps) with 

iScanRX10K.
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SLIT-SCAN PLUS BACKGROUND
Experimenters like Doisneau learned that 

if a slit were scanned in front of the lens, 

the background would join the distorted 

moving subject matter, since it had been 

scanned into the shot along with the 

moving subjects. We have simulated that 

in a different set of Actions and they 

produce images with either vertical or 

horizontal scanning directions.

These Actions scan from one edge of 

the image to the opposite edge. Only the 

motion that occurs during capture can 

possibly contribute to distorted subjects. 

Image size = frame count. 

i If the camera is solid and unmoving, 

static items in the  scene will appear to be quite normal.

• Open the movie file. It should be the only thing open in 

PSX at that time.

• Find the folder iSlitScan and select the appropriate 

Action, iSlitV+BG(1280) or iSlitH+BG(720). All the other 

contents of the folder are rotation or sizing utilities.

• You may need to twist files for correct processing. 

The Actions assume a horizontal 720p-anything movie clip, 

but some cameras may open a vertical shot as a vertical 

image. If you want a vertical slit effect, make the image 

horizontal before processing.

The original movie here was captured at 60 frames per second with a Canon 7D. 
The vertical slit marched from left to right to make this shot, covering 1280 frames 
which required a 720p60 clip that was at least 21:11 in length. Cars in the back, 
coming around the curve were elongated laterally as they passed through the slit. 
The image below was made from the same movie file, but the shot was rotated 180 
degrees before the Action processed the image.
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• Frame Count = Image Size. 720p-anything Images must be 1280 

frames long for vertical slit interpretations or they must be 720 frames 

long for horizontal slit interpretations. 

• 1080p-anything shots must be 1920 frames long for vertical 

slit images or 1080 frames long for horizontal images.

• With these Actions, you do not select the slit. It moves auto-

matically across the image.

• Horizontal scans move top to bottom. Vertical scans move 

left to right.

• Individual shots can take from 5 to 15 minutes to process 

depending on image size, orientation and computer power.

• You can select the start frame by moving the timeline. Shots 

A, B, C, D at left are all from the same clip but started progressively 

later in the shot.

• If you flip an image before processing, 

it will warp subjects in the opposite way. 

Shots 1 and 2 here are scanned effectively 

from bottom to top by rotating the movie 

180° before processing.

B

C 1

2D

All the images here were produced with a horizontal slit 
scanning across an image that was originally 1080p30. 
All shots are automatically reduced to 720p30 before 
processing. 

A
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SLIT-SCAN PHOTOGRAPHIC TIPS
Nomenclature: Slit-streak and slit-scan initially meant 

different things. The last uses of true slit-scan photos or 

animations was decades ago. Other than for horse-races. Now 

the terms are used interchangeably. The scan may be subject-

induced or it may refer to a moving, scanning slit. 

Slit-scan photography is a strange interpretive world unto 

itself. Digital HDSLR cameras are rather limited in what they can 

achieve due to their inherent restraint on the number of motion 

updates per second (frame rate) they achieve. No camera on the 

market today with a large frame size can acquire more than 60 

frames per second, those being the 720p60 results from many 

Canon EOS models and units in the GH series from Panasonic. 

Check your local internet listings for other models, since this is 

a growth category. 

We hope that future cameras raise the frame rate options. It 

would be nice to have 120 fps and 240 fps in-camera options 

since even 60 frames every second is too few for many 

desired slit-scan interpretations. If a person walks through a 

vertical slit in one second (a reasonable modest stride), they 

will end up scanning themselves into a tall, skinny 60 pixels 

of image at 60 fps. Every bit of greater frame rate translates 

into more horizontal detail. If only there were methods for 

stretching time itself. 

Surprise. There are.

A precious few software-only solutions can take 60 fps footage 

and mold it into convincing slow-motion files. The Bad News is 

that they cost a healthy chunk of change. The Good News is that 

hundreds of thousands of video professionals have these soft-

ware tools, perhaps without realizing it. The Bad News would be 

that you aren’t yet one of these. 

Enough of this Good News/Bad News thing. Here’s the scoop. 

If you don’t have the software, maybe you can stand next to 

someone who already does and look wistful.

The shot here was captured in 1080p30 
from a hand held camera. But the 
videographer attempted to stabilize the 
shot by hand. Hence the seismic profile. 
Narrow people are moving faster (or 
closer to the camera) and more distant 
people look closer to actual aspect 
ratio. The people are in costume for 
Halloween.
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Apple’s Final Cut Studio includes a program 

called Motion 4. The other components in 

the suite function at a top professional level, 

producing world-class audio, grading movie 

shots for ultimate image qualities, making 

DVDs and doing titles. Studio indeed.

Motion is a moving image manipulation 

program that contains a technology 

labeled Optical Flow, which can invent 

missing images between Frame A and 

Frame B when you pull them apart in 

time. In other words, it figures out and 

redraws (!) the frames that would have 

existed between existing frames when 

time is slowed in the shot. 

Typically, you can force many 60 fps scenes into slow motion results that appear to 

have been shot at 240 fps or higher. Results are nothing short of jaw dropping. 

More Bad News, though. You can’t buy Motion 4 by itself. It’s only available with the 

whole Final Cut Studio suite of programs, and that costs $10001 US. Sadly for PC users, 

it only runs on Macintosh computers. 

A stand-alone program exists that will achieve results comparable to that of Motion’s 

Optical Flow technique. Look for Twixtor. It integrates with Final Cut Express, Adobe 

Premiere, Adobe After Effects plus other edit programs and does virtually the same job 

found in Final Cut Pro’s Motion program. Twixtor runs on PCs and Macs. Cost: $170-ish 

for the version that works with Apple’s low price Final Cut Express. Twixtor is $330 to 

$600 for the version that works with Adobe After Effects.

1	 Compare	that	to	any	other	top-end	comprehensive	edit	package.	Now	pick	your	jaw	up	off	the	floor.

http://www.apple.com/finalcutstudio/
http://www.apple.com/finalcutstudio/motion/
http://www.revisionfx.com/products/twixtor/
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GRAD FILTERS FOR MOVIE SCENES
iMovieGrad places a grad filter effect over the image. There 

are a number of good grad filter programs in the world for 

video, but this one lets you tweak the Hue/Saturation control 

in Photoshop to your taste. It simply lays a white grad over 

the image in a new layer, then treats only that layer with 

Hue/Saturation. 

You can change the filter Blending Mode. How about 

Overlay? Multiply? Linear Burn for a deep color effect? Try 

them all. Some make a hazy, fog effect, others an additive 

filtration. Adjust all the H/Sat controls to see what comes up.

You can redraw the grad to fit your shot. Or move the pre-

drawn, default grad around on the image. It’s a Layer and can 

be wrangled like any other layer. Stretched. Twisted. Resized.

Since the grad image is a separate layer, you can paint on 

it, too, and custom erase areas of the image that produce the 

color effect. Distant clouds on the shot at right, for instance. 

Frames lifted from 
movie clips:

iMovieGrad. All 
these used Colorize 
blending mode. 

Top: Lightness 
lowered, saturation 
moderate, gold hue, 
Color Burn.

Upper middle: 
Purple hue. Linear 
Burn, Saturation up, 
Lightness lowered 
more.

Lower middle: 
Blue hue. Overlay. 
Saturation very high. 
Beach, sky and shore 
edge were painted out 
from the grad layer. 
Clouds were painted-
in with grad color.

Bottom: Blue Hue. 
Normal blend mode 
forcing a haze effect. 
Saturation high. 
Lightness modest.

As you make adjustments 
to the Hue/Saturation 
Panel, the image changes 
dynamically. When you 
are done, save the image 
through File > Export > 
Render Video.
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SELECTIVE BLUR FOR MOVIE SCENES
iVidBlur2 lets you selectively blur ANY area of the image 

by airbrush painting over the areas you wish to keep sharp. 

You use a soft or hard brush to selectively erase a 

transparent black mask. Totally clear areas stay perfectly 

untouched; dark areas become blurred. Areas left partly 

dark become proportionally less blurred. 

i It takes practice to get a feel for how this works.

You can run a second or third pass, if you wish, to increase 

the blur using a support Action called iVidBlurNextPass. 

This allows you to construct all sorts of focus effects, 

including scenes that look like miniature live images, as 

on top at left.

Run the separate Action, iVidBlurExport to clear the image 

of extra layers and run the appropriate save procedure. 

This is available manually under File > Export > Render 

Video, and you must specify where to save the file, what its 

compression will be and what size it should be. 

iVidBlur2 works well with 720p files.

Caveats: 

These Actions won’t work with every kind of shot, but they 

can go a long way toward fooling the viewer’s eyes. Stable 

shots will work better with them. 

The more complex your area of sharpness, the more oppor-

tunities it will have to look manipulated. Sometimes that’s 

not a bad thing.

iVidBlur lets you paint a sharpness mask over an existing image. The Action processes 
up to five seconds of video, but that can be extended. On top, a “miniaturization” effect 
is created with a simple fuzzy slash through the image. Below, a shaped, soft mask 
revealed only the line of people directly behind the LA shirt guy. 

iVidVidBlur2

iVidVidBlur2
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MOVIE SCENE FLICKER REPAIR
HDSLR shots and time-lapse shots can 

flicker. Exposure jumps and lens issues 

can ruin a shot. So what’s to be done? 

The iNovaFX iFlickerFixerV3 Actions 

to the rescue. They have you identify 

a reference frame named “Ref” which 

serves as the standard against which all 

the other frames are adjusted.

The result: flicker evaporates!

Use the Action, iFlickerSetup-SingleRef 

to pick one representative Ref frame.

For complex scenes, the setup Action 

called iFlickerSetup-MultiRefs picks four 

frames from your clip, combining them 

into one big reference image.

Now you run iFlickerFIX, the main workhorse that compares the 

Ref image to each current frame in turn, adjusting it to reference 

standards.

i See also iTDNoiseB for alternative time-lapse shot flicker control.

But wait; there’s more.

To turn a string of still images into a time-lapse file, use the 

Action iTimeLapseMaker. You’ll need to put copies of all your 

shots into a folder, first. Then iTimeLapseMaker works with you 

to locate the folder, loading all those images as frame layers, 

allowing you to preview them in motion. Export that movie—

even if it flickers—so you can attack it with other Actions.

iFlickerFixer works on scenes that show bouncing exposures. It tries to iron-out 
small exposure differences  making the scene look normal. Click the image above to 
view on Vimeo. Click on the left side of the image below to see the flickering original. 
Click on the right side to see the iFlickerFIX version after processing.

< Before                    After >

http://vimeo.com/11585140
http://vimeo.com/15879416
http://vimeo.com/15888050
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CROSS STAR FILTER FOR MOVIE SCENES
This eBook started with added cross stars. Back there, 

they were only for existing still images. Here is a cross 

star filter for existing video files.

First, you’ll need a shot that has bright points of light 

against a dark background. A night shot with lots of 

bright highlights coming from light sources in the pic-

ture will work. Run the Action iMovieStar - 1frame, to 

test the effect. Add more by running the 30-frame, 150 

frame or 900-frame versions (iMovieStar - 30frames, 

etc .). You can use 1080p or 720p images, but the 

effect is strongest on 720p clips. For a single frame of 

cross star twinkle, you may position the Current Time 

Indicator anywhere and run iMovieStar - 1frame.

i Original shots may be any frame rate. The 150-frame version processes 5 

seconds at 30 fps. If you were to have a shot seven seconds long, you’d want 

to do two 30-frame runs plus a 150-frame run.

i Start new extension runs on the last already-processed frame.

i Use the iMovieStarLite Action set for a less intense cross star result.

Caveats: Processing is slow. It can take up to five seconds per frame on a 

modern, fast computer to add the effect. 150 frames can have you drumming 

your fingers waiting for the shot to finish. How about a nice cup of tea? 

The last frame of the scene will accumulate all remaining cross star pro-

cesses and will likely be blown to smithereens. Trim it away. If you wish 

to use PSX to brighten a night scene, do that  operation after creating the 

cross star effect. That way the effect will not be overly amplified.

Frame from a 1080p30 clip with iMovieStar added. 
The angle of the cross star pattern is twisted 15°.

iMovieStar

Original



  264 | CHAPTER 8       ACTIONS!

NOSTALGIC CINEMA
Painting a movie scene with tonalities that make it look old is 

an art. Simple sepia coloring helps with a few shots, but here is a 

series of Actions that give color clips a decidedly venerable look.

The iVintageCS5 series brings four color regimes to modern clear 

color scenes. iVintage evokes the same Warm, Gold, Cool and Mix 

treatments found in the iHalcyon series for still images.

Open your movie scene and run the iVintage(Color choice)Setup 

program to see what Frame #2 will look like. If you like it, pick the 

iVintage(Color)-(X)frames file to add more processed frames. If the 

Action runs out before the scene is finished, simply select another 

iVintage(Color)-(X)Frames Action to add more frames.

Versions are available in 30frames, 150frames and 450frames. The 

times at 30fps are 1, 5 and 15-seconds, respectively. Or 1.25, 6.25 

and 18.75 seconds at 24fps. PAL scenes shot at 25fps yield 1.2, 6 

and 18 seconds.

i Works with 720p and 1080p images.

i iVintageMix is an even warmer variation of 

iVintageWarm.

i Processing time is approximately 1 second per 

frame in a fast, modern computer.

i What happens when you run an iVintage Action twice on the same 

scene? Horrors! No I mean it. It looks like the extreme grading some 

directors like to add to their horror movie scenes.

i Adding frames always starts with the last completed frame.

i It is normal to lose the first and last frames during processing.

i Make tonal adjustments before iVintage. Or after.

A sample clip processed with 
iVintageWarm, iVintageCool 
and iVintageGold. Original 
from Nikon D90 in 720p24.

iVintageWarm

iVintageCool

iVintageGold
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GRAPHIC FLATTENING
Some cameras or edit programs have a “posterization” option 

that reduces the number of colors in a clip. But what you really 

wanted was a decent image-simplifying graphic effect.

iMovieToon Actions are three variations of movie effects process-

ing that avoid the posterization idea, turning each frame into an 

airbrushed work of art.

Run the iMoveToon(X/Y/Z)Setup to see how the shot looks with 

processing. Frame #1 stays clean while Frame #2 shows the 

effect. If you like the result, select from the named 30 frame, 150 

frame or 450 frame Actions.

i Works with 720p and 1080p clips and is bolder on 720p.

i Processing time ranges from about 1 to 3 seconds per frame in 

720p. 1080p shots necessarily take about twice as long.

i These cover every bit of grain from high ISO clips.

i First and last frames are lost to processing.

i To add frames, always start with the last processed frame.

i Okay. What happens when you run it twice?

A 1080p30 clip taken with 
a Canon 7D. Top to left, 
consecutive frames. The 
effects you see here will 
be exaggerated in shots 
captured as 720p.

Original

iMovieToonX

iMovieToonY iMovieToonZ
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MOVIE DRAWINGS
Turning a photo into a piece of art is one thing, but what about 

making a movie clip into a moving sketch? Here we have adapted 

the iPSSketch series’ iChalkNCharcoal Actions and turned them into 

movies. 

Housed in the folder, iMovieCharcoal, the iCharcoalSetup and iCh-

arcoalColorSetup Actions convert photographic HDSLR scenes into 

animated drawings with an attitude.

The Setup Action shows you the result on one frame, if you want 

more, run the iChar# Actions (30-frame, 150-frame and 450-frame 

Actions) for the black and white version or iCharCo# for the color 

versions.

The rough texture animates with every frame. As though the artist 

who drew each image were starting with a fresh piece of paper.

i You may wish to change 

the density of the image 

before processing it with these 

Actions. 

i Both Actions automati-

cally reset the Background/

Foreground colors to black and 

white, respectively. You can change these for effect after running 

the Setup, but the mid-tones will remain neutral gray.

i The first and last frames of your clip will likely be lost.

Original

iChar

iCharCo
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CRAYON MOVIES
Photoshop’s Conté Crayon drawings can turn still photos into  

three-tone images with black and white (Background/Foreground) 

areas over a gray canvas. The iMovieConté folder has iConté-

CanvasSetup monochrome and iContéColorSetup Actions plus 

30-frame, 150-frame and 450-frame extension Actions.

Conté Crayon drawings have been around since the 1790s. They 

look like pastels—colored chalk—but are tougher, almost waxy. 

Impressionists used them prominently a century later. Now they move.

Surface texture repeats with every frame—unlike the iMovieChar-

coal Actions—grounding the effect. Scale of the canvas substrate 

has been optimized for HD presentation in both 720p and 1080p.

Run the appropriate Setup Action to see a sample frame, then run 

the extension Actions to add more frames. 

i After running the iContéCanvasSetup, you can change the 

Background/Foreground colors in the Tool Panel. Artists often use 

a single dark color for shadow areas and a slightly off-white crayon 

for highlights, as in our -Tinted example.

i iMoveConté treatments are quite exposure sensitive. See next 

page for help with that.

i Because the Conté effect is so rough, it neatly hides the fact that 

our example shot was rather poorly focused.

iContéCanvas

iContéCanvas-Tinted

iContéColor



  268 | CHAPTER 8       ACTIONS!

MOVIE EXPOSURE HELPER
When you apply an extreme effect as are 

produced by the iVintage, iMovieToon, 

iMovieCharcoal and iMovieConté Actions, you 

may not get good results from the original 

exposure that your HDSLR camera obtained. 

The iMovieBrighten and iMovieDarken 

Action series are designed to help you past 

that hurdle. Like the previous four effects, 

there are 30-frame, 150-frame and 450-

frame versions of each that extend the idea, 

allowing you to add frames. This time we’ve 

added a 10-frame option, so you can quickly 

perform a short sample of one of the effects 

Actions and try a few things on it.

The advantage to using these to make a 

small tonality change is that they may be 

run on a clip, then immediately followed by 

an effect pass. Their impact on iMovieConté 

and iMovieCharcoal Actions is especially 

dramatic.

i First and last frames of the clip will likely 

be lost in processing.

Original Original

Brighten +1 Darken -1

Brighten +2 Darken -2

Brighten +3 Darken -3
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FAST MOVIE GRADING
When movie and HD editors refer to “grading” they’re not talking 

about grad filter effects at all. Nor are they giving the movie an A. 

Grading is the motion picture equivalent of darkroom techniques 

applied to still images. Every single shot in every movie you’ve seen 

in a theater has adjusted exposure and color to make it seamlessly 

cut with surrounding shots. PSX can grade a clip with Adjustment 

Layers and a little know-how. 

The iMovieGrade folder’s series of Actions sets up your shot with 

Adjustment Layers, each tweaked to show you a difference that you 

can immediately change by selecting the new Adjustment Layer and 

tweaking its settings. With each color, tonality or exposure change, 

you may be either fixing or enhancing the shot.

i In general, when an Adjustment Layer sits over a movie clip, 

whatever that layer accomplishes now applies to the entire movie. 

This makes doing things like gamma correction with Levels, whole 

Curves changes and Hue/Saturation changes a piece of pie. Easy 

as cake. A ginger snap. (These twisted similes will lock the idea in 

your memory forever.)

Examples here, and on the next few pages, show tricky things you 

can achieve with variations based on Adjustment Layers overlaying 

movie clips.

First up, simple gamma correction: The iMovieGamma Action 

simply prepares a Levels Adjustment Layer and bumps the gamma 

to 1.5 to lighten the shot. Not that you need that setting. You 

can interactively change it to whatever your shot calls for. Your 

adjusted setting will now apply to the entire clip as you Export it. 

Original

iMovieGamma (1 .5)

Levels contains a handy central Gamma 
Adjustment Slider. Many shots like this can 
take advantage of the way a gamma tweak 
can bring up central tonalities in lieu of 
making an exposure adjustment.
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MOVIE GRADING CONTINUED...

Vignetting (iMovieGrade folder) enhances many shots. We have 

found a quick way to invoke this using the Curves control plus a 

vignette pattern applied to the Adjustment Layer’s Mask. Click on 

the iMovieVignette1080 Action to set it up. Use iMovieVignette720 

for 720p clips or for a deeper vignette in 1080p clips.

i Since the Curves control is now open, you can reshape it to 

fine-tune the vignette effect. Our version is just a starting point.

i If that’s not right for your shot, you can also try adjusting the 

Opacity of the Adjustment Layer.

i Elevated settings to the Curves control may allow you to neutral-

ize the natural vignetting in some shots.

i For a customized vignette, select the Layer Mask using 

Option+click (Mac) or Alt+click (Windows). That opens the mask 

as a monochrome frame onto which you can perform surgery. A 

Radial Gradient that starts in the center of the image can make 

a custom vignette pattern. With black in the middle of the mask, 

the center of the image will be untouched, but scene details in the 

edges of the shot where the mask is lighter will become darker 

and less eye-catching.

i Note that extreme highlights are not inappropriately grayed out 

using Curves this way. If you want highlights diminished, too, then 

pull the highlight corner value down on the Curves Panel.

i Run the iMovieGridCrosshairs Action to create crosshairs in 

the center of the image. Turn the Grid on or off with Ctrl+comma 

(Windows) or Command+comma (Macs).

i iMovieGrade Actions work on every frame non-destructively. No 

frames are lost in processing. No original pixels are harmed.

Original

iMovieVignette’s default

Lenses that produce natural vignetting don’t gray-down 
spectral highlights, nor does iMovieVignette. BTW, this 
is a Nikkor 10.5mm full-frame fisheye lens adapted to 
the Canon 7D HDSLR. But that’s another story.
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MOVIE GRADING CONTINUED...

Wrong white balance can occur in movies just as easily as in 

still shots. PSX’s Photo Filter Adjustment Layer can rescue many 

scenes that are off-color. Use the iMoviePFilter Action to set it 

up. Our example uses a custom magenta-ish filter for this under-

streetlights sample image, but you have many, many options with 

the Photo Filter Adjustment Layer including the formulas based on 

a number of standard color correction filters often used over the 

lens.

CREEPY GRADING
Horror movies are almost never bright and colorful, the way your 

eyes see things. With judicious adjustment of the Curves control 

plus Hue/Saturation, you can dial in the cold, creepy, low-gamma, 

low saturation effects that turn a Halloween party into a Wes 

Craven flick. Use iMovieHorror to setup the idea with our sample 

dark coloration in place.

i Of course, you can use this setup to produce any number of 

Curves plus Hue/Saturation adjustments. This combo is a good 

starting place for many ails that can sneak into a shot. From the 

beginning of scene-by-scene printing corrections in the 1920s 

through the mid 1990s, color and exposure repairs were 97% of the 

bag of tricks that most movie scenes ever saw.

i Use the Curves to easily correct the white-balance of many shots by 

employing the Neutral Gray Eyedropper. Click it on subject matter that 

is naturally gray or shadowed white. It doesn’t always work perfectly, 

but by trying it early in your attempt to fix a broken image, you will be 

increasing your chances to luck out.

iMoviePFilter

Original

iMovieHorror
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MOVIE GRADING CONTINUED...

Serious HDSLR movie making needs serious image control. A new 

equation bubbles to the surface. 

    C • T = M2

Where C is color; T is tonality and M is mood. In highly dramatic 

scenes, the visual treatments of color multiplied by tonality 

produce an intentionally communicated series of conscious and 

subconscious responses in the mind of the viewer. M2.

One of PSX CS5’s new tools is the Vibrance Adjustment Layer, 

which our iMovieVibrance Action sets up for you.

The Vibrance Panel lets you directly touch both Vibrance and 

Saturation in one mutually interactive operation. On the surface, 

both seem to be variations of the same thing, but thinking that 

would be so wrong. 

Vibrance adjusts the chroma of the more subtle colors first, 

affecting stronger colorations comparatively less. Saturation 

reduces or amplifies all color intensities equally.

i To make a scene look subtly like it came from a bygone era, try 

reducing Vibrance, not Saturation. Reduced Vibrance makes subtle 

colors evaporate, while keeping the essence of the strongest colors.

The Action, iMovieVibrance++ adds TWO ADJUSTMENT LAYERS of 

Vibrance and one layer of Curves! This gives the over-chroma effect 

of TV’s CSI Miami to your shots without breaking the Saturation 

barrier. It looks oversaturated without becoming technically insane. 

The Curves Adjustment Layer contains a slight contrast boost curve. 

Double delete vibrance to gray-down shots, leaving only a hint of color.

i Watch out. It’s easy to abuse this setup.

-50% Saturation

Original

-50% Vibrance
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MOVIE GRADING CONTINUED...

Wouldn’t it be great to have one Action that let you setup all of 

these controls at the same time? 

It could also put you into a blizzard of overchoice. You be the 

judge. iMoviePanacea1080 creates a setup with no less than six 

Adjustment layers in this order, top to bottom, with these tweaks:

▶  Vignette (darkening curve applied).

▶  Vibrance (+100 Vibrance, -10 Saturation lifting subtle colors).

▶  Hue/Saturation (RGB and detail color curves neutral).

▶  Curves (the default flat line with no adjustment made).

▶  Levels (gamma is 1.20 which lightens mid-tones)

▶  Photo Filter (85 warming filter at 33% for golden-hour tint)

▶  Original movie (by default, movies become “Layer 1”).

i 720p shots should use the iMoviePanacea720 Action.

Big advantage to the use of Adjustment Layers: their effect is near 

instantaneous and rendering each frame during Export is quick.

i Watch out. Both Hue/Saturation and Vibrance layers have a 

saturation control. Use one or the other by habit. We suggest the 

one in Vibrance since it can control color more interactively.

i Things to note in the iMoviePanacea default image: 1 . Added 

vignetting has pulled the focus of the image toward the center of 

the shot. 2 . The combination of vignetting and color filtering has 

improved the sky dramatically. 3 . The warm color filter has made the 

image feel far more like the near-sunset reality of the actual moment. 

4 . Almost center—the guy with the pink shirt way over there—vibrance 

has tweaked his shirt and blue jeans. 5 . Levels’ gamma control has 

lightened shadows. 6 . Other subtle color areas have perked up. Like the 

street’s pavement color and the face of the building across the street.

Original

iMoviePanacea default

The top Vignette layer is really 
a Curves Adjustment Layer with 
a radial Gradient from black to 
white originating in dead center. 
iMoviePanacea is scaled for use 
with 1080p clips. Otherwise, use 
the iMoviePanacea720.
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MOVIE NOISE UNMAKERS
Just about the time that HDSLR cameras began to appear, the 

technologies that elevate ISO sensitivities blossomed. Some of 

today’s cameras have useful ISO numbers in the 25,600+ range. It 

would be nice to get even more. To do that, though, we would have 

to shoot with a high setting on our current camera, then get rid of 

the noise (color splotches and grain) somehow.

The iMovieDeNoise Actions make it possible to shoot in available 

darkness and still get decent-looking shots. Three versions are 

available. iMDeNoise1 is a strong denoise Action that seeks to 

reduce color noise and as much grain as possible without becoming 

obvious. iMDeNoise2 is maximum one-pass denoise in every way. 

Both try to hang on to as much detail as possible, but there is no 

such thing as a free ride with no consequences. Some texture will 

be sacrificed. iMDeNoise3 doubles the effort of iMDeNoise2. It is for 

worst-case shots. But grainy skies will smooth out.

i If you shoot in 1080p format, then run a given denoise Action, 

you get one result. But now if you reduce the image to 720p, a natural noise reduc-

tion occurs as grain crowds together. If you shoot 720p to begin with, the “detail 

tax” that a denoise Action may extract can punish the image more than you wish. 

Use the Extension Actions (e.g. iMDeNoise-30frames). They allow you to build more 

frames onto your range of completed images.

i Find the extension point by moving the Current Time Indicator over the last 

already-processed frame.

i To convert 1080p to 720p, locate the iMovieSize > iMovieSize1080->720 Action.

ISO 12,800 is easy to access on the Canon 
EOS 7D, but it’s hard to enjoy for HD movie 
scenes. Here a cropped section shows the 
effect of iMDNoise2 on a grainy original. 
The area of this crop is about 20% of the 
full frame.

Original                              iMDNoise2
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TEMPORAL DENOISING
What if you could use time to help with noise issues? 

iMovieTimeDNoise Actions do just that. Two flavors: iTDNoiseA and 

B come in variations of p60, p50, p30, p25 and p24 (like iTDNoiseBp60 

or iTDNoiseAp24.). They take two (A) or three (B) different frames and 

pile them  on top of each other, displacing them in time (by one frame) 

before blending them together. Noise drops -3db or -4.5db. Pick the 

one that matches your original scene. Ten in all for all frame rates.

i The penalty: fast motion will display frame doubling or tripling 

artifacts or greater smearing. Your eye will guide you.

i Advantage number one: no rendering. But you must immediately 

Export your result. And that takes time.

i Advantage number two: on 720p60 shots with iTDNoiseAp60, 

you’ll probably never see any time-based artifacts at all.

i Advantage #3: B does wonders deflickering time-lapse shots.

MOVIE SHARPENING
HDSLR cameras, as a group, are somewhat less capable than 

dedicated HD camcorders at detecting and maintaining focus. In 

other words, you might need some occasional focus helper.

To achieve full HD potential, the iMovieSharpen Actions may 

come in handy for key scenes. These use Photoshop’s clever Smart 

Sharpen filter to perk up shots without visible artifacts.

i iMovieSharpen1 is a slight correction. iMovieSharpen2 is tightly 

focused for minor tweaking. iMovieSharpen3 is maximum sharpening 

for already-sharp frames. Used on well-focused shots, they bring the 

HD image into full glory. Added to slightly challenged shots, they may 

be able to make a clip acceptable.
Original                              iMovieSharpen3
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MOVIE FLAW REPAIR
Rarely, an HDSLR camera can develop a pixel flaw that shows up 

in movie clips shooting with high ISO settings. Usually blown pixels 

are mapped and controlled during camera manufacture, but some 

cameras may acquire the effect of a misfiring pixel months after 

being purchased. Most warranties cover pixel flaws, as happened to 

this author’s Canon 7D, but only after scenes shot under high ISO 

were gathered at a wedding reception. What to do?

The Actions in iMovieDotRemover can get rid of any bad or 

underperforming pixel flaws. The iMovieDotSetup Action lays a 

red overlay onto the image and hands you a two-pixel brush. You 

manually mark the flawed pixel(s), then watch as it shows you a 

sample frame of the repair. 

i If need be, you can re-mark or enlarge your mark that identifies 

the flawed pixel(s).

Run the extension Actions to increase the running time of the 

repair. You can extend processing for 30 frames, 150 frames, 450 

frames, 900 frames, 1800 frames or 5400 frames. At 30 fps, that 

last one will run a scene that’s a full three minutes long. Processing 

is fairly fast.

i The principle here is similar to the one in the iFlawFix Actions. 

Your mark(s) become selections that are filled in with the color of 

surrounding pixels. It’s amazing how invisible the flawed pixels 

become.

ISO 3200 revealed a flawed pixel in this crop from a movie 
scene (top, circled). Worse: she danced into it. It wasn’t 
there when the camera was brand new, and Canon fixed 
it cheerfully when I showed it to them, but iMovieDotSetup 
has removed it completely from the next frame. The 
sparkles on the bride’s dress are from sequins.
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EXPORTING ACTION-PROCESSED MOVIE FILES
After you complete the processing of a video file, you must save 

it, and this step is not as straightforward as it is for still images.

Instead of just Save, you Export. 

File > Export > Render Video... is the path you want. It will 

collect all your frames into a format, size and frame rate of your 

choice. The Good News is that it can control these things. The 

Bad News is that you MUST specify them. Especially the four 

items indicated here. Otherwise, you may think you’ve done the 

right thing, only to find out—at the very last stage— you have 

ruined everything.

In the Render Video Panel, the top item is the file’s Name and 

where to save it. By default, it is the same name and location as 

it had originally. You MUST change this or you will overwrite your 

original shot, leading to much cursing, later.

File Options include QuickTime Export and Document Size. 

You can use this to save the file in numerous motion formats or 

shrink the movie to smaller size, but usually you will wish to save 

it in a form close to the original. You might occasionally wish to save an original 1080p file 

as a 720p result. Depending on other resources in your computer, you may wish to compress 

the final scene in a format other programs want to use. In our example, above, we are saving 

a 1080p shot using high quality H.264 compression.

Render Options could bite you. If its Frame Rate option is wrong, your shot will be ren-

dered out at the wrong speed. This option will show the settings that were used during the 

last Export, so double check it to see that it specifies the same frame rate as your original 

file. Rarely, you may use this to change the frame rate of a shot.
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PHOTOSHOP’S TRICKIEST SECRET
When you open a RAW image, it 

appears in the Raw Interpreter Panel, 

and a comprehensive array of tools 

are immediately at your fingertips. 

You can change exposure, add 

fill light for shadow detail, control 

blooming highlights, level, lens 

correct, sharpen, color adjust and 

dozens of other things.

Wouldn’t it be nice to have this 

suite of tools for immediate manipu-

lation of all your JPEG images as you 

open them? 

You can. 

But it’s so well hidden you will 

need to tell PS CS5 exactly how to 

do that for you.

Open Preferences (Command + K or Control + K) > File Han-

dling > File Compatibility > Camera Raw Preferences > JPEG 

and TIFF Handling > JPEG: > (Automatically open all supported 

JPEGs). By my count that’s tucked away no less than six layers 

deeper than anything obvious. But now every time you drop a 

JPEG image onto your Photoshop icon, it will pop open using the 

Raw Interpreter Panel.

i The only downside: You must confront the image(s) and use 

the Raw Panel to complete the idea of opening them every time.

One window; a billion possibilities. The Raw Interpreter Panel delivers 
more image manipulation tools into your immediate control than anything 
else. Here it has opened three JPEG images at once from two different 
cameras. You can select them all and give them all the identical settings, 
if you wish, for an instant batch processing. Here the top image has 
been Leveled (angle), Exposure adjusted +15% of a stop, and a small 
amount of Fill has been added to dark shadow areas. With practice, 
you can perform enhancements, corrections and improvements on your 
images before opening them in the main Photoshop window. Be aware, 
though, that JPEGs won’t tolerate the large corrections that RAW files 
comfortably enjoy. 



|   279INDEX   ACTIONS!

Index

Symbols
2¼ by 2¼  60
4 image printing  70
4x5 sheet film  65
4x5 view camera  60
6x6 format  60
16 image printing  72
35mm borders  67
720p60  255, 258

A
A4 Letter  71
Action Anatomy  15
Action Creation  39
ActionsCS5  3
Action Shortcuts  9
Actions Panel  55
Adams, Ansel  6
Adjustment Layers  226, 227
Adobe After Effects  259
Adobe Premiere  259
Adobe Reader  4
Airbrush effect  209
Amplification  14
Ansel Adams  6
APS-C  173
Array images  178
Aviator (movie)  212

B
Background/Foreground colors  266
Barrel distortion  39–170
Barrel distortion batch correction  176
Barrel distortion correction  174
Bayer  16
Blending Mode  19, 260
Bloom art effect  206
Blown pixels  192, 276
Borders  59
Butler, Linda  214
Butterfly Actions  243–244
Button Mode  21
B&W conversion  217
B&W filters  215

C
Canvas Size  45
Canvas Size tool  139
Carnet  196, 216
Carnets  9
Caveats  62, 63, 64, 65, 67, 69, 71, 73, 159, 176, 224 

261, 263
Channel Mixer  236
Chromatic aberration  26
Color blast effect  203
Color filter simulators for B&W conversion  215
Complex Action Recording  48
Conté Crayon movie effect  267
Conté Crayon still effect  125

Click on page numbers to jump directly to that page.
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Contents  5
Continue  21
Conversions  14
Cooler / Warmer  185
Corrective Actions  32
Corrective measures  171–194
Create Simple Action  43
Crops  228
Crop utility  228
Cross Star Filter for movie  263
Cross Star filters  160
CSI Miami  272
Curves  184
Curves control  50
Cylindrical edge repair  177

D
De-Noise  188
Digimarc  94
Digital Camera  3
Digital Intermediate  210
Dimroom art effect  205
Distortion lens effect  166
Domino  213
Dreamy color effect  203
Dust Reference Frame  194
Dust & Scratches Filter  120
DX format  173, 231
Dynamic range enhancement  220–222

E
Easy Barrel Correction  41
Edge Fog effect  62
Equalization  200
Equisolid  231
Errors  13
Exporting Action-processed movie files  277
Extreme ISO  191
Extrude Filter  139
Eyedropper tool  184
Eye of the Beholder  6

F
Film Strip  68
Filters  14
Final Cut Studio  259
Fingerprint  237
First Photo  17
Fisheye  38
Flaw Frame  192
Flesh tone B&W  207
Fog filter  157
Foreword  3
Four image print  70–71
Four thirds (format)  173
Framing Actions  33
Full frame 35mm  173
Full STOP  21
FX format  173
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G
Geometry Repairs  172
Giant images  178
Giant poster  245
Giottos Rocket  193
Glass filter equivalents  151–168
Golden Section  234
Gradation filters  153
Grad filter Actions  33
Grad filter effect  260
Grading, movie  269
Grad Layer  154
Graphic  209
Graphic flattening  265
Graphic Photo Fantasies  37

H
Halo filter  159
Handwritten fonts  201
Hayes Island Effect  196
HDR  220, 222
HDSLR  247, 248, 252, 275
High ISO  188, 192
History Lesson  57
History Panel  12, 18–170, 26–170, 29–170, 30–170, 

46, 54–170, 56–170, 57, 106–170, 201, 207, 209, 
213

Hue/Saturation  198, 211

I
iBaby Action  166
iCrAb  26, 27
iFourPrint  70
iGraphic Action  209
iHalcyon  264
iMovieBrighten  268
iMovieDarken  268
iMovieDeNoise  274
iMovieGamma  269
iMovieGrade  269
InfoBites  10
Infrared filter effect  163
iNovaChrome  61
iNovaFX  13, 14, 184
iNova, Peter  2–4
In-register FX  19
Installing Actions  31
iOldTymie Action  229
iPad  4
iPSBrushStrokes  95
iPSDistort Series  105
iPS+Noise Series  120
iPSSketch Series  121
iPSTexture Series  145
ISO boosting  190–191
iStylize Series  138
iTimeLapseMaker  262
iToons  208
iToy Action  167
iVintageCS5  264
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J
JPEG artifacts  187

L
Law Of The Haircut  33
Layer effects  20
Less is more  209
Lights  3
Limitations  14
List View  21, 44
Load Actions  11
Local Contrast  204

M
Meet the Actions  7
Miller, Frank  211
Miniature scene effect  167
Monochrome  207, 214, 215, 218, 236
Monopod  249
Motion 4  259
“Moustache” curve  41
Moustache distortion  175
Movie Drawings  266
Movie Flaw repair  276
Movies  247
Movie scene flicker Repair  262
Multiple Images on a page  34

N
NASA  230
New Snapshot  54
Niépce, Joseph Nicéphore  17

O
Opacity  56, 155, 190
Optical filter actions  33
Optical Flow  259

P
Panoramic  58
Panoramic image  248
Panoramics  177
PDF  4
Pencil line  202
Pencil sketch  201
Perspective  182
Perspective repair  181
Perspective tutorial  182–183
Photography As An Effect  16
Photomerge  31, 58, 176, 177, 178, 249
Photoshop CS5  3, 20
Photoshop Extended  9, 247
Photoshop Filters +++  75–150
Photoshop FX Actions  35
Photoshop’s Trickiest Secret  278
Pinch  41
Polar Coordinates  238
Polarization filter effect  162
Portraits  242
Posterization  265
Preface  11, 39, 59, 75, 171, 195, 219
Preferences  278
Printing dots  232
Print Preparation Actions  36
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PS Artistic  77–94
PS Brush Strokes  95–104
PS Distort  105–116
PS Pixelate  117–119
PS Plus Noise  120
PS Sketch  121–137
PS Stylize  138–144
PS Texture  145–150
PSX  247

R
RAW format  222
Raw Interpreter Panel  278
Reader Shortcuts  9
Reference Point Locator  24
Restarting  22
Retinex effect  230
Rodriguez, Robert  211
Roll film Actions  61
Roll film borders  60
Rolling shutter  252
Rule Of Thirds  234

S
Save Actions  55
Scratch filter  161
Screen Blending Mode  19
Selective blur  261
Shatter glass effect  164–165
Sheet Film Border  65
Sin City (movie)  211
Sixteen image printing  72–73
Slide film  220
Slit-Scan Photography  252
Smart Sharpen  275
Smith and Boyle  16
Snapshot  216
Sodium lighting  185
Spherize  41
Spiderwebbing  187
Stamp out images  69
Storytelling  13
Sweep Panorama  248

T
The Aviator (movie)  212
Theory of adjustment  24
“The Primate Limit”  12
Three Hints  6
Traction from your Action  56
Twixtor  259
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U
Unsharp Mask  204
US Letter  71

V
Vibrance Adjustment Layer  272
View camera corrections  181
Vignette effect  170
Vignetting  270
Visual Effects Actions  35

W
Warmer / Cooler  185
White card  194
Why this eBook?  3

Z
Zoom lenses  172
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